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AccuRoute product documentation is provided as part of the licensed product. As such, the documentation is subject to 
the terms outlined in the End User License Agreement. (You are presented with the End User License Agreement during 
the product installation. By installing the product, you consent to the terms therein.)

Permission to use the documentation is granted, provided that this copyright notice appears in all copies, use of the 
documentation is for informational and non-commercial or personal use only and will not be copied or posted on any 
network computer or broadcast in any media, and no modifications to the documentation are made. Accredited 
educational institutions may download and reproduce the documentation for distribution in the classroom. Distribution 
outside the classroom requires express written permission. Use for any other purpose is expressly prohibited by law.

AccuRoute and/or its suppliers make no guaranties, express or implied, about the information contained in the 
documentation. Documents and graphics contained therein could include typographical errors and technical 
inaccuracies. AccuRoute may make improvements or changes to the documentation and its associated product at any 
time.

Upland AccuRoute Resources

The Upland Success Community

The Upland Community is the central hub for Upland customer information, in the community you can: 

· Track tickets

· Search and Download Knowledge

· Interact in Upland Forums

· Stay up to date on AccuRoute and/or Upland News

Access the Community by logging in with your company email at:

https://community.uplandsoftware.com/hc/en-us

Customer Service and Technical Support Contact Information

· Phone: 718-362-3755 or 1-888-303-8098

· E-mail: omtool-support@uplandsoftware.com

· Community: https://community.uplandsoftware.com/hc/en-us

NOTE: Technical support requires an active support contract. For more information go to: 

https://uplandsoftware.com/accuroute/customer-success/support-overview/

Sales, Consulting Services, Licenses and Training

· Phone: 978-327-5700 or 1-800-886-7845
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Section 1: About this Guide

This AccuRoute Clients Installation Guide collects and explains the installation procedures as well as the 
required and optional configuration settings for the AccuRoute Clients. 

This section includes:

Intended Audience (1-1)

AccuRoute Clients List (1-1)

Client Deployment Summary (1-3)

Related AccuRoute v6.3 Documentation (1-3)

Intended Audience
The AccuRoute Clients Installation Guide is primarily intended for administrators responsible for installation 
of the different AccuRoute clients. 

AccuRoute Clients List
Organized by client name, the following table provides links to the relevant chapters for each AccuRoute 
client, including introductions, installation steps, server and client configurations, and optional 
configurations.

Table 1-1: AccuRoute Clients Section Index

Client Name Section Links

AccuRoute Desktop 

For Introduction, see AccuRoute Desktop (2-2)

For Installation, see AccuRoute Desktop (4-1)

For Server Configurations, see AccuRoute Desktop (5-2)

For Required Configurations, see AccuRoute Desktop (6-2)

For Optional Requirements, see AccuRoute Desktop (7-2)

AccuRoute Web Apps

For Introduction, see AccuRoute Web Apps (2-9)

For Installation, see AccuRoute Web Apps (4-7)

For Server Configurations, see AccuRoute Web Apps (5-8)

For Required Configurations, see AccuRoute Web Apps (6-11)
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Print to AccuRoute

For Introduction, see Print to AccuRoute (2-11)

For Installation, see Print to AccuRoute (4-13)

AccuRoute Queue

For Introduction, see AccuRoute Queue (2-14)

For Installation, see AccuRoute Queue (4-20)

For Server Configurations, see AccuRoute Queue (5-11)

For Required Configurations, see AccuRoute Queue (6-15)

For Optional Requirements, see AccuRoute Queue (7-49)

AccuRoute Acquisition

For Introduction, see AccuRoute Acquisition (2-15)

For Installation, see AccuRoute Acquisition (4-24)

For Required Configurations, see AccuRoute Connect (6-16)

AccuRoute Connect

For Introduction, see AccuRoute Connect (2-20)

For Installation, see AccuRoute Connect (4-29)

For Server Configurations, see AccuRoute Connect (5-12)

For Required Configurations, see AccuRoute Connect (6-16)

AccuRoute COM API

For Introduction, see AccuRoute CostRecovery (2-23)

For Installation, see AccuRoute COM API (4-32)

For Required Configurations, see AccuRoute COM API (6-17)

Cost Recovery

For Introduction, see AccuRoute CostRecovery (2-23)

For Installation, see AccuRoute Cost Recovery (4-34)

For Required Configurations, see AccuRoute CostRecovery (6-19)

Server Monitor

For Introduction, see AccuRoute Server Monitor (2-24)

For Installation, see AccuRoute Server Monitor (4-38)

For Server Configurations, see AccuRoute Server Monitor (5-17)

For Required Configurations, see AccuRoute Server Monitor (6-33)

For Optional Requirements, see AccuRoute Server Monitor (7-51)

Fax Center

For Introduction, see AccuRoute FaxCenter (2-25)

For Installation, see AccuRoute FaxCenter (4-40)

For Server Configurations, see AccuRoute FaxCenter (5-20)

For Required Configurations, see AccuRoute FaxCenter (6-36)

For Optional Requirements, see AccuRoute FaxCenter (7-55)

Table 1-1:  (Continued)AccuRoute Clients Section Index

Client Name Section Links
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Client Deployment Summary
To deploy any AccuRoute Client:

1 Verify that AccuRoute Server and the Client requirements have been met. (Go to Section 3: 
Requirements.)

2 Install the client of interest. (Go to Section 4: Installation.)

3 Make required server configurations on the AccuRoute Server. (Go to Section 5: Required 
Server Configuration.)

4 Apply required configurations that are necessary for your client (Go to Section 6: Required 
Configuration.)

5 Apply optional configurations that may be relevant for your client (Go to Section 7: Optional 
Configurations.)

Related AccuRoute v6.3 Documentation
For more information about AccuRoute v6.3 and other AccuRoute products, refer to the AccuRoute v6.3 
documentation home page to access:

 Readmes and release notes

 DMS Libraries quick start guides

 User guides and online help

 Administrator guides

 Installation and upgrade guides

http://www.omtool.com/documentation/accuroute/6.3/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
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Section 2: Introduction

AccuRoute takes the guesswork out of document delivery. AccuRoute software is a versatile document 
messaging suite enabling users to send documents—electronic and hard copy—to multiple and varied 
destinations like document repositories, network printers, fax numbers, and email. 

This section describes all the AccuRoute clients along with their interactions with each other and the 
AccuRoute Server.

This section includes:

AccuRoute Desktop (2-2)

AccuRoute Web Apps (2-9)

Print to AccuRoute (2-11)

AccuRoute Queue (2-14)

AccuRoute Acquisition (2-15)

AccuRoute Connect (2-20)

AccuRoute CostRecovery (2-23)

AccuRoute CostRecovery (2-23)

AccuRoute Server Monitor (2-24)

AccuRoute FaxCenter (2-25)
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AccuRoute Desktop
This section includes:

Introduction to AccuRoute Desktop (2-2)

Methods of submitting messages to the AccuRoute Server (2-2)

Components of AccuRoute Desktop (2-4)

Workflows for messages and Embedded Directives (2-6)

Views associated with AccuRoute Desktop features (2-7)

Introduction to AccuRoute Desktop
AccuRoute’s unmatched routing capabilities are presented to the user as AccuRoute Desktop, an 
intelligent client-side application that resembles a desktop email client. Using AccuRoute Desktop, users 
can create Embedded Directives and Routing Sheets and use them to streamline their common document 
routing practices. 

AccuRoute Desktop also features a desktop printer that generates PDF files and a Windows Send To 
shortcut; both invoke AccuRoute Desktop automatically, allowing the user to send documents that are 
already open on the desktop or saved on the network.

AccuRoute Desktop is the client-side desktop application that allows network users to: 

 Create and save Embedded Directives (EDs). These EDs can be used to submit messages 
directly to the Upland AccuRoute Server and generate Routing Sheets.

 Generate Routing Sheets. The Routing Sheets can be placed in front of hard copy documents 
and the set can be scanned from a multifunction device and sent to the Upland AccuRoute 
Server for processing. 

 Submit messages directly to the Upland AccuRoute Server without using an Embedded 
Directive.

Methods of submitting messages to the AccuRoute Server
The highly intelligent Embedded Directive technology requires each message to be submitted directly to the 
Upland AccuRoute Server for processing and routing to the final destinations. 

There are several ways messages can be submitted to the AccuRoute Server; each method is explained in 
the figure in the next page and in the following sub sections. 

This section includes:

AccuRoute Web Apps (2-3)
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Network scanning devices (2-3)

Figure 2-1: Methods of submitting messages to the Upland AccuRoute Server

AccuRoute Web Apps

The AccuRoute Web Apps client is an intranet-based web application providing network users a convenient 
method of creating document distributions (Embedded Directives), generating Routing Sheets, and sending 
messages. For more information on AccuRoute Web Apps, refer to AccuRoute Web Apps (2-9).

Network scanning devices

AccuRoute seamlessly converts any hard-copy document into searchable electronic format and delivers it 
as a message. A user simply scans the hard copy document with a Routing Sheet on a network scanning 
device, and the Upland AccuRoute Server does the rest. 

A scanned document enters the AccuRoute system via AccuRoute Intelligent Device Client or an inbound 
connector. Specialized solutions are available for the industry’s most common multifunction device models. 
For more information, refer AccuRoute Embedded Device Client Installation Guide.

mailto:sales@omtool.com
mailto:sales@omtool.com
http://www.omtool.com/documentation/accuroutedeviceintegration/deviceclient/5.1/accurouteembeddeddeviceclientinstallationguide.pdf
http://www.omtool.com/documentation/accuroute/5.0/documentation.htm
http://www.omtool.com/documentation/accuroute/5.0/documentation.htm
http://www.omtool.com/documentation/accuroutedeviceintegration/deviceclient/5.1/accurouteembeddeddeviceclientinstallationguide.pdf
http://www.omtool.com/documentation/accuroutedeviceintegration/deviceclient/5.1/accurouteembeddeddeviceclientinstallationguide.pdf
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Components of AccuRoute Desktop
The AccuRoute Desktop application consists of three components:

This section includes:

Watch Folders application (2-4)

AccuRoute Desktop (2-4)

Print to AccuRoute printer (2-6)

Watch Folders application

This is an application that starts at Windows startup and has a tray icon. The application uses Virtual 
Filescan implementation and gathers files that are dropped in known/specified folders and then process 
them through the AccuRoute Server. 

AccuRoute Desktop

AccuRoute Desktop resembles an email client application in which the user can choose recipients for a 
message and send it. In addition to this direct send capability, the AccuRoute Desktop user can save the 
message as an Embedded Directive, reuse saved Embedded Directives to send new messages, add or 
remove existing attachments, or use an Embedded Directive to generate a Routing Sheet. It is the core 
component of the application suite; it can be invoked by users, the Watch Folders application, and the Send 
To AccuRoute Desktop shortcut.

Note AccuRoute Desktop contains the configuration UI for the Watch Folders application.
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Send To AccuRoute Desktop

The Send To > AccuRoute Desktop option is listed in the Windows Explorer right-click menu for files. 

When the user sends a document to AccuRoute Desktop, a special form prompts the user to launch 
AccuRoute Desktop with the document attached or to immediately send the document using an existing 
Embedded Directive..
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If the user sends the document using an existing Embedded Directive, AccuRoute Desktop sends the 
message immediately. If the user launches AccuRoute Desktop, the form appears on the desktop and the 
document is attached.

Print to AccuRoute printer 

AccuRoute Desktop v6.0 printing is handled by the Print to AccuRoute client. Print to AccuRoute allows 
users to print any document to the AccuRoute PDF printer, which makes a .pdf version of that document. 
Then the system opens the new .pdf file in the AccuRoute Desktop, where it is available to be sent to 
recipients or addresses, as with any other message. Print to AccuRoute lets users take advantage of 
AccuRoute messaging capabilities for file formats not otherwise supported. For more information, refer to 
Print to AccuRoute (2-11)

Workflows for messages and Embedded Directives
AccuRoute Desktop supports the following workflows:

 Sending messages - When AccuRoute Desktop submits a message to the Upland 
AccuRoute Server, the server queues it in the Dispatch component. The Dispatch component 
analyzes the Outbound rules and determines a message path through the Upland AccuRoute 
Server’s processing queues. It directs the message to the appropriate workflow component 
where it is processed for delivery. After AccuRoute Desktop has submitted the message to the 
Upland AccuRoute Server, it can be tracked using the Upland AccuRoute Server 
Administrator.
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 Creating and updating Embedded Directives - When AccuRoute Desktop creates a new 
Embedded Directive or updates an existing Embedded Directive, the Upland AccuRoute 
Server updates the Embedded Directive in the message database.

 Generating and displaying Routing Sheets - When AccuRoute Desktop creates a Routing 
Sheet or displays a previously generated Routing Sheet, it uses the Embedded Directive 
properties and the message attachments (send to when printing to AccuRoute Desktop or 
from the Send to Desktop shortcut) to compose a Routing Sheet on the desktop and display 
using the default PDF viewing application.

Views associated with AccuRoute Desktop features
A view is configuration file for an AccuRoute Desktop form. All three components of the AccuRoute Desktop 
application suite use forms. For example, AccuRoute Desktop uses the standard form that is linked to the 
view file Default.VIEW. Each view file is comprised of XML data that determines the look and feel of the 
application, and the features that are available to the user.

Tip Upland AccuRoute provides guidelines on modifying view files so that administrators or 
programmers can customize views for the target environment. For a fee, an AccuRoute Technical 
Support engineer can assist with view file modifications or customize view files for the target 
environment. 

Do not modify any views before using AccuRoute Desktop. Use the application in its default configuration, 
generate a list of specifications for deployment, and then customize the application. View files are stored on 
the Upland AccuRoute Server and can be updated anytime—even after AccuRoute Desktop has been 
installed on clients.

Users can use custom views when running AccuRoute Desktop in standard mode.

 AccuRoute Desktop loads Default.VIEW by default. The view that AccuRoute Desktop loads is 
determined by the property prDefaultView in AccuRouteclient.xml. This property can be 
modified for individual users. 

 Send To AccuRoute Desktop loads DirectSent.OMV which is located in …\AccuRouteViews 
on the Upland AccuRoute Server. The view can be modified as necessary, but it cannot be 
customized for different users and groups and cannot be moved to a different location.

 Printing a document to the AccuRoute watch folder loads the Default.VIEW. This view is 
determined by the watch folder configuration AccuRouteWatchFolder.xml which defaults to the 
Default.VIEW. Users can also modify this to be any view they want, PrintToFax.OMW, or even 
the PrintTo.OMV as necessary. 

This section includes:

Views versus user preferences (2-7)

Inheritance (2-8)

Overrides (2-8)

Views versus user preferences

Views always takes precedence over user preferences in AccuRoute Desktop. This allows administrators 
to use views to enforce user and group policies. (If a user sets preferences that conflict with the view, then 
the conflicting settings are not saved.)
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Inheritance

A view can inherit configuration data from another view. Using this concept called inheritance, AccuRoute 
Desktop can be deployed with a hierarchal set of views that meet the needs of users and groups. In an 
environment that utilizes view inheritance, the view with the most general configuration data is called the 
base view, and the view that determines the AccuRoute Desktop configuration on the client is called the 
derived view. Any view that occurs between the base view and the derived view is called an intermediate 
view. For example, the view lineage can be comprised of the base view, multiple intermediate views, and 
the derived view.

While view inheritance can be used to propagate settings to other views, it provides versatility at the feature 
level. A view can override data that is inherited from another view. (Go to Overrides on 2-8.)

Two-view example

Consider the following example of view inheritance using two views:

 organization.view

 department.view

AccuRoute Desktop on the client is configured to load department.view. Since department.view inherits 
configuration data from organization.view, organization.view is the base view and department.view is the 
derived view.

Three-view example

Consider a more sophisticated example of view inheritance using three views:

 organization.view

 site.view

 department. view

AccuRoute Desktop on the client is configured to load department.view. Department.view inherits 
configuration data from site.view, and site.view inherits configuration data from organization.view. 
Department.view is the derived view, site.view is the intermediate view, and organization.view is the base 
view.

Overrides

A derived view can override data that is inherited from the base view. Conversely, the base view can allow 
or prevent the derived view from overriding all or part of the view configuration. (The attribute overridable 
can be set on the view itself, on general sections such as <General>, and on more specific sections such 
as <Recipient>. which belongs to the <Defaults> section.) This concept of overrides is detailed thoroughly 
in the next section that contains guidelines on modifying view files.
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AccuRoute Web Apps
This section includes:

Introduction to AccuRoute Web Apps (2-9)

Messages and distributions (2-9)

Distribution Collections (2-10)

Introduction to AccuRoute Web Apps
AccuRoute Web Apps is an intranet-based web application that provides network users a convenient 
method of delivering documents. Web Apps is the customizable, tile-based AccuRoute client from which 
users can access Applications integral to their workflow.

The intuitive Web Apps Homepage presents the user with several application tiles, from which they can 
create Messages, work with Distributions and Files, and set preferences. The Application options available 
to user groups are defined in the System Administrator. 

Figure 2-A: AccuRoute Web Apps Client

Messages and distributions
Users can send messages and distributions electronically and from hard copy. In both cases, the Web Apps 
Client delivers the document as an electronic file attachment using the recipient information.

 For messages and distributions sent electronically, users manually add a recipient or choose a 
distribution, select and add an attachment, review options and send. The system processes it 
using the associated routing information.

 For messages and distributions sent starting with a hard copy, users can print Routing Sheets 
to bring to an MFP with the document, or they can sign-in to the device and use the 
distributions associated with authenticated buttons on the device, such as Scan to Me.

For more information on messages and distributions, and exact steps for working with them in the Web Apps 
Client, see the AccuRoute Web Apps User Guide.
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Distribution Collections
Users can create their own Distributions or make use of any Distribution Collections to which their user 
group is assigned in the AccuRoute Server. Users cannot edit an existing distribution within a Distribution 
Collection, but they can modify it and use Save As to generate a new one based on the original settings. 

For more information on working with Distribution Collections, refer to the AccuRoute Web Apps User 
Guide.
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Print to AccuRoute
This section includes:

Introduction of Print to AccuRoute Features (2-11)

Printing to AccuRoute Desktop (2-11)

Introduction of Print to AccuRoute Features
Print to AccuRoute allows users to print any document to the AccuRoute PDF printer, which makes a .pdf 
version of that document. Then the system opens the .pdf file in either the AccuRoute Desktop or Web 
Client, where it is available to be sent to recipients or addresses, just like any other message. 

With Print to AccuRoute, users can take advantage of AccuRoute messaging capabilities for file formats not 
typically supported. The Print to AccuRoute installation offers choices:

 Print to AccuRoute Desktop

Printing to AccuRoute Desktop
When printing a document to AccuRoute Desktop. Right-click on the document and select Print 
option, the document is automatically routed to AccuRoute Desktop as an attachment for a 
message. Here are the steps.

To print to AccuRoute Desktop:

1 Open a document.

2 Click Print. The Print dialog opens and the Print to AccuRoute printer is selected. 
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3 The AccuRoute Desktop application is launched with the file as a PDF attachment. 

The user can send a message with the attachment or create an Embedded Directive with the 
attachment. The document will be submitted to the server which will convert to the requested 
final form.
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Print to AccuRoute WebApps
Print to AccuRoute using Web Apps Client:

1 Install Print to AccuRoute client by providing Web Apps URL

2 Right-click on a PDF document and select Print

3 AccuRoute Web Apps launches with the options Advanced and Send Using Existing 
Reservation

4 Select Advanced: New Distribution window of the web apps client appears with the selected 
document as an attachment. Document sent to the server is converted to the final format

5 Select Send Using Existing Reservation: User is displayed with the list of previously created 
distributions



AccuRoute® Clients Installation Guide

Section 2: Introduction

© 2019 by Omtool, Ltd. (Upland AccuRoute) All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

2-14

AccuRoute Queue
This section includes:

Introduction to AccuRoute Queue (2-14)

Working with AccuRoute Queue (2-14)

Introduction to AccuRoute Queue
AccuRoute Queue is a desktop component of Upland AccuRoute document management system that 
provides a viable digital alternative to traditional paper based document management and routing systems. 
It can be deployed as a standalone configuration along with the AccuRoute Acquisition Client or as a 
component of an enterprise e-document delivery and management system. The advantage of using 
AccuRoute Queue is that it processes documents in a workflow bound for a document management system 
(or Object Archive™). For information on AccuRoute Queue and other AccuRoute products, see the 
AccuRoute v6.0 documentation home page.

The AccuRoute Queue is a separate licensed product that must be purchased before it can be installed or 
used. For more information on how AccuRoute Queue works, contact Upland AccuRoute Sales.

Working with AccuRoute Queue
The AccuRoute Queue software processes scanned documents that are routed to predefined Queues as 
messages. The documents can be scanned into AccuRoute Queue using AccuRoute’s AccuRoute 
Acquisition Client software or from a multifunction device. The Queues are pre-configured in the Upland 
AccuRoute Server Administrator where the Administrator assigns access rights and permissions to 
predefined user Groups.

When an AccuRoute Queue operator logs into AccuRoute Queue, the user has access to all scanned 
documents in the Queue. The user can open a new document for processing, assign deficiencies (mark 
them as lacking in requirement information) or route the document to a specific destination. To maintain data 
integrity, only one AccuRoute Queue operator can view/process a document in AccuRoute Queue at any 
given point in time. However, if a document was opened for processing and was not freed up after a 
specified length of time, it is automatically freed up for processing. 

The AccuRoute Queue operator can perform various tasks while processing messages. They can, for 
example: 

 Route documents to a specific destination (for example, email, fax, printer or ObjectArchive).

 Assign deficiencies (note missing information and send them to users who can provide the 
missing value). For example, you notice a missing signature and assign an e-signature 
request on it and send it to the person who should be providing the e-signature. 

 Merge and split documents, manually release a lock or move a document to processed 
depending on assigned permissions (by the Upland AccuRoute Server Administrator). 

http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
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AccuRoute Acquisition
This section includes:

Introduction to AccuRoute Acquisition (2-15)

Introduction to AccuRoute Acquisition
AccuRoute Acquisition is a desktop component of Upland AccuRoute. 

In AccuRoute Acquisition client, documents are scanned from a TWAIN scanner, grouped and sent to 
AccuRoute for further processing. 

Documents may be scanned using Simplex or Duplex modes. Scanned documents can be merged/split 
as required by the workflow and submitted to AccuRoute.

The AccuRoute Acquisition client is a separate licensed product that must be purchased before it can be 
installed or used. For more information on how AccuRoute Acquisition works, contact Upland AccuRoute 
Sales.

This section includes:

User Interface (2-16)

Top Menu Bar (2-16)

Tool Bar Icons (2-18)

Image/page number pane and PDF viewer pane (2-19)

Status bar (2-19)
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User Interface 

The AccuRoute Acquisition client user interface is composed of a top menu bar, a tool bar, an image/page 
number pane, a PDF viewer pane and a status bar with the folder number. Often there are several ways to 
access common commands, which are all described under the relevant heading. Keyboard shortcut keys, 
when applicable, are given in parenthesis.

Top Menu Bar

This section includes:

File menu (2-16)

Scan menu (2-17)

Image menu (2-17)

File menu

 New (Cntl+N) opens the Properties window and enables the Scan command
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 Rescan (Cntl+R)

 Open (Cntl+O) an existing document

 Submit (Cntl+S) the document to AccuRoute Queue

 Close the current document

 Properties (F2) displays the index window with Folder number, Medical record, and Account 
number.

 Options (F3) Note: This diagnostic should be enabled only at the request of tech support.

 Delete removes the folder and all images in it.

 Exit (Alt+F4) the application

Scan menu

 Scan new images to the end of a folder.

 Scan Insert scans images and puts them before the selected image.

 Scan Overwrite scans new images and overwrites starting at the current image. (Also see 
Substituting a page in a 

 document on 3-8.)

 Settings (or Cntl+T) for the scanner allows the choice of:

 Color, Black & White or Grayscale, which may help with the quality of some problem 
documents

 resolution in DPI

 Duplex

 Show scanner UI

 Select Source allows you to choose which scanner to use.

Image menu

 Merge/Split collects pages into a single document or subtracts them from an existing 
document. (Also see Merging  scanned pages into a single document on 3-4.) and (Also see 
Splitting double-sided merged pages into individual pages on 3-7.)

 Swap Front/Back

 Delete (Cntl+Del) deletes the image selected.

 Rotate Left (Cntl+Shift+Left)

 Rotate Right (Cntl+Shift+Right
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 Flip (Cntl+Shift+Down)

 Zoom (25%, 50%. 100%, Best fit, Fit to Width, Fit to Height)

Tool Bar Icons

 Create a new folder (Cntl+N) (Also see Scanning a document on 3-2.)

 Open a folder previously scanned on this workstation (Cntl+O) (Also see Closing and 
(re)opening a document file 

 folder on 3-4.)

 Submit folder to AccuRoute Queue (Cntl+S) (Also see Submitting a document to AccuRoute 
Queue on 3-9.)

 Display or modify folder properties (F2)

 Scan (F5) enters the image of the page into AccuRoute (Also see Scanning a document on 3-
2.)

 Scan images and place them before the selected image (Cntl+F5) (Also see Substituting a 
page in a document on 3-8.)

 Scan new images, overwriting starting at the current image (Shift+F5) (Also see Substituting a 
page in a document on

 3-8.)

 Scan both front and back of pages (Also see  Scanning a document on 3-2.)

 Rotate the image 90 degrees counter-clockwise (Click+Shift+Left Arrow)

 Rotate the image 90 degrees clockwise (Click+Shift+Right Arrow)

 Flip the current image (Click+Shift+DownArrow)

 Delete the current image
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Image/page number pane and PDF viewer pane

The image and page number pane lists the pages that have been scanned and gives information about 
their pagination in the document. The highlighted page can be viewed and manipulated in the PDF viewer 
pane.

Status bar

The status bar shows the folder number and current action.
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AccuRoute Connect
This section includes:

Introduction to AccuRoute Connect (2-20)

Working with AccuRoute Connect (2-20)

Description of the AccuRoute Connect features (2-21)

Introduction to AccuRoute Connect
AccuRoute Connect is an extensive and powerful application that allows AccuRoute to integrate with 
various external applications without any custom programming. It uses a powerful metadata gathering 
technique to collect metadata from the external application it integrates with. This captured metadata can 
be used, for example, to generate Embedded Directives and Routing Sheets. Using an Embedded Directive 
or a Routing Sheet, an user can route documents to repositories like MicroSoft® SharePoint® or 
ObjectArchive™ where the captured document is stored using the metadata values as indices. 

The AccuRoute Connect Client is a separate licensed product that must be purchased before it can be 
installed or used. For more information on how AccuRoute Connect works and for custom integrations of 
AccuRoute with external applications, contact Upland AccuRoute Sales.

Working with AccuRoute Connect
The following example will give you an idea as to how AccuRoute Connect works. In this example, an 
Administrator needs to integrate the AccuRoute environment with a Human Resource application. This 
application contains employee demographic information like employee name, date of birth, email and or fax 
number, social security number etc. The purpose of the integration is to collect the employee metadata and 
use the information to create a Routing Sheet, and then use the Routing Sheet to route documents to a 
repository using the metadata values as indices.

The integration is easily configured using AccuRoute Connect where the Administrator simply creates an 
“Appspace” for the application (with mappings for all the demographic information fields as Xmodel 
elements) and installs the Appspace on the AccuRoute Server. 

Note An AppSpace can be thought of as a document container for RegWins. A RegWin is a set of tabs 
in the AppSpace that allow the Upland AccuRoute Server Administrator to associate controls on 
a Windows Application UI in order for the metadata to be captured.

Thereafter, whenever an user brings up the application, the user is presented an AccuRoute icon in the title 
bar. When the user activates the icon, AccuRoute Connect opens, presenting the user with one or several 
of the AccuRoute Connect options. (The list of options the user can see, will depend on his configuration). 

 Create Routing Sheet

 Create Scan Reservation

 View Linked Documents

 Open in AccuRoute Desktop

 Upload Documents

 Link to Queue
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As soon as the user selects the “Create Routing Sheet” option, a Routing Sheet is generated using the 
metadata from the current contents of the fields that are mapped as Xmodel elements.

Description of the AccuRoute Connect features
 Create Routing Sheet

When the user selects the “Create Routing Sheet” option, a Routing Sheet is automatically 
generated using the metadata from the current contents of the fields that are mapped in the 
external application. The Routing Sheet can be used for capturing and routing of documents to 
the final destination using the values as indices. Since the Routing Sheet is automatically 
generated, this process does not require any data entry on the users part. Administrators 
however, can configure, to prompt the user for a relevant Routing Sheet name or users can 
use the default name if needed.

 Create Scan Reservation

When the user selects the “Create Scan Reservation” option, an Embedded Directive is 
automatically generated using the current contents of the fields that are mapped for collecting 
metadata. Once you save this, the Embedded Directive can be made available on a multi-
function device for use. 

This method of creating a scan reservation does not require any data entry on the users part. 
Additionally, the users do not have to save or print a Routing Sheet before walking up to a 
multi-function device to scan their document. 

This feature provides the same basic capabilities as “Create Routing Sheet” option. However 
instead of generating a routing sheet, the system creates an Embedded Directive and make it 
available on a multi-function device. 

 View Linked Documents

This feature allows the end user in an external application to search for and view all 
documents previously associated with a field mapped for metadata collection. It invokes the 
AccuRoute Web Client’s direct search capability where the mapped field is used as the search 
criteria for finding related documents. 

For example, if the end user is in the external application selects the View linked Documents 
option, and if the employee id is mapped field, then the user will be able to view all documents 
that were archived via the AccuRoute Web Client that are associated with the employee ID.

 Open the AccuRoute Desktop

In cases where more complicated or modified processing is required for document routing, the 
user will have the option to open the Routing Sheet in the AccuRoute Desktop Client. 

When the user selects the “Open in AccuRoute Desktop” option in AccuRoute Connect, an 
Embedded Directive is created using the current contents of the fields that are mapped for 
metadata collection. The AccuRoute Desktop Client application opens where the newly 
created Embedded Directive is listed. The user can save the Embedded Directive as is, or 
modify the directive as needed before saving it. 

The Embedded Directive can be accessed from the AccuRoute Desktop Client, the 
AccuRoute Web Client and also from multi function devices (MFPs). It is usually listed at the 
top of directives list available for use.
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 Upload Documents

When the user selects this option and if the documents being captured already exist 
electronically, the user has the option to upload the documents directly to the Upland 
AccuRoute Server for processing, bypassing the scanning step.

 Link to AccuRoute Queue

The Link to Queue feature allows the user to apply the metadata from the external application 
to a job listed in the External Applications folder of the AccuRoute Queue application. 

When the user selects the “Link to Queue” option in AccuRoute Connect, the Upland 
AccuRoute Workflow Integration Application page opens listing all jobs in the External 
Applications folder. The user can select a job, preview the associated document and click OK 
to apply the metadata from the external application to the job. The job moves from the External 
Applications folder of AccuRoute Queue application and matches the queue workflow rules to 
its final destination.
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AccuRoute CostRecovery
This section includes:

Introduction to AccuRoute CostRecovery (2-23)

CostRecovery Features (2-23)

Introduction to AccuRoute CostRecovery
AccuRoute CostRecovery is a stand-alone application for AccuRoute that extracts information from 
Upland AccuRoute Server applications for billing purposes. AccuRoute CostRecovery creates a file that 
contains the information extracted from the Upland AccuRoute Server database. You can post this file to 
your billing system, which enables your company to bill the appropriate client for message transactions such 
as copying or scanning documents, if your company uses AccuRoute CostRecovery with AccuRoute.

Note This manual includes information about using AccuRoute CostRecovery with AccuRoute. When 
you install AccuRoute CostRecovery, it is customized with information specific to the Upland 
AccuRoute Server application you use. For this reason, some of the images of AccuRoute 
CostRecovery screens displayed in this manual will not necessarily exactly match what you see 
when you run AccuRoute CostRecovery. The appropriate Upland AccuRoute Server-specific 
images or procedures are provided where necessary to enhance your understanding of the 
program.

For more information about any of these messaging solutions, contact Upland AccuRoute or refer to the 
documentation that accompanied the product you are using with AccuRoute CostRecovery.

CostRecovery Features
AccuRoute CostRecovery features include:

 The ability to collect message or document transactions from the message database in 
AccuRoute.

 Customizable templates to design the format of the extracted information to meet the needs of 
your billing system.

 The ability to price by page for faxes and e-mail messages, and to assign different prices for 
the first page and all additional pages, and to add a maximum price for any given message.

 The ability to price local, long distance, and international calls differently, and to assign a 
maximum cost for each type of call.

 The ability to price by page for copies, scanned documents, and storage of documents in a 
document management system with AccuRoute.

 The ability to schedule AccuRoute CostRecovery to run automatically on a daily basis.

 The ability to parse partial strings from billing codes and to remove leading zeros from numeric 
billing codes.
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AccuRoute Server Monitor
This section includes:

Introduction to AccuRoute Server Monitor (2-24)

Introduction to AccuRoute Server Monitor
AccuRoute Server Monitor is a stand-alone application that monitors various components of an Upland 
AccuRoute Server. It executes custom-created tests to detect workflow bottlenecks and system failures. 

Conditions that can be monitored include the size of the message database, available disk space on the 
AccuRoute Server, the size of Send and Receive folders, the status of AccuRoute services, and the status 
of connectors. Additionally, with its versatile monitoring capabilities, AccuRoute Server Monitor runs test in 
specified frequencies; maintains a suspend schedule; supports custom actions for each test which can 
include sending e-mail notifications, writing entries to the event log, and changing the status of AccuRoute 
services; supports custom e-mail addresses for the source and destination of notification messages; and 
monitors Upland AccuRoute Server clusters.

AccuRoute Server Monitor consists of:

 AccuRoute Server Monitor Administrator - A snap-in to the Microsoft Management 
Console, the Administrator plays two essential roles. First, it serves as the user interface 
where you create “tests” for each Upland AccuRoute Server you monitor. (Each test consists 
of criteria and at least one action.) Second, the Administrator connects to the AccuRoute 
Server Monitor Service. Because the AccuRoute Server Monitor Administrator can run on a 
different system than the AccuRoute Server Monitor Service, you can manage your server 
monitoring methods from another Windows system in the local area network, including your 
desktop.

 AccuRoute Server Monitor Service - This Windows service performs all monitoring activities 
from a high-availability server. It logs on to the Upland AccuRoute Server using the Upland 
AccuRoute Server account, which has DCOM access and launch permissions on the Upland 
AccuRoute Server, and then executes the tests created in the Administrator.
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AccuRoute FaxCenter
This section includes:

Introduction to AccuRoute FaxCenter (2-25)

Introduction to AccuRoute FaxCenter
FaxCenter is a fax routing application. While many inbound faxes will be routed directly to recipients in your 
company, there are instances when someone needs to review an inbound fax, determine its most 
appropriate recipient or destination, and send the fax to that recipient or destination. FaxCenter offers this 
ability.

The FaxCenter and server routing rules help you to set up an inbound routing rule that determines which 
faxes need to be reviewed and routed to the appropriate recipients and destinations. When these inbound 
faxes arrive at the server, they are routed to FaxCenter users. FaxCenter users determine the most 
appropriate recipients and destinations for each fax and route faxes accordingly.

As you follow the procedures in this guide, you will:

 Install FaxCenter on client systems.

 Add FaxCenter users to Registered Users in the Administrator and give them permissions to 
run FaxCenter and use the appropriate features. 

 Set up inbound routing rules on the server that determine which faxes get routed to 
FaxCenter. 

Once you have completed these steps, FaxCenter users can route faxes to e-mail recipients, fax machines, 
network printers, and document management systems. They may also be able to release outbound faxes 
in Registration Pending to secure destinations.

The AccuRoute FaxCenter is a separate licensed product that must be purchased before it can be installed 
or used. For more information on how AccuRoute FaxCenter works, contact Upland AccuRoute Sales.
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Section 3: Requirements

This section includes:

Server requirements (3-1)

Client requirements (3-4)

Server requirements
This section includes:

AccuRoute Server requirements (3-1)

Basic client hardware requirements (3-1)

DCOM permissions when installing on a remote system (3-2)

HTTP or HTTPS connectivity for AccuRoute Intelligent Device Client (3-2)

Note about connecting AccuRoute Server installed on Windows (3-2)

Supported email applications (3-3)

AccuRoute Server requirements

Note You can install the Web Apps Client on the system running the AccuRoute server. If you install 
the Web Apps Client on a system that is not running the AccuRoute server, you must configure 
DCOM permissions so that the Web Apps Client server can access the AccuRoute server DCOM 
objects. 

Basic client hardware requirements
 Pentium®-class processor, 400 MHz or faster

 20 GB hard drive with a minimum of 50 MB free space

 128 MB RAM

 Microsoft Windows 2012 x64, Windows 2012 R2 x64, or Windows 2016 x64

 Internet Information Services IIS v8 (Windows component) with Internet connection

Note NOTE: For IIS v7 or later, configure to allow Active Server Pages. This configuration is located in 
the Web Service Extensions node in the IIS console tree.
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 Microsoft .NET Framework v4.6.1 redistributable package

 Microsoft Internet Explorer 11or later, Chrome, Edge, Firefox, or Safari for Mac v6.2.8 or 
later

Note Internet Explorer 11 support requires the compatibility view be disabled. For steps to do so, see 
Disabling Compatibility Mode in Internet Explorer 11 (4-2).

 Acrobat® Reader® 9.x / 8.x / 7.x

 An image viewer compatible with your operating system

Important AccuRoute Desktop has been qualified with Windows Terminal Services and 
Remote Desktop Connection.

DCOM permissions when installing on a remote system
When you install the AccuRoute Clients on a remote system, you must configure the DCOM permissions 
on the AccuRoute server. Without this configuration, the AccuRoute server cannot communicate with the 
remote clients. For configuration instructions, see Configuring server-client connectivity methods (5-3)

HTTP or HTTPS connectivity for AccuRoute Intelligent Device 
Client
AccuRoute Desktop v6.0 supports the following methods of server-client connectivity: DCOM, HTTP, and 
HTTPS. Additional requirements apply for HTTP and HTTPS: For contivity instructions, see Implementing 
connectivity methods (5-4)

Important AccuRoute v6.0 installs the AccuRoute Intelligent Device Client as part of the 
server install. No separate client installation is necessary. 

 For HTTPS connectivity only - Windows component Certificate Services must be installed on 
the system running AccuRoute Intelligent Device Client and a CA certificate must be configured 
for the Default Web Site in IIS.

 For Windows 2008 R2 SP2 64-bit servers only - Allow Dynamic RPC for the local port 135. 

Note about connecting AccuRoute Server installed on 
Windows

To allow AccuRoute Clients to connect to AccuRoute Server running on Windows:

1 In the Windows 2008 system, open the Server Manager. 

2 Select Windows Fire Wall with Advanced Security. 

3 Select Inbound Rules under it, on the right select New Rule.
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4 Create a new Windows Firewall Inbound Rule. 

5 Select Port.

6 Select TCP and enter port 135 (you will change this port after the rule is created).

7 Select Allow the Connection. 

8 Select Domain, Private, Public.

9 Name the rule as appropriate, for example DCOM RPC (or something else). 

10 After rule is created enter the rule's properties.

11 Go to the Protocols and Ports page. 

12 Change Local Port 135 to Dynamic RPC. 

13 Press OK to save your changes.

Note The Server PreInstall will open the appropriate ports on the server when using Windows Firewall. 
If another vendor firewall is used, the above settings has to be configured manually.

Supported email applications
AccuRoute Desktop can integrate with the address book in the following email applications:

 Microsoft® Outlook® 2007 or higher (Outlook Express not supported)

 Notes 6.5/6.0/5.0

 Novell GroupWise 6.0/5.5

When AccuRoute Desktop is configured to integrate with an address book for a supported email application, 
the e-mail application must be selected as the Windows default email application. For more information, 
consult Windows help.
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Client requirements
The AccuRoute clients have specific following additional requirements.

This section includes:

AccuRoute Web Apps (3-4)

Print to AccuRoute (3-5)

AccuRoute COM API (3-5)

AccuRoute Server Monitor (3-6)

The following AccuRoute clients do not require any specific additional requirements.

 AccuRoute Destop

 AccuRoute Queue

 AccuRoute Acquisition

 AccuRoute Connect

 AccuRoute Cost Recovery

 AccuRoute FaxCenter

AccuRoute Web Apps
This section includes:

AccuRoute Web Apps user requirements for email account (3-4)

AccuRoute Web Apps user full permission requirements (3-5)

AccuRoute Web Apps user requirements for email account
The Web Apps Client users must have an email account created for them using the mail server (Microsoft 
Exchange Server).

Important The mail server for any email account created must be installed on the same 
domain on which the AccuRoute server is installed. 

This is necessary because the Web Apps Client queries the Active Directory attributes like “mail” and 
“proxyAddresses”. The “proxyAddresses“attribute is added to the Active Directory properties only if an 
Microsoft Exchange Server is installed in the same domain as the Active Directory.
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AccuRoute Web Apps user full permission requirements

Important Full permissions to the Web Apps installation folder is required for all domain users 
(including the application pool account user) when Web Apps is installed to a non-
default location with a custom virtual directory name.

Print to AccuRoute 
The system where you install one of the Print to AccuRoute v6.0 options must meet the following 
requirements:

 Print to AccuRoute Desktop requires AccuRoute Desktop v6.0.

 Print to AccuRoute Web Client requires AccuRoute Web Apps v6.0.

AccuRoute COM API

Components installed by the AccuRoute Intelligent Device 
Client setup
Install the AccuRoute Intelligent Device Client on the system where you intend to run the applications you 
create. The system must meet the following requirements:

 Microsoft Windows 2012 x64, Windows 2012 R2 x64, or Windows 2016 x64

 Service account for the AccuRoute server must have Distributed COM access permissions on 
the system where you install the AccuRoute Intelligent Device Client and run applications. 
(This is the user account you used to install the AccuRoute server. It is the logon account for 
all Om* services.)

 Must be in the same domain as the AccuRoute server or in another domain that has a 
bidirectional trust with the server’s domain.

 Any other resource requirements necessary to support the applications you create.



© 2019 by Omtool, Ltd. (Upland AccuRoute) All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

3-6AccuRoute® Clients Installation Guide

Section 3: Requirements

AccuRoute Server Monitor
This section includes:

AccuRoute Server Monitor Service (3-6)

AccuRoute Server Monitor Administrator (3-6)

AccuRoute Server Monitor Service
The system where the AccuRoute Server Monitor Service is installed must meet the following minimum 
requirements:

 Windows domain computer that always runs in the same domain as the AccuRoute Server and 
is not a domain controller, an AccuRoute Server, or a remote server

 Pentium III-compatible processor; 1 GHz; 512 MB RAM; 20 GB available hard disk space; CD-
ROM drive; and Microsoft mouse or compatible pointing device

 Microsoft Windows 2012 x64, Windows 2012 R2 x64, or Windows 2016 x64

 IIS configured for SMTP mail delivery

 Exchange System Administrator (required only for Exchange monitoring)

AccuRoute Server Monitor Administrator
The system where AccuRoute Server Monitor Administrator is installed must meet the following minimum 
requirements:

 Windows domain computer that belongs to the same domain as the AccuRoute Server

 Pentium III-compatible processor; 1 GHz; 512 MB RAM; 200 MB hard disk space; CD-ROM 
drive; and Microsoft mouse or compatible pointing device

 Microsoft Windows 2012 x64, Windows 2012 R2 x64, or Windows 2016 x64

 AccuRoute service account or another account that belongs to the AccuRoute Admins group 
on the AccuRoute Server.
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Section 4: Installation

This section describes the installation steps of the AccuRoute clients.

This section includes:

AccuRoute Desktop (4-1)

AccuRoute Web Apps (4-7)

Print to AccuRoute (4-12)

AccuRoute Queue (4-19)

AccuRoute Acquisition (4-23)

AccuRoute COM API (4-31)

AccuRoute Cost Recovery (4-33)

AccuRoute Server Monitor (4-37)

AccuRoute FaxCenter (4-39)

AccuRoute Desktop
This section includes:

About the AccuRoute Desktop Components (4-1)

Installing AccuRoute Desktop (4-2))

View files installed with AccuRoute Desktop (4-4)

Running AccuRoute Desktop setup in silent mode (4-5)

Installing AccuRoute Desktop for all users in silent mode (4-6)

About the AccuRoute Desktop Components
The AccuRoute Desktop setup installs the AccuRoute Desktop Client and the Watch Folder application. 
The installation will set the Watch Folder application to start on Windows startup, and will automatically start 
when installation is complete.
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Installing AccuRoute Desktop

Note Your AccuRoute Client version older than v5.0 is removed, and AccuRoute Desktop v6.0 installs 
on running the setup. You can install the AccuRoute Desktop on the AccuRoute Server or the 
client system. In previous versions, the install created a Post Script printer that was used to 
convert the printed document to PDF. In this version, the install will no longer create a printer. All 
printing will go through the Print to AccuRoute client, which can be found on the AccuRoute server 
system\ clients directory.

To install AccuRoute Desktop:

1 Log on to the system using an account that belongs to the local Administrators group. 

2 Navigate to the Clients directory containing the setup files. 

3 Click setup.exe. The InstallShield wizard configures your system and the Welcome message 
appears.

4 Click Next. The License Agreement screen appears. 

5 Read the agreement carefully and if you agree to the terms, click Yes. 

The Choose Destination Folder screen opens. The default destination is C:\Program 
Files\UplandAccuRoute\AccuRouteDesktop. 
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6 To accept the default, click Next. Otherwise, click Change. If you want to install in a non-
default location, click Browse and then select a location. Then click Next. 

7 The Ready to Install the Program screen opens. 

8 Click Install to begin the installation. 

When installation is complete, you see the InstallShield Wizard Complete message. 

9 Click Finish to close the wizard. 
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10 Check the version of the AccuRoute Desktop client you installed. It should be AccuRoute 
Desktop v6.0.

View files installed with AccuRoute Desktop
Any *.VIEW file that resides in …\AccuRouteViews or in search folders appears in the View menu in 
AccuRoute Desktop and allows users to change views on demand. (This statement assumes that the View 
menu in AccuRoute Desktop is visible to users and that the particular search folder is defined for the view.)

All *.OMV files are invisible to AccuRoute Desktop, so they cannot be displayed as view options in the 
AccuRoute Desktop View menu. (These views are reserved for special applications, such as the Send To 
AccuRoute Desktop feature and printing to AccuRoute Desktop and are not designed for general purposes.)

The following view files are installed on the AccuRoute server and reside in 
…\AccuRoute\AccuRouteViews:

 Default.VIEW - View that AccuRoute Desktop loads on startup in standard mode.

Important Do not delete, rename, or move this file. It is required for AccuRoute Desktop to 
work correctly.

 DirectSend.OMV - View that AccuRoute Desktop loads when the user sends a document to 
AccuRoute Desktop using the Send To AccuRoute Desktop shortcut in Windows.

 Print To.OMV - View that can be optionally used when a user prints a document to the 
AccuRoute Desktop. By default when printing to the AccuRoute Desktop, the default.view is 
used. 

 AccuRoute Client-Safe.OMV - Backup copy of Default.VIEW. Do not modify this file.

The \AccuRouteViews folder also contains the following files:

 DMSAssignDistribution.OMV

 DMSCreateRS.OMV

 DMSCreateRS-ReScan.OMV

 DMSPrompt.OMV

 PrintToFax.OMV

 PrintWithPrompts.OMV
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Figure 4-A: View menu in AccuRoute Desktop

The View menu, which allows the user to change the current view, includes the default view (Default) and custom 
views (AllUsers, Managers, MarketingUsers, SalesUsers, and SuperUsers).

Running AccuRoute Desktop setup in silent mode
To run the AccuRoute Desktop setup in silent mode:

Note For 64 bit systems, the path is C:\Program Files\UplandAccuRoute\AccuRoute 
\Clients\AccuRouteDesktop\setup.exe 

1 To install AccuRoute Desktop in another system, run: setup.exe /s /v"/qn"

This installs AccuRoute Desktop to the default location:
C:\Program Files\UplandAccuRoute\AccuRouteDesktop.

Note To install AccuRoute Desktop for all users in silent mode, see Installing AccuRoute Desktop for 
all users in silent mode (4-7)



AccuRoute Clents Installation Guide

Section 4: Installation

© 2019 by Omtool, Ltd. (Upland AccuRoute) All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their
respective owners.

4-6

2 Optionally, to change the location, set the property INSTALLDIR, run
setup.exe /s /v"/qn INSTALLDIR=<short name path>" 
where <short name path> is the short name path to the target folder. (The entire path must be 
in short name format. For example, if the long path is J:\Program 
Files\UplandAccuRoute\AccuRouteDesktop, then the short path is 
J:\PROGRA~1\UPLANDACCUROUTE\ACCURO~1.)

Tip The command for short name conversions is dir /x. Run this command in any directory to return the 
short names of all folders in that directory. For example, to do a short name conversion on 
J:\Program Files, change the current directory to J:\ and run dir /x.

3 Verify that AccuRoute Desktop is installed on the client by navigating to 
…\UplandAccuRoute\AccuRouteDesktop on the client and verifying that the AccuRoute 
Desktop program files are installed.

Installing AccuRoute Desktop for all users in silent mode
To install AccuRoute Desktop for all users in silent mode:

1 Start by following the instructions in Running the AccuRoute Desktop setup in silent mode (4-
6). 

2 In step 4, where you run the setup file, add the following argument ALLUSERs=2:

setup.exe /s /v"/qn ALLUSERS=2"

Note The ALLUSERS argument is required in order for the install to complete successfully. If you do 
not use this argument, and you log into the system using a user credential that is different than 
one who ran the install, the AccuRoute Desktop does not show in Add/Remove Program list. 

3 Sign in as a different user and verify that AccuRoute Desktop is listed in Start> All Programs 
> Add/Remove programs.
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AccuRoute Web Apps
This section includes:

About the AccuRoute Web Apps components (4-7)

Installing AccuRoute Web Apps (4-8)

Required DCOM permissions when installing on a remote system (4-12)

About the AccuRoute Web Apps components
The AccuRoute Web Apps client setup:

 Installs the Web Apps client program files.

 Creates a virtual directory in IIS.
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 Configures IIS authentication.

 Configures Web Apps with the AccuRoute server location, the mail system identity and 
location.

Installing AccuRoute Web Apps 
Run the Prerequisite of AccuRoute Server

The below listed prerequisites are to be installed before installing AccuRoute WebApps

 Microsoft .NET Framework 4.6.1

 Microsoft .NET Framework 3.5 SP1

 Microsoft SQL Server

 Web Server IIS

 W3SVC Service Automatic Startup

 Microsoft .NET Core 1.0.0-Windows server Hosting

 Install SMTP Server

 SMTP Service Automatic StartUp

 DCOM Exception in Windows Firewall

 Print Spooler Service Automatic Startup

 

Note If any of the above features are not installed then they should be installed manually from the 
Server Manager tool.
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To install AccuRoute Web Apps:

1 Log on to the system where the Web Apps client is being installed using an account that 
belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteWebApps directory of the system 
running the AccuRoute server containing the Web Apps client setup files and run setup.exe. 
The InstallShield Wizard opens to the Welcome screen. 

3 Click Next to begin the installation process. 

TipThe Web Apps Client setup is included with a complete AccuRoute Server installation 
in \Program Files (x86)\UplandAccuRoute\AccuRoute\Clients\Web Apps. Immediately 
following the AccuRoute Server installation, only the AccuRoute service account has 
permissions to access client setup programs on the AccuRoute server, but additional 
users can be granted permissions if necessary.

The Destination Folder screen appears. 

4 If you need to change the destination folder, click Change and follow the prompts. Then click 
Next. 
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The IIS Virtual Directory screen appears. 

5 Name the Web Apps Client by entering the IIS Virtual Directory name here. The default is 
AccuRoute. You can change the virtual directory name if necessary. Then click Next.

Note The virtual directory name is used to create a virtual directory in IIS under Default Web Site.

The Message Server screen appears.

6 Enter the Message Server name. If the AccuRoute server is running in the system in which 
you are installing this client, the name is entered by default. Click Next. 
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The Message Server Credentials screen appears. 

7 Enter the Service Account name and Password used by the AccuRoute Server, and click 
Next.

8 On the Authentication Type screen, select an Authentication type and enter the 
Authentication server name. Click Next. 

9 The Ready to Install the Program screen appears. Click Install. 
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The InstallShield wizard installs the client and the Completed screen appears. 

10 Click Finish to exit the wizard. 

11 To launch the Web Apps Client, open a web browser with a URL of 
https://messageservername/virtualdirectoryname.

AccuRoute Web Apps Silent Mode Installation
1 Create a Debug folder on any local drive with Write permissions.

2 Go to the Web Apps Client folder: C:\Program files (x86)\Upland 
AccuRoute\AccuRoute\Clients\Web Apps.

3 Run the following command.

setup.exe /s /v" /qn ALLUSERS=1 MESSAGE_SERVER=<accuroute_servername>   
SERVICE_ACCOUNT=<username>   SERVICE_PWD=<password> /L*v 
C:\Debug\printsetup.log"

Notes: 

 Specify the AccuRoute server name in the setup.exe command line.

 Specify the username and password credentials used to access Web Apps in the setup.exe 
command line.

Required DCOM permissions when installing on a remote 
system
When you install the AccuRoute Web Apps Client on a remote system, you must configure the DCOM 
permissions on the AccuRoute server. Without this configuration, the AccuRoute server cannot 
communicate with the remote clients. For DCOM configuration instructions, see Configuring required COM 
permissions for launching the remote Web Apps (6-11): . 
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Print to AccuRoute
This section describes how to install both of the client installation options included with the Print to 
AccuRoute software. You can select only one of these options to install. Each client option has both 
standard and silent mode installation processes. 

This section includes:

Installing Print to AccuRoute for the Web (4-13)

Installing Print to AccuRoute for the AccuRoute Desktop (4-17)

Installing Print to AccuRoute for the Web 
This section includes:

Standard Installation of Print to AccuRoute for Web (4-13)

Silent Mode Installation of Print to AccuRoute for Web (4-15)

Note The AccuRoute Desktop Client must be installed prior to installing Print to AccuRoute.

Standard Installation of Print to AccuRoute for Web

To install Print to AccuRoute for Web:

1 Log on to the system where the Print to AccuRoute client is being installed using an account 
that belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\PrintToAccuRoute directory of the system running 
the AccuRoute server containing the Print to AccuRoute client setup files and run Setup.Exe. 
The setup opens the InstallShield Wizard and the Welcome message appears. 

Note If you are installing Print to AccuRoute on the same system, simply navigate to this folder to 
access the setup files. If you are installing Print to AccuRoute on a different system, ensure that 
proper access permissions have been set up for you to access the C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\Print to AccuRoute directory. You can also 
copy the setup files to a shared network directory.
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3 Click Next to begin the installation process.

4 The Document Destination page appears. Your selection here determines the course of the 
installation. Select Upload to Web Apps and click Next..

Note On Pre-install of AccuRoute Desktop on the client system, the install wizard options Upload to 
Web Apps and Launch AccuRoute Desktop appear.

5 The Web Client URL page appears. Enter the AccuRoute Web Client URL. This is usually:
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http://[ServerName]/webclient
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6 Click Next. The Ready to Install the Program page appears. Click Install to install the Print 
to AccuRoute Web Client.

7 When installation is complete, the InstallShield Wizard Completed message appears. Click 
Finish to close the wizard.

Silent Mode Installation of Print to AccuRoute for Web

To install Print to AccuRoute for Web in silent mode:

1 Log on to the client with an account that belongs to the local Administrators group using the 
AccuRoute Service Account credentials.

2 Copy the Print to AccuRoute setup directory to a local drive, or map a drive to the folder that 
contains the setup files.

3 Open a command prompt.

4 Set the current directory to the Print to AccuRoute setup directory.

5 Run: setup.exe /s /v" /qn ALLUSERS=1 ACCUROUTE_SERVER=http://ARServer/
AccuRoute/ L*v C:\Debug\printsetup.log" where the ARServer is the name of the AccuRoute 
server.

This installs Print to AccuRoute to the default location, C:\Program 
Files\UplandAccuRoute\Print To AccuRoute. 
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To change the location, set the property INSTALLDIR. Run: setup.exe /s /v"/qn 
INSTALLDIR=<short name path>" where <short name path> is the short name path to the 
target folder. The entire path must be in short name format.

For example: setup.exe /s /V"/qn ADDLOCAL=JavelinUploader 
ACCUROUTE_SERVER=http://servername/accuroute 
INSTALLDIR=J:\PROGRA~1\UplandAccuRoute\ACCURO~1"

Tip The command for short name conversions is dir /x. Run this command in any directory to return the 
short names of all folders in that directory. For example, to do a short name conversion on 
J:\Program Files, change the current directory to J:\ and run dir /x.

To verify that Print to AccuRoute is installed on the client, go to Device and Printers and 
verify that the AccuRoutePDF printer is installed.

Installing Print to AccuRoute for AccuRoute Desktop
This section includes:

Standard Installation of Print to AccuRoute for AccuRoute Desktop (4-16)

Silent Mode Installation of Print to AccuRoute for AccuRoute Desktop (4-18)

Note The AccuRoute Desktop Client must be installed prior to installing Print to AccuRoute.

Standard Installation of Print to AccuRoute for AccuRoute Desktop

To install Print to AccuRoute for AccuRoute Desktop:

1 Log on to the system where the Print to AccuRoute client is being installed using an account 
that belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\PrintToAccuRoute directory of the system running 
the AccuRoute server containing the Print to AccuRoute client setup files and run Setup.Exe. 
The setup opens the InstallShield Wizard and the Welcome message appears. 

Note If you are installing Print to AccuRoute on the same system, simply navigate to this folder to 
access the setup files. If you are installing Print to AccuRoute on a different system, ensure that 
proper access permissions have been set up for you to access the C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\Print to AccuRoute directory. You can also 
copy the setup files to a shared network directory.
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3 Click Next to begin the installation process.

4 The Document Destination page appears. Your selection here determines the course of the 
installation. Select Launch AccuRoute Desktop and click Next.

5 The Ready to Install the Program page appears. Click Install to install Print to AccuRoute for 
the AccuRoute Desktop.
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6 When installation is complete, the InstallShield Wizard Completed message appears.

7 Click Finish to close the wizard.

Silent Mode Installation of Print to AccuRoute for AccuRoute Desktop

To install Print to AccuRoute for AccuRoute Desktop in silent mode:

1 Log on to the client with an account that belongs to the local Administrators group using the 
AccuRoute Service Account credentials.

2 Copy the Print to AccuRoute setup directory to a local drive, or map a drive to the folder that 
contains the setup files.

3 Open a command prompt.

4 Set the current directory to the Print to AccuRoute setup directory.

5 Run: setup.exe /s /V"/qn ADDLOCAL=ARDLauncher"

This installs Print to AccuRoute to the default location, C:\Program 
Files\UplandAccuRoute\Print To AccuRoute.

To change the location, set the property INSTALLDIR. Run: setup.exe /s /v"/qn 
INSTALLDIR=<short name path>" where <short name path> is the short name path to the 
target folder. The entire path must be in short name format.

For example

setup.exe /s /V"/qn ADDLOCAL=ARDLauncher 
INSTALLDIR=J:\PROGRA~1\UPLANDACCUROUTE\ACCURO~1"

Tip The command for short name conversions is dir /x. Run this command in any directory to return the 
short names of all folders in that directory. For example, to do a short name conversion on 
J:\Program Files, change the current directory to J:\ and run dir /x.

To verify that Print to AccuRoute is installed on the client, go to Device and Printers and 
verify that the AccuRoutePDF printer is installed.
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AccuRoute Queue
This section includes:

Installing AccuRoute Queue (4-19)

Running AccuRoute Queue setup in silent mode (4-22)

Installing AccuRoute Queue
To install AccuRoute Queue: 

1 Log on to the system where the AccuRoute Queue client is being installed using an account 
that belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteQueue directory of the system running 
the AccuRoute server containing the AccuRoute Queue client setup files and run Setup.Exe. 
The setup opens the InstallShield Wizard and the Welcome message appears. 

Note If you are installing AccuRoute Queue on the same system, simply navigate to this folder to 
access the setup files. If you are installing AccuRoute Queue on a different system, ensure that 
proper access permissions have been set up for you to access the C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteQueue directory. You can also 
copy the setup files to a shared network directory.

3 Click Next to begin the installation process. 
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4 The License Agreement screen appears. 

Read the agreement carefully and if you agree to the terms, click Yes. 

5 The Destination Folder screen opens. The default destination is C:\Program 
Files\UplandAccuRoute\AccuRouteQueue.

Note On 64 bit systems, the default destination folder is C:\Program 
Files(x86)\UplandAccuRoute\AccuRouteQueue.
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6 Click Next to accept the default destination. The Start Copying Files page appears listing 
installation details you have supplied. If you want to install in a non-default location, click 
Browse, select the required location, and then click Next. 

7 The installation begins. 
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8 The InstallShield Wizard Complete screen appears when installation is complete. 

9 Click Finish to close the wizard. 

Running AccuRoute Queue setup in silent mode
To run AccuRoute Queue setup in silent mode:

1 Log on to the client with an account that belongs to the local Administrators group using the 
AccuRoute Service Account credentials. 

2 Open a command prompt.

3 Change the current directory to the one containing the setup files. The default location is 
C:\Program Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteQueue.

Note On 64 bit systems, the setup files are located in the C:\Program Files 
(x86)\UplandAccuRoute\AccuRoute\Clients\AccuRouteQueue directory. 

4 To install AccuRoute Queue in silent mode for the first time, record a response file: 

setup.exe /r /v"/qn

This will display the UI and also install the application. It also creates C:\Windows\setup.iss 
file. 

5 Copy the setup.iss file to the following location C:\Program 
Files(x86)\UplandAccuRoute\AccuRoute\Clients\AccuRouteQueue. 

Note For 64 bit systems, the path is C:\Program Files\UplandAccuRoute\AccuRoute 
\Clients\AccuRouteQueue\setup.exe 

6 To install AccuRoute Queue in another system, run: setup.exe /s /v"/qn"

This installs AccuRoute Queue to the default location:
C:\Program Files\UplandAccuRoute\AccuRouteQueue.
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7 Optionally, to change the location, set the property INSTALLDIR, run
setup.exe /s /v"/qn INSTALLDIR=<short name path>" 
where <short name path> is the short name path to the target folder. (The entire path must be 
in short name format. For example, if the long path is C:\Program 
Files\AccuRoute\AccuRouteQueue, then the short path is 
C:\Progra~1(x86)\AccuRoute\Image-~1.)

Note Add (x86) after Program Files for 64-bit systems.

Tip The command for short name conversions is dir /x. Run this command in any directory to return the 
short names of all folders in that directory. For example, to do a short name conversion on 
J:\Program Files, change the current directory to J:\ and run dir /x.

Verify that AccuRoute Queue is installed on the client by navigating to 
…\AccuRoute\AccuRoute Queue on the client and verifying that the AccuRoute Queue 
program files are installed.

AccuRoute Acquisition
This section includes:

Installing AccuRoute Acquisition (4-24)

Running the AccuRoute Acquisition setup in silent mode (4-27)

Accessing the setup files
The AccuRoute Acquisition setup files located in the [Server Installation 
Folder]\Clients\AccuRoute Acquisition which is shared from the AccuRoute server as 
\\[ServerName]\Upland\Clients\AccuRoute Acquisition.

Note Obtain access permissions to the above share to install/copy setup.

file:///\\[ServerName]\Upland\Clients\AccuRoute
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Installing AccuRoute Acquisition 
To install AccuRoute Acquisition client: 

1 Log on to the client using an account that belongs to the Administrators group and navigate to 
the directory containing the setup files

2 Double-click SETUP.EXE 

The InstallShield Wizard appears.
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3 Click Next >

The License Agreement screen appears. Read the agreement carefully.

4 Accept the terms in the license agreement, Click Next >

The Destination Folder screen appears.
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Note Click Change to install to a different folder.

5 Click Next > to install on the destination folder 

The Ready to Install the Program screen appears.
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6 Click Install to begin the installation 

The InstallShield Wizard Completed screen appears.

7 Click Finish

Running the AccuRoute Acquisition setup in silent mode
To run the AccuRoute Acquisition setup in silent mode:

1 Log in to the client with an account that belongs to the local Administrators group using the 
AccuRoute Service Account credentials.

2 Open a command prompt.

3 Change the current directory to the one containing the setup files. The default location is 
C:\Program Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteAcquisition.

Note On 64 bit systems, the setup files are located in the C:\Program Files 
(x86)\UplandAccuRoute\AccuRoute\Clients\AccuRouteAquisition directory. 

4 To install AccuRoute Aquisition in silent mode for the first time, record a response file: 

setup.exe /r /v"/qn

This will display the UI and also install the application. It also creates C:\Windows\setup.iss 
file. 

5 Copy the setup.iss file to the following location C:\Program 
Files(x86)\UplandAccuRoute\AccuRoute\Clients\AccuRouteAcquisition. 
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Note For 64 bit systems, the path is C:\Program Files\UplandAccuRoute\AccuRoute 
\Clients\AccuRouteAquisition\setup.exe 

6 To install AccuRoute Acquisition in another system, run: setup.exe /s /v"/qn"

This installs AccuRoute Aquisition to the default location: C:\Program 
Files(x86)\UplandAccuRoute\AccuRouteAquisition.

7 Optionally, to change the location, set the property INSTALLDIR, run
setup.exe /s /v"/qn INSTALLDIR=<short name path>" 
where <short name path> is the short name path to the target folder. (The entire path must be 
in short name format. 

Tip The command for short name conversions is dir /x. Run this command in any directory to return the 
short names of all folders in that directory. For example, to do a short name conversion on 
J:\Program Files, change the current directory to J:\ and run dir /x.

8 Verify that AccuRoute Acquisition is installed on the client by

a Navigating to ...\AccuRoute\\AccuRouteAcquisition directory on the client system.

b Verifying that the AccuRoute Acquisition program files are installed.

AccuRoute Connect
This section includes:

Installing AccuRoute Connect (4-28)

Running the AccuRoute Connect setup in silent mode (4-30): 

Installing AccuRoute Connect
To install AccuRoute Connect:

1 Log on to the system where the AccuRoute Connect client is being installed using an 
account that belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteConnect directory of the system 
running the AccuRoute server containing the AccuRoute Connect client setup files and run 
Setup.Exe. 
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3 The setup opens the InstallShield Wizard and the Welcome message appears. 

Note If you are installing AccuRoute Connect on the same system, simply navigate to this folder to 
access the setup files. If you are installing AccuRoute Connect on a different system, ensure that 
proper access permissions have been set up for you to access the C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteConnect directory. You can also 
copy the setup files to a shared network directory.

4 Click Next. The License Agreement screen appears. 

5 Read the license agreement and if you agree, select the I accept the terms in the license 
agreement option. 
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6 Click Next. The setup shows the Ready to Install the Program screen.

7 Click Next to begin the installation. When installation is complete, the Installation Complete 
screen appears. 

8 Clear the Launch AccuRoute Connect option if you do not want to open the application.

9 Click Finish to close the InstallShield Wizard. 

Running the AccuRoute Connect setup in silent mode
To run the AccuRoute Connect setup in silent mode:

1 Log in to the client with an account that belongs to the local Administrators group using the 
AccuRoute Service Account credentials. 

2 Open a command prompt.

3 Change the current directory to the one containing the setup files. The default location is 
C:\Program Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteConnect.
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Note On 64 bit systems, the setup files are located in the C:\Program Files 
(x86)\UplandAccuRoute\AccuRoute\Clients\AccuRouteConnect directory. 

4 To install AccuRoute Connect in silent mode for the first time, record a response file: 

setup.exe /r /v"/qn

This will display the UI and also install the application. It also creates C:\Windows\setup.iss 
file. 

5 Copy the setup.iss file to the following location C:\Program 
Files(x86)\UplandAccuRoute\AccuRoute\Clients\AccuRouteAcquisition. 

Note For 64 bit systems, the path is C:\Program Files\UplandAccuRoute\AccuRoute 
\Clients\AccuRouteAquisition\setup.exe 

6 To install AccuRoute Acquisition in another system, change the current directory to the one 
containing the setup files. The default location is C:\Program 
Files(x86)\UplandAccuRoute\AccuRoute\Clients\AccuRouteQueue.

7 Run: setup.exe /s /v"/qn"

This installs AccuRoute Connect to the default location:
C:\Program Files(x86)\UplandAccuRoute\AccuRouteConnect.

8 Optionally, to change the location, set the property INSTALLDIR, run
setup.exe /s /v"/qn INSTALLDIR=<short name path>" 
where <short name path> is the short name path to the target folder. (The entire path must be 
in short name format. 

Tip The command for short name conversions is dir /x. Run this command in any directory to return the 
short names of all folders in that directory. For example, to do a short name conversion on 
J:\Program Files, change the current directory to J:\ and run dir /x.

9 Verify that AccuRoute Connect is installed on the client by

a Navigating to …\AccuRoute\\AccuRouteConnect directory on the client system.

b Verifying that the AccuRoute Connect program files are installed.

AccuRoute COM API
This section includes:

About the Embedded AccuRoute for Intelligent Devices components (4-32): 

Embedded AccuRoute for Intelligent Devices for COM API installation (4-32): 
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About the Embedded AccuRoute for Intelligent Devices 
components
The Embedded AccuRoute for Intelligent Devices setup program installs the required DLL files and the 
Sample project for Visual Basic.

The required DLL files are:

 …\Program Files\Common Files\Upland AccuRoute\omfGFScriptingU.DLL (registered)

 …\Program Files\Common Files\Upland AccuRoute\omfGFInterfacesps.DLL (registered)

 …\Program Files\Common Files\Upland AccuRoute\omimg.DLL

The Sample project for Visual Basic is installed to …\Upland AccuRoute\ComAPI\Sample with several 
modules:

 EDProcessSample.BAS

 EDSample.BAS

 EDScanSample.BAS

 FAXSample.BAS

Embedded AccuRoute for Intelligent Devices for COM API 
installation
Download the Embedded AccuRoute for Intelligent Devices from the Upland AccuRoute web site. Then 
install it on the system where you intend to run the applications.

To install the Embedded AccuRoute for Intelligent Devices:

1 Run the Embedded AccuRoute for Intelligent Devices update utility on the AccuRoute server. 
This installs the Embedded AccuRoute for Intelligent Devices setup to ...\Upland 
AccuRoute\AccuRoute\Clients\ComAPI.

2 Navigate to ...\Upland AccuRoute\AccuRoute\Clients\ComAPI and run setup.exe. The 
InstallShield wizard displays the Welcome screen.

3 Click Next. The License Agreement screen appears.

4 Read the license agreement and click Yes if you agree to the terms. The Choose Destination 
Location screen appears.

5 Accept the default location, or choose a new location if necessary, and click Next. The Start 
Copying Files screen appears.

6 Review the installation settings and click Next. The setup program installs the Embedded 
AccuRoute for Intelligent Devices and displays the InstallShield Wizard Complete screen.

7 Click Finish.
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AccuRoute Cost Recovery 
This section includes:

Backing up existing AccuRoute Cost Recovery configuration files (4-33))

Running the AccuRoute Cost Recovery setup (4-34): 

Backing up existing AccuRoute Cost Recovery configuration 
files
When upgrading CostRecovery from a previous version, make a backup copy of the following Cost 
Recovery configuration files:

 \Upland AccuRoute\AccuRoute\CostRecovery\LFCostRecoveryU.ini

 \Upland AccuRoute\AccuRoute\CostRecovery\lfaccounting.ini

 \Upland AccuRoute\AccuRoute\CostRecovery\CostRecovery.txt

After these files have been backed up, remove Cost Recovery. (Go to Removing CostRecovery on 2-4.) 
Then continue to Running the setup.
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Running the AccuRoute Cost Recovery setup
To run the AccuRoute Cost Recovery setup:

1 Log on to the system where the AccuRoute Cost Recovery client is being installed using an 
account that belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteCostRecovery directory of the system 
running the AccuRoute server containing the AccuRoute Cost Recovery client setup files 
and run Setup.Exe. The setup opens the InstallShield Wizard and the Welcome message 
appears. 

Note If you are installing Cost Recovery on the same system, simply navigate to this folder to access 
the setup files. If you are installing Cost Recovery on a different system, ensure that proper 
access permissions have been set up for you to access the C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteCostRecovery directory. You can 
also copy the setup files to a shared network directory.

3 Click Next to begin the installation process. 
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4 Click Next. The License Agreement screen appears. 

5 Read the license agreement and click Yes if you agree to its terms. The installation Choose 
Destination Location screen appears. 

6 Click Next to accept the default installation location or click Browse to select a custom 
installation location. Then the Cost Recovery setup prompts you to enter the name of the 
AccuRoute Server.
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7 Click Next. The Current Settings screen appears for your review.

8 Click Next to start the installation. The InstallShield Wizard Complete screen appears when 
the installation is complete. 

9 Click Finish.

When upgrading from a previous version, use the configuration files to reconfigure 
CostRecovery.

Important If CostRecovery is being upgraded from a previous version, the application 
configuration files were backed up before the latest version of CostRecovery was 
installed. Do not overwrite the new configuration files using the backup copies from 
an older version. The latest configuration files that are installed with the application 
can contain configurations that pertain to new features. Carefully compare the data 
in the two sets of configuration files, and then copy data into the new files where it 
is appropriate.
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AccuRoute Server Monitor
This section includes:

About the AccuRoute Server Monitor client components (4-37): 

Installing AccuRoute Server Monitor (4-37): 

About the AccuRoute Server Monitor client components
AccuRoute Server Monitor is installed with two components: AccuRoute Server Monitor Administrator 
and AccuRoute Server Monitor service. The Server Monitor service is a Windows service that monitors 
the AccuRoute Server environment and is installed only on one system. The Server Monitor Administrator 
can be installed on multiple systems so that one or more administrators can conveniently manage the 
AccuRoute Server Monitor.

Tip AccuRoute Server Monitor Administrator and AccuRoute Server Administrator are snap-ins to the 
Microsoft Management Console. Both snap-ins are supported on the same system so that 
administrators can manage the AccuRoute Server and the application that monitors it from the 
same location.

Installing AccuRoute Server Monitor
The AccuRoute Server Monitor setup files are installed on the AccuRoute Server in a folder that is not 
shared by default. Before installing Server Monitor, log on to the AccuRoute Server using an account that 
belongs to the local Administrators group, share C:\Program Files\Upland 
AccuRoute\AccuRoute\Tools\ServerMonitor, and give the Server Monitor installation user read access to 
the share the path.

To install AccuRoute Server Monitor:

1 Log on to the system where the AccuRoute Server Monitor client is being installed using an 
account that belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Tools\ServerMonitor directory of the system running the 
AccuRoute server containing the AccuRoute Server Monitor client setup files and run 
Setup.Exe. The setup opens the InstallShield Wizard and the Welcome message appears. 

Note If you are installing AccuRoute Server Monitor on the same system, simply navigate to this folder 
to access the setup files. If you are installing AccuRoute Server Monitor on a different system, 
ensure that proper access permissions have been set up for you to access the C:\Program 
Files\UplandAccuRoute\AccuRoute\Tools\ServerMonitor directory. You can also copy the 
setup files to a shared network directory.



3 Click Next to begin the installation process.

4 Click Next. The setup shows the license agreement.

5 Read the license agreement and click Yes if you agree to the terms. The setup shows setup 
options.

6 Click Next. The setup requests logon credentials for the AccuRoute Server Monitor Service.

Note To install only the AccuRoute Server Monitor Administrator, select Custom. Clear Server 
Monitor Service and click Next. Go to step 8.



7 Enter the logon credentials of the AccuRoute service account or another account that belongs 
to the AccuRoute Admins group on the AccuRoute Server, and click Next. The setup shows 
installation settings.

8 Review the installation settings and click Next to begin the installation. The setup shows a 
message indicating that the installation is complete.

9 Click Finish.

AccuRoute FaxCenter
This section includes:

Installing AccuRoute FaxCenter (4-40): 

Installing AccuRoute FaxCenter
To install AccuRoute FaxCenter:

1 Log on to the system where the AccuRoute FaxCenter client is being installed using an 
account that belongs to the local Administrators group.

2 Navigate to a network folder C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRouteFaxCenter directory of the system 
running the AccuRoute server containing the AccuRoute FaxCenter client setup files and run 
Setup.Exe. The setup opens the InstallShield Wizard and the Welcome message appears. 

Note If you are installing FaxCenter on the same system, simply navigate to this folder to access the 
setup files. If you are installing FaxCenter on a different system, ensure that proper access 
permissions have been set up for you to access the C:\Program 
Files\UplandAccuRoute\AccuRoute\Clients\AccuRoute FaxCenter directory. You can also 
copy the setup files to a shared network directory.



3 Click Next to begin the installation process.

4 Click Next. The License Agreement screen appears.

5 Read the license agreement and click Yes if you agree to the terms. (Click No to exit the setup 
if you do not agree to the terms.) The Choose Destination Location screen appears.



6 Click Browse, navigate to the location where you want to install FaxCenter, select the 
installation directory, click OK, and click Next. The Start Copying Files screen appears.

7 Review the installation settings and click Next to begin installing FaxCenter. The InstallShield 
Wizard Complete screen appears.

8 Click Finish. The installation is complete.
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Section 5: Required Server 
Configuration

This section contains a brief description of the required server configurations for the AccuRoute clients.

This section includes:

AccuRoute Desktop (5-2)

AccuRoute Web Apps (5-8)

AccuRoute Queue (5-11)

AccuRoute Connect (5-12)

AccuRoute Server Monitor (5-17)

AccuRoute FaxCenter (5-20)

Note: The following clients have no required server configurations.

 Print to AccuRoute

 AccuRoute Acquisition

 AccuRoute COM API

 AccuRoute Cost Recovery
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AccuRoute Desktop
This section includes:

Configuring server-client connectivity for AccuRoute Desktop (5-2)

Configuring Group permissions for AccuRoute Desktop (5-6)

Configuring server-client connectivity for AccuRoute Desktop
AccuRoute Desktop supports multiple server-client connectivity methods. Choose an appropriate method 
for the target environment and then complete the required configuration.

This section includes:

About connecting with the AccuRoute Server (5-2)

Configuring server-client connectivity methods (5-3)

Implementing connectivity methods (5-4)

About connecting with the AccuRoute Server

AccuRoute Desktop supports the following methods of server-client connectivity: 

 DCOM

 HTTP

 Secure HTTP

At the beginning of a session, AccuRoute Desktop establishes a connection to the AccuRoute Server—
either by connecting directly using DCOM or submitting the request to AccuRoute Intelligent Device Client. 
The initial connection validates the user’s permissions to run AccuRoute Desktop and solicits a response 
from the AccuRoute Server.

Note AccuRoute Desktop does not maintain a constant connection to the AccuRoute Server during a 
session. Instead, AccuRoute Desktop requests and submits data to the AccuRoute Server on 
demand. 

For example, when the user tries to open an Embedded Directive, AccuRoute Desktop requests a list of the 
user’s Embedded Directives from the AccuRoute Server.

This connectivity behavior brings an added benefit to environments with an AccuRoute Server cluster. 
AccuRoute Desktop can continue a session even when the AccuRoute Server cluster enters a failover state 
and the alternative AccuRoute Server becomes active. Although a momentary delay can occur during the 
failover transition, AccuRoute Desktop establishes a connection to whichever AccuRoute Server is active.

On startup, AccuRoute Desktop reads the connection string and analyzes the first 5 characters. (The 
connection string is either preconfigured in AccuRouteClient.XML or entered in the Connect To Server 
dialog box.)

 If the first 5 characters of the connection string are http:, AccuRoute Desktop uses HTTP 
connectivity. 

 If the first 5 characters of the connection string are https, AccuRoute Desktop uses Secure 
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HTTP connectivity.

 For all other values, AccuRoute Desktop uses DCOM connectivity.

Note For HTTP or secure HTTP connectivity, AccuRoute Intelligent Device Client is required. 
Additionally, if the environment has an AccuRoute Server cluster, then AccuRoute Intelligent 
Device Client must be configured to support an AccuRoute Server cluster. For more information, 
consult the AccuRoute Intelligent Device Client chapter of the AccuRoute Server Installation and 
Configuration Guide. 

Configuring server-client connectivity methods

To configure server-client connectivity, follow the instructions for the appropriate connectivity method:

 DCOM - The DCOM connectivity method facilitates a direct connection between AccuRoute 
Desktop and the AccuRoute Server.

 HTTP - The HTTP connectivity method facilitates a connection between AccuRoute Desktop 
and AccuRoute Intelligent Device Client on the web server. (AccuRoute Intelligent Device 
Client is a web service extension that handles requests for AccuRoute Desktop and the 
AccuRoute Server). 

 Secure HTTP -The secure HTTP connectivity method facilitates a secure connection between 
AccuRoute Desktop and AccuRoute Intelligent Device Client on the web server. (AccuRoute 
Intelligent Device Client is a web service extension that handles requests for AccuRoute 
Desktop and the AccuRoute Server.) 

DCOM

The DCOM configuration on the client running AccuRoute Desktop must give access permissions to the 
AccuRoute Server account. 

To configure DCOM permissions on Windows 2016 and on Windows 2012:

1 Log in to the system where you will install AccuRoute Server using the login credentials of the 
local Administrators group. 

2 Click Start and select Run. Enter dcomcnfg and click OK. The Component Services snap-in 
opens.

3 Expand Component Services > Computers. Right-click My Computer and select 
Properties from the menu options. 

4 Click the COM Security tab.

5 Under Launch and Activation Permissions, click the Edit Limits button, and then click the 
Add button.

6 Add Anonymous Logon in the Permissions list, select the Allow check box to allow the 
Local Launch permission, Local Activation permission, Remote Launch permission, and 
Remote Activation permission for the selected group. 

7 Click OK twice to save changes. 

8 Restart the system for these configuration changes to take effect. 

HTTP
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HTTP connectivity requires AccuRoute Intelligent Device Client. For more information, consult the 
AccuRoute Intelligent Device Client section in the AccuRoute Server Installation Guide. No additional client 
configuration is required.

Secure HTTP

Secure HTTP connectivity requires AccuRoute Intelligent Device Client, and it must be configured to accept 
secure HTTP requests. For more information, consult the AccuRoute Intelligent Device Client section in the 
AccuRoute Server Installation Guide. No additional client configuration is required.

Implementing connectivity methods

On startup, AccuRoute Desktop must be able to establish a connection to the AccuRoute Server. This 
requires a connection string which represents either the location of the AccuRoute Server (DCOM 
connectivity) or the web address of the virtual directory where AccuRoute Intelligent Device Client is 
installed (HTTP and secure HTTP connectivity).

To establish a connection to the AccuRoute Server, AccuRoute Desktop does one of the following:
 Reads the connection string in AccuRouteClient.XML and connects to the AccuRoute Server 

automatically.

 Reads all connection strings in AccuRouteClient.XML and prompts the user select a 
connection string. By default, the user can also enter a connection string manually.

Because AccuRoute Desktop can be customized for users and groups, both scenarios can occur in the 
same environment. Both methods require implementation. For more information, see 

 Entering the connection string manually during login (5-5) 

 Preconfiguring AccuRoute Desktop with the connection string (5-5)



© 2019 by Omtool, Ltd. (Upland AccuRoute) All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

5-5AccuRoute® Clients Installation Guide

Section 5: Required Server Configuration

Entering the connection string manually during login

When logging in to AccuRoute Desktop, the user can enter the connection string manually. It must be 
formatted appropriately for the connectivity method being used.

Preconfiguring AccuRoute Desktop with the connection string

The AccuRoute Desktop configuration file, AccuRouteClient.XML, can be configured with the connection 
string so that AccuRoute Desktop automatically displays the connection string in the server menu or 
connects to the AccuRoute Server immediately.

Upland AccuRoute strongly recommends this configuration. It can eliminate or reduce issues that can occur 
when users do not format the connection string correctly.

To configure AccuRoute Desktop to connect to the AccuRoute Server automatically:

Go to Section 9: Frequently Asked Questions and see Can the client connect automatically 
without prompting the user on startup? (9-4).

To configure AccuRoute Desktop to display the connection string in the server menu:

1 Locate AccuRouteClient.XML on the client on the AccuRoute Server located in …\Upland 
AccuRoute\AccuRoute\Clients\AccuRoute Desktop.

Table 5-1: Connection string formats for DCOM, HTTP, and secure HTTP connectivity

Connectivity method Connection string format

DCOM AccuRoute Server computer name or IP address

Examples:

• 172.16.10.47
• LANGSTON

HTTP http://<web server computer name or IP address>/DESKTOPWebAPI/

The web server is the system running AccuRoute Intelligent Device Client.

Examples:

• http://172.16.10.43/DESKTOPWebAPI
• http://SAPPHIRE/DESKTOPWebAPI
AccuRoute recommends using the IP address because this can reduce or eliminate connection failures related 
to DNS issues.

The connection string must start with “http:”. If it starts with any other value, AccuRoute Desktop attempts to 
connect to the AccuRoute Server using DCOM connectivity.

Secure HTTP is not supported when AccuRoute Intelligent Device Client is configured to accept HTTP 
requests. If the address includes “https” at the beginning, AccuRoute Desktop returns an error and no server 
connection is established.

secure HTTP https://<web server computer name or IP address>/DESKTOPWebAPI/

The web server is the system running AccuRoute Intelligent Device Client.

Examples:

• https://172.16.10.43/DESKTOPWebAPI
• https://SAPPHIRE/DESKTOPWebAPI
AccuRoute recommends using the IP address because this can reduce or eliminate connection failures related 
to DNS issues.

When secure HTTP connectivity is configured, only secure HTTP requests are accepted. The connection 
string must start with “https”, for example, https://langston/desktopwebapi/. If it starts with any other value, 
AccuRoute Desktop returns an error and no server connection is established.
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If any modifications are made to the AccuRoute Desktop setup on the AccuRoute Server and 
the environment has Server cluster, AccuRoute strongly recommends repeating this 
procedure on the alternative AccuRoute Server.

2 Open the file in Notepad or in an XML editor.

3 Go to the Servers section. (Search on Servers if necessary.)

4 Add the following lines:
<Servers>
     <Server default="true">
          <prServerName>[connection string]</prServerName>
     </Server>
</Servers>
The attribute default determines whether the connection string is selected by default in the 
login dialog box:

 If true, then the connection string is selected by default in the server menu.
 If false or omitted, then the connection string is listed in the server menu. The list order 

follows the same order the servers are listed here in the configuration file. If only one 
server is listed, then the connection string is selected by default in the server menu.

For more information on setting a default server, go to Servers (6-8).

5 Verify that the connection string is formatted correctly. (Go to Table 5-1: Connection string 
formats for DCOM, HTTP, and secure HTTP connectivity on 5-5.)

6 Save the file and close it.

7 Start AccuRoute Desktop and verify that it is configured correctly.

Configuring Group permissions for AccuRoute Desktop
Users must have permissions to use AccuRoute Desktop. Permissions, which are set in the Configuration 
> Groups node in the AccuRoute Server Administrator. 

To configure AccuRoute Desktop permissions:

1 Start the AccuRoute Server Administrator.

2 Expand the console tree and go to Configuration > Groups.

3 Double click the Default group and to any other group (you created) that should have 
permission to AccuRoute Desktop. The Group properties page opens. 

Note The Group Default is created when you install AccuRoute Server. The members associated with 
the Default Group are Domain Users.

4 Click the AccuRoute tab to open the AccuRoute page.

5 Check the box beside Enable members of this group as AccuRoute users. 

6 In the Allow group to Route to section, select the recipient types to whom messages can be 
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routed from AccuRoute Desktop.

7 Click OK to save your changes and close the Properties page. 

Tip Permissions determine whether users can run AccuRoute Desktop and which routing destination 
are available to them. Access to other features is controlled through views. 

For environments with an Server cluster, it is not necessary to repeat these procedures on the alternate 
Server. This information is stored in the AccuRoute Server database which is shared by both AccuRoute 
Servers in the cluster.
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AccuRoute Web Apps
This section includes:

Enabling integrated Windows authentication (5-8)

Configuring integrated Windows authentication on clients running Internet Explorer 11 (5-8)

Adding the Web Apps Client URL to the list of trusted sites on a client system (5-9)

Disabling Compatibility Mode in Internet Explorer 11 (5-9)

Selecting a network printer (5-9)

Enabling integrated Windows authentication
The AccuRoute Web Apps Client authenticates users based on their Windows logon credentials. The logon 
credentials are either passed transparently from the client to the web server or entered manually by the user 
at the beginning of each session. The login method depends on how authentication is configured.

Note Windows authentication is required with NTLM authentication. Skip this section for database 
authentication.

Windows integrated authentication is automatically configured on the AccuRoute web server during the 
installation process. 

However, you will need to configure the Internet Explorer for authentication on clients, as described below.

Configuring integrated Windows authentication on clients 
running Internet Explorer 11
You must configure Integrated Windows Authentication on all clients running Internet Explorer 11.

1 Log on to the client using an account that belongs to the local Administrators group and start 
Internet Explorer.

2 Open Internet Explorer and click Tools > Internet Options.

3 Click the Security option. 

4 Select Internet or Local Intranet depending on your default zone, and click Custom level. 

5 The Security Settings page opens. 

6 Scroll down to the User Authentication section and make the following changes:

 To authenticate the Windows user transparently, select Automatic logon with current 
user name and password. 

 To prompt the Windows user to enter logon credentials at the beginning of each session, 
select Prompt for Username and Password. 

7 Click OK to close the Internet Options page. 

8 Close the Internet Explorer browser.
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9 Close all other open instances of Internet Explorer for the change to take effects.

Adding the Web Apps Client URL to the list of trusted sites on a 
client system
You must add the Web Apps Client URL to the list of trusted sites on all client systems which will browse to 
the Web Apps Client. 

1 Log on to the client system using an account that belongs to the local Administrators group 
and open Internet Options. (It is accessible from the Control Panel or Internet Explorer.)

2 Go to the Security tab.

3 Select Trusted sites and click Sites.

4 Enter the Web Apps Client URL and click Add.

5 Deselect Require server verification (https:) for all sites in this zone if this option is 
selected.

6 Click Close to close the Trusted Sites dialog. 

7 Click Apply to save the changes and click OK to close the dialog box.

The Web Apps Client URL is now added to the list of trusted sites. To verify that the system recognizes the 
Web Apps URL as a trusted site, start Internet Explorer and go to the Web Apps URL. Verify that Web Apps 
Client loads. (Depending on your Windows Integrated Authentication configuration, you may need to login. 

Disabling Compatibility Mode in Internet Explorer 11
Using the AccuRoute Web Apps Client with Microsoft Internet Explorer 11 requires that you disable 
Compatibility Mode. 

If you try to launch the Web Apps Client when the server name is included in the URL (for example: http://
servername/accuroute) and Compatibility Mode enabled, the following warning message appears:

Oops. This browser is not supported (this may be resolvable by disabling Compatibility View or 
this site).

To disable Compatibility Mode:

1 In the Internet Explorer 11 browser, click the Tools button.

2 Select Compatibility View Settings.

3 De-select the Display intranet sites in Compatibility View option.

You can now successfully launch the Web Apps Client on the Internet Explorer 11 browser using the server 
name in the URL.

Selecting a network printer
1 Be sure the printer driver is installed on the AccuRoute server. The Web Apps Client will read 

the list of configured network printers on the AccuRoute server. 
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Note Before the network printers are listed in the AccuRoute Web Apps Client, the network printers 
must be added to the Jobs > Printers section of Group Properties in the AccuRoute Server 
Administrator.
For more information on adding and configuring network printers, see the AccuRoute Server 
Administrator Online Help.

2 Log in to the AccuRoute Web Apps Client application.

3 Click the Preferences tile. The Preferences page opens. 

4 Click the Options tile to access the Printer field.

5 In the Printer field, enter the printer Name or IP address of interest and click Save.

Note If you do not save your preferences, your configuration is valid for the current session only. The 
Web Apps Client will not remember your choices if you log out or open a new session. 
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AccuRoute Queue
This section includes:

Configuring the Property Expression feature (5-11)

Configuring the Property Expression feature
The Property Expressions feature allows jobs to be processed based on the value of a property. For 
example, based on a property expression, the Administrator can configure jobs to be released from 
AccuRoute Queue. 

To configure Property Expression for AccuRoute Queue:

1 Click Start >All Programs > Upland AccuRoute > AccuRoute Server Administrator.

2 In the console tree, expand the AccuRoute Server. 

3 Go to the Queues node and select the queue to configure. Open the properties page for the 
Queue. 

4 Open the WorkFlow tab.

5 Add a workflow where the job will be automatically routed if a property (say for example client 
value) is equal to a specific value (for example, say 1111).

Important You must use double quotes not single quotes when configuring the property 
value, for example: 
*\\prDMSCustomFields(prDMSFieldName=client)\prDMSFieldValue="1111"

6 Save the workflow.

Now when a user selects a job and applied the value of "1111" to the job, it is automatically 
routed. 
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AccuRoute Connect
This section includes:

Configuring the AccuRoute Connect node (5-12)

Configuring Groups for AccuRoute Connect (5-14)

Configuring the AccuRoute Connect node
After the AccuRoute Server Administrator has set permissions for the Active Directory groups, the 
Administrator must configure the AccuRoute Connect node. 

To go to the AccuRoute Connect node:

1 Open the AccuRoute Server Administrator console.

2 Expand the Configuration node and find the AccuRoute Connect node.

The AccuRoute Connect node lists all Appspaces defined for the AccuRoute environment. For each 
Appspace, the Administrator will define the Xmodel elements.

Note AppSpace can be thought of as a document container for RegWins. A RegWin is a set of tabs in 
the AppSpace that allow the AccuRoute Server Administrator to associate controls on a Windows 
Application UI in order for the metadata to be captured.

The Appspace and the associated Xmodel definitions will depend on the external application AccuRoute is 
integrating with. 

The following example shows an Appspace that has been defined for integration with a Human Resource 
application processing employee demographic information.
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To collect employee demographic information like primary identification number, employee display name, 
email, phone and or fax number, the AccuRoute Server Administrator will define Xmodel elements for each 
individual information piece as shown below.

Since the AccuRoute action will populate properties from only one X-Model, when mapping properties to X-
Model elements, it is important to create all the elements in one X-Model.

For example, the MyCRM.Appspace that is included with the install and is located in the Samples directory 
has several X-Models in each Regwin. This means that not all the fields are accessible through the 
AccuRoute action.
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Configuring Groups for AccuRoute Connect 
After you have install AccuRoute Connect, you must specify the Groups that can use AccuRoute Connect. 

To configure Group permissions for AccuRoute Connect:

1 In the AccuRoute Server Administrator console, expand Configuration and go to the Groups 
node.

2 Double click the Group you should configure for AccuRoute Connect. The Properties page 
opens.

3 Open the AccuRoute Connect tab.

4 Select the Enable members of this group to use the selected integrations option.

5 Select the AppSpaces the Group members can use. 

6 For each Appspace selected, click Properties to open the Properties page and configure as 
needed.
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7 Select or clear the AccuRoute Connect options for the users as needed. 

8 If you want the user to use only one of the AccuRoute Connect feature by default, select the 
Automatically select option and select the option for the user.

9 For each of the following features - Create a Routing Sheet feature, Create Scan Reservation, 
Open in AccuRoute Desktop and Upload Documents, and specify the template Embedded 
Directive optionally, enable prompt using the instructions below:

a Click Properties and in the Action Properties page that opens, go to the Options tab.

b Click on the Browse button beside the and field and select from available Embedded 
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Directives on the server to serve as a template. 

c Optionally, in the Name text box, provide a descriptive name for the Embedded Directive. 
You can also ask the user to provide a name by checking the Prompt the user to enter 
name option. 

d To enable use of Prompts, select the Prompt user to enter name option. 

e Click OK to save your changes.

10 If you are configuring use of the Link to Queue feature, specify the Application Code using the 
following instructions. 

a In the Properties page, select LinkToAccuRoute Queue and then click Properties in 
that page. The Action Properties page opens. 

b Open the Actions tab. 

c In the Application Code text box, enter IIC. 

d Click OK to save your changes.

11 Close all the other open dialogs to complete Group configuration. 
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AccuRoute Server Monitor
This section includes:

Configuring AccuRoute Server Monitor server properties (5-17)

Clustering Server Monitor (5-17)

Defining sender and recipient e-mail addresses (5-18)

Defining server properties - the General tab (5-18)

Defining failover actions (5-19)

Configuring AccuRoute Server Monitor server properties
After you add an AccuRoute Server to the Server Monitor Administrator, right-click the server (or, highlight 
the server and click Action on the toolbar) to open the available options menu.

The available options are:
Properties - Select this menu item to configure options on the General and Suspend Monitor 
tabs.

Remove - Select this menu item to remove the server from the Server Monitor Administrator.

New - Select this menu item to create a new test.

Figure 5-A: AccuRoute Server Monitor properties

Clustering Server Monitor
When adding a clustered server to the Server Monitor Administrator, it must be active. The server icon in 
the AccuRoute Server Monitor Administrator changes when you add a clustered server.

If you are using a clustered server environment, please consider the following while configuring AccuRoute 
Server Monitor:

 You need to cluster a server before you add it to the Server Monitor Administrator.
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 Make sure you add the preferred server in the cluster to the Server Monitor Administrator.

 If the failover time in a clustered environment exceeds 90 seconds, AccuRoute Server Monitor 
performs all actions specified in the Cluster Failover Action option located on the General tab 
of the server properties. It also performs all these actions if both the preferred and secondary 
servers are shut down.

 After control is moved from the preferred server to the secondary server, the test will be 
performed for the backup server, but the stored configurations are not updated with the 
backup server name.

Defining sender and recipient e-mail addresses
When you add a server to the Server Monitor Administrator, you are prompted to enter two e-mail addresses 
in the Default Test Criteria screen.

Figure 5-2: Default Test Criteria screen

The e-mail address in the From field is used as the default sender's e-mail address whenever you add a 
new e-mail action for your test criteria.

The e-mail address in the To field is used as the default recipient's e-mail address whenever you add a new 
e-mail action for your test criteria.

Note The From and To e-mail addresses are also used for e-mail notifications of critical errors in a 
clustered environment.

Tip You can enter multiple e-mail addresses in the To field by separating each e-mail address with a 
semicolon (;), or you can enter a distribution list address. Distribution list aliases are not supported.

You can update the e-mail addresses in the server properties at any time, as well as override the default e-
mail addresses when creating new test criteria.

Defining server properties - the General tab
The General tab is where you define server properties in the AccuRoute Server Monitor.



© 2019 by Omtool, Ltd. (Upland AccuRoute) All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

5-19AccuRoute® Clients Installation Guide

Section 5: Required Server Configuration

Opening the General tab

Use the following procedure to open the General tab.
To open the General tab in the server properties:

Right-click the server and select Properties. (Or, highlight the server, click Action on the 
toolbar, and select Properties.) The General tab is selected by default.

On this tab, you can:
 Enable or disable monitoring of this server by selecting or clearing Enable monitoring of this 

server. The icon displayed in the Server Monitor Administrator changes based on your 
selection.

 Change the sender and recipient e-mail addresses. You defined these e-mail addresses when 
you added the server to the Server Monitor Administrator.

 Define actions for when a failover occurs.

Tip You can enter multiple e-mail addresses in the To field by separating each e-mail address with a 
semicolon (;), or you can enter a distribution list address. Distribution list aliases are not supported.

Defining failover actions
In a clustered environment, you can define the actions that happen when a failover event occurs in the 
cluster. For example, you can define a Failover Action that sends an e-mail if the secondary server takes 
over from the preferred server.

To define Failover Actions:

1 Click Failover Action on the Server Properties General tab. The Cluster Failover Action 
screen appears.

2 Specify the actions to take when a failover occurs.

Complete the wizard for the action you specified.
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AccuRoute FaxCenter
This section includes:

Creating routing rules for inbound faxes (5-20)

Creating routing rules for inbound faxes
Using the following procedure, you will create an inbound routing rule that determines the faxes that 
should be routed to FaxCenter users. Once the server routes these faxes to FaxCenter. FaxCenter 
users will review each fax, determine the most appropriate recipients and destinations for the fax, 
and route the fax accordingly.

To create a rule for routing inbound faxes to FaxCenter:

1 Double-click Rules in the console tree.

2 Right-click Inbound and select New | Rule. The Specify the Criteria for this Rule screen 
appears.

3 Click the Add button, select a criterion for inbound faxes that should match this rule, and click 
Next. 

4 Specify the parameters for the criterion you selected in the previous step and click Finish. 

5 Add more criteria for inbound faxes that should match this rule, if needed, and click Next. The 
Specify the Actions to take for this Rule screen appears.

6 Click Add. The Add Rule Action screen appears.

7 Select FaxCenter and click Next. The Route to FaxCenter screen appears.

8 Select the FaxCenter user option only if you want the inbound faxes that match this rule to be 
routed to a particular FaxCenter user, and then select the FaxCenter user from the drop-down 
list. (If you do not select this option, inbound faxes that match this rule will be routed to all 
FaxCenter users.)

Type the number of hours a fax can reside in FaxCenter in the Expiration Time spin box. (If a 
fax has not been routed to a recipient or other destination within the allotted time, the server 
fails the fax and removes it from FaxCenter.)

Click Finish.

9 Add any other actions for inbound faxes that match this rule, if needed, and click Next. The If 
any Action(s) fail do the following screen appears.

10 Add the actions you want to apply to faxes that match this rule if any of the primary actions fail 
(optional), and click Next. The Specify a name for this rule screen appears.

11 Type a friendly name for the rule in the text box, and configure the other options in this screen 
as needed, and click Finish. The new rule wizard creates the rule and displays all the inbound 
routing rules.

Now that you have created an inbound routing rule for FaxCenter, order the inbound routing rules 
as needed.
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Section 6: Required Configuration

This section contains a brief description of the required configurations of different AccuRoute clients.

This section includes:

AccuRoute Desktop (6-2)

AccuRoute Web Apps (6-12)

AccuRoute Queue (6-16)

AccuRoute Connect (6-17)

AccuRoute COM API (6-18)

AccuRoute CostRecovery (6-20)

AccuRoute Server Monitor (6-35)

AccuRoute FaxCenter (6-38)

The following client do not have any server configurations.

 Pint to AccuRoute

 AccuRoute in Acquisition
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AccuRoute Desktop
This section includes:

Configuring address book integration in the AccuRoute Desktop setup (6-2)

Using AccuRoute Desktop with an AccuRoute Connector for DMS (6-4)

Configuring MyAccuRoute on the AccuRoute Server (6-4)

Configuring the Watch Folders application on the AccuRoute Server (6-5)

Modifying the AccuRoute Desktop configuration file (6-6)

Configuring address book integration in the AccuRoute 
Desktop setup
Address book integration in AccuRoute Desktop enables users to add message recipients from the same 
address book they use to send email messages. Because AccuRoute Desktop supports all contacts in the 
address book, including global and personal contacts, users can quickly access all the message recipients 
they can access from their email application. Supported email applications include:

 Outlook

 Notes

 GroupWise

The address book configuration is stored on the client, so AccuRoute Desktop can be configured to support 
different address books on different clients. However, each installation of AccuRoute Desktop supports only 
one address book: Outlook, Notes, or GroupWise. Address book integration can also be disabled.

Upland AccuRoute recommends configuring address book integration in the AccuRoute Desktop setup on 
the AccuRoute Server. This ensures that no configuration is required on the client after AccuRoute Desktop 
is installed.

By default, AccuRoute Desktop is configured to support the Outlook address book. If the default 
configuration is correct, skip this procedure.

Tip The address book configuration is stored in AccuRouteclient.xml. There are additional properties 
in this file that can be modified before AccuRoute Desktop is installed on the client. 

To configure address book integration in the AccuRoute Desktop setup:

1 Log on to the system running the AccuRoute Server. Navigate to …\Upland 
AccuRoute\AccuRoute\Clients\AccuRouteDesktop\program 
files\AccuRoute\AccuRouteDesktop.

2 Open AccuRouteclient.xml in Notepad or an XML editor.

3 Go to prMailType and modify the value of this property using one of the following values:

 Outlook (default)

 LotusNotes

 Groupwise
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 None

Note None disables address book integration. When address book integration is disabled, the user 
must enter the destination address of all recipients manually.

4 Save your changes and close the file. 
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To configure address book integration in the system running AccuRoute Desktop

1 Log on to the system running the AccuRoute Server. Copy the updated file 
AccuRouteclient.xml from 
…\UplandAccuRoute\AccuRoute\Clients\AccuRouteDesktop\program 
files\AccuRoute\AccuRouteDesktop

2 Now go to the client system where AccuRoute Desktop is already installed. Paste the file in 
…\AccuRoute\AccuRouteDesktop and replace the existing file.

Important For environments with an AccuRoute Server cluster, AccuRoute strongly 
recommends repeating this procedure on the alternate AccuRoute Server.

Using AccuRoute Desktop with an AccuRoute Connector for 
DMS
AccuRoute Desktop can be configured to integrate with document management systems and other 
specialized applications that extend the functionality of pre-existing document storage and retrieval 
methods. For more information on configuring DMS connectors, consult the AccuRoute DMS Libraries 
documentation. For general information on AccuRoute Connectors for DMSs, contact AccuRoute Sales. 

Configuring MyAccuRoute on the AccuRoute Server
The MyAccuRoute feature streamlines a workflow; it enables the AccuRoute Server to process all 
messages from the same user with the same Embedded Directive. For example, suppose a user is 
responsible for scanning hard copy documents at a scanning station and routing them all to the location 
where another user indexes and archives those documents. When MyAccuRoute is configured for the user, 
the AccuRoute Server always applies the Embedded Directive specified in the user’s My AccuRoute 
configuration, which in turn specifies the destination to which to route the scanned documents.

The key aspect of this configuration is that the AccuRoute Server must be able to identify the sender so that 
it can apply the Embedded Directive that is selected in the user’s MyAccuRoute configuration. The previous 
example that describes a user at a scanning station presumes that the user logs in to the scanning station 
and that this data accompanies the scan to the AccuRoute Server. There are other scenarios in which the 
user might be submitting messages repeatedly from AccuRoute Desktop.

Tip AccuRoute offers customized solutions for some device manufacturers including Xerox, HP, Sharp 
and Ricoh. Contact AccuRoute Sales for more information. 

The configuration that supports MyAccuRoute has two required components:

 MyAccuRoute configuration on the client - The user must create an Embedded Directive 
and select it in the My AccuRoute configuration in AccuRoute Desktop. For more information, 
consult the AccuRoute Desktop User Guide. 

 Outbound rule on the AccuRoute Server - An outbound rule must identify the criteria for the 
message, for example, the sender, and set the action so that the AccuRoute Server processes 
the message using MyAccuRoute.

mailto:sales@omtool.com
mailto:sales@omtool.com
mailto:sales@omtool.com
mailto:sales@omtool.com
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MyAccuRoute is configured on the AccuRoute Server. Notify users that they must configure MyAccuRoute 
before they can begin using this feature. By default, an outbound rule already exists on the server.

For environments with an AccuRoute Server cluster, it is not necessary to repeat this procedure on the 
alternate AccuRoute Server. This information is stored in the AccuRoute Server database which is shared 
by both AccuRoute Servers in the cluster.

Configuring the Watch Folders application on the AccuRoute 
Server
Watch Folders is a desktop application installed with AccuRoute Desktop. A watch folder is:

 an ordinary folder residing on the client system running AccuRoute Desktop 

 has been identified in AccuRoute Desktop as a “watch folder”

 has been associated with an Embedded Directive

In AccuRoute Desktop v6.0, the Watch Folders have been modified to support the following categories:

 Deliver to ED

 Deliver to Recipient (DMS only supported in this release)

 Launch AccuRoute Desktop

You can also configure the Watch Folder tray application to start at Windows starts up. It uses Virtual 
Filescan implementation and gathers files that are dropped in known/specified folders and then process 
them through the AccuRoute Server. 

When the AccuRoute Desktop user wants to send a message using the Embedded Directive that has been 
associated with the watch folder, the user copies files to the watch folder, and AccuRoute Desktop 
processes those files as a message. In this way, the watch folder functions as an automatic sending queue. 
Similarly, when the user wants to deliver a message to a DMS, the user copies the file to the designated 
watch folder from where it is picked up and processed by the server and routes to the DMS. 

Advantage of using Watch Folders

When the AccuRoute Desktop user wants to send a message using the Embedded Directive or a specific 
folder associated as a watch folder, the user copies files to the watch folder. AccuRoute Desktop processes 
those files as a message and sends them to the AccuRoute Server for further processing. In this way, the 
watch folder functions as an automatic sending queue.

The biggest advantage to using the Watch Folders therefore is that they enables users to streamline their 
most common workflows. Consider the following example. An executive assistant sends out a packet of 
materials each week to a group of people who meet weekly to discuss operations. 

The executive assistant simply gathers the files that should be distributed to group members and copies 
them to the watch folder that was set up for this purpose. AccuRoute Desktop immediately processes the 
files in the folder as a single message and distributes those files using the Embedded Directive that is 
associated with the watch folder.

The configuration supporting the Watch Folders requires two components:

 Watch Folders configuration on the AccuRoute Desktop client - The user must configure 
the Watch Folders application and identify the local folders that should be designated as watch 
folders. For more information consult the AccuRoute Desktop user guide. 

 Outbound rule configuration on the AccuRoute Server - An outbound rule must identify 
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outbound messages with an Embedded Directive and allow the Embedded Directive Manager 
component to process these messages using the Embedded Directive specified in the user’s 
Watch Folders configuration. 

To create an outbound rule on the AccuRoute Server for the Watch Folders application:

1 Start the AccuRoute Server Administrator.

2 Expand Rules in the console tree.

3 Right-click Outbound and select New > Rule. The rules wizard appears on the desktop.

4 Click the Add in the Specify the Criteria for this Rule window. Select Embedded Directive 
in the list of criteria and click Next. Select is, enter *, and click Add. Click Finish. The criteria 
Where Embedded Directive is * appears in the list. Click Next.

5 Click the Add in the Specify the Actions to take for this Rule window. Select Route to 
Embedded Directive Manager and click Next. Select Use sender-specified Embedded 
Directive and click Finish. The action Use the Embedded Directive Manager to determine 
actions appears in the list. Click Next.

6 Click Next in the If any Action(s) fail do the following window.

7 Verify that Stop processing other rules is selected and click Finish.

Note This rule identifies all outbound messages with an Embedded Directive. If the AccuRoute Server 
has more than one rule that identifies messages with an Embedded Directive, review the list of 
rules and verify that the rule order produces the correct results.

The Watch Folders application is configured on the AccuRoute Server. Notify users that they must configure 
the Watch Folders application before they can begin using this feature.

For environments with an AccuRoute Server cluster, it is not necessary to repeat this procedure on the 
alternate AccuRoute Server. This information is stored in the AccuRoute Server database which is shared 
by both AccuRoute Servers in the cluster.

Modifying the AccuRoute Desktop configuration file
The AccuRoute Desktop configuration file, AccuRouteclient.xml, provides configuration data to AccuRoute 
Desktop on startup. The configuration data includes the name of the view that AccuRoute Desktop loads on 
startup in standard mode, the email application that provides address book support to AccuRoute Desktop, 
the search folders that contain view files and Routing Sheet template files, and the AccuRoute Server in the 
network.

AccuRouteclient.xml can be modified after AccuRoute Desktop is installed on the client. If 
AccuRouteclient.xml is modified after AccuRoute Desktop is installed on the client, push the file out to 
…\AccuRoute\AccuRouteDesktop on the client and replace the existing file.

Modify AccuRouteclient.xml using the guidelines in the following table. The major sections of the file appear 
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in bold typeface.

Table 6-1: Guidelines on modifying elements in AccuRouteClient.XML

Element Parent Description

Configuration — Root element.

AppData Configuration Section containing application data that AccuRoute Desktop reads on startup. It 
identifies the view file that AccuRoute Desktop loads on startup in standard mode and 
the email system on the client. For example: 

<Configuration>
     <AppData>

          <prDefaultView>$/Default.view</prDefaultView>

          <prMailType>Outlook</prMailType>

     </AppData>
     …
</Configuration>

AppData The AppData section supports the following properties:

• prDefaultView - Filename of the view that AccuRoute Desktop loads on startup 
in standard mode. For example: 
<AppData>
     <prDefaultView>$/Default.view</prDefaultView>
     …
</AppData>

• prMailType - Email application that provides address book support to AccuRoute 
Desktop. (For a list of email applications and versions that have been qualified 
with AccuRoute Desktop, go to Section 3: Requirements.) For example: 
<AppData>
     …
     <prMailType>LotusNotes</prMailType>
</AppData>

Use any of the following values:

Outlook

LotusNotes

Groupwise

None (Requires the user to enter the addresses of email recipients and fax 
recipients manually.)

HelpSystem Configuration Section indicating the location of the AccuRoute Desktop user guide. Do not modify 
these values. 
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SearchFolders Configuration Section identifying all the folders in the network that contain view files (*.VIEW) and 
Routing Sheet template files (*.WTX, *.OMTPL, *.DOC).

The optional attribute overridable determines whether the user can expand the list of 
search folders. If overridable="true", the user can add folders to the Configuration 
Folders list, and then delete or modify only the folders that the respective user added. 
If overridable="false", the user cannot add folders to the Configuration Folders list.

For example: 
<Configuration>
     …
     <SearchFolders overridable="false">
          …
     </SearchFolders>
     …
</Configuration>

Note: A search folder does not include its subfolders. Each folder containing view 
files or Routing Sheet template files must be defined individually.

Folder SearchFolders Section identifying a folder in the network that contains view files (*.VIEW) and/or 
Routing Sheet template files (*.WTX, *.OMTPL, *.DOC). For example:
<SearchFolders overridable="true">
     <Folder>
          <prName>RSTemplates<\prName>
     </Folder>
     …
</SearchFolders>

The Folder section supports the following properties:

• prName - Folder that contains view files (*.VIEW) and/or Routing Sheet template 
files (*.WTX, *.OMTPL, *.DOC). Use any of the following values:

alias such as General views (Go to Aliases on 6-9.)

%InstallFolder% to represent …\AccuRouteServer\AccuRouteViews on the 
AccuRoute Server

UNC path such as \\computer\folder

local path such as c:\folder or c:\folder\

For example:
<Folder>
     <prName>%InstallFolder%<\prName>
</Folder>

Table 6-1: Guidelines on modifying elements in AccuRouteClient.XML

Element Parent Description
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Servers Configuration Section defining the AccuRoute Servers in the network.

AccuRoute Desktop must establish a connection to the AccuRoute Server before 
allowing a user to begin a session. The optional attribute autoconnect determines 
whether AccuRoute Desktop prompts the user to login and select an AccuRoute 
Server. Use true to enable autoconnect, or false to disable autoconnect. For example: 
<Configuration>
     …
     <Servers autoconnect="true">

          <Server default="true">

               <prServerName>LANGSTON</prServerName>

          </Server>

     </Servers>
     …
</Configuration>

If autoconnect="true", AccuRoute Desktop connects to the AccuRoute Server 
automatically. AccuRoute Desktop authenticates the user based on the user login to 
the email application. Consider the following autoconnect scenarios:

• If the email application is configured to start automatically and 
autoconnect="true", AccuRoute Desktop suppresses the Connect to Server dialog 
box on startup and connects to the AccuRoute Server automatically. 

• If the email application is configured to prompt the user to select an identity/
profile and autoconnect="true", the user selects an email identity/profile and then 
AccuRoute Desktop connects to the AccuRoute Server. 

• If the element prMailType uses the value None (See the description of prMailType 
on 6-7.) and autoconnect="true", the user must complete the Connect to Server 
dialog box on startup. After providing a name and e-mail address, the user must 
select Always connect to this server. Then AccuRoute Desktop connects to the 
AccuRoute Server automatically.

Note: If autoconnect="true", include only one AccuRoute Server in the 
<Servers> section or set default="true" on the AccuRoute Server that AccuRoute 
Desktop should connect to automatically.
If autoconnect="false" or if the attribute is not set, AccuRoute Desktop prompts the 
user to select an AccuRoute Server and log in. A list menu displays all the AccuRoute 
Servers defined in this section.

Table 6-1: Guidelines on modifying elements in AccuRouteClient.XML

Element Parent Description
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Server Servers An AccuRoute Server in the network. 

The optional attribute default determines whether the server is the default selection. 
Use one of the following values: true to indicate the default server, or false (default). 

If default="true", AccuRoute Desktop displays the server as the first item in the server 
list menu. This item is selected by default. If configured to autoconnect (Go to Servers 
on 6-8.), AccuRoute Desktop connects to the default server automatically. 

If default="false" and multiple servers are included in this section, or if this attribute 
is not present and multiple servers are included in this section, the AccuRoute Server 
is not the default server.

The following code sample shows SAPPHIRE as the default server:
<Servers>
     …
     <Server default="true">

     <prServerName>SAPPHIRE</prServerName>

     </Server>
     …
</Servers>

The Server section supports the following properties:

prServerName - Connection string. It must be formatted appropriately for the server-
client connectivity method. (Go to Table 5-1: Connection string formats for DCOM, 
HTTP, and secure HTTP connectivity on 5-5.) For example:
<Server>
     <prServerName>SAPPHIRE</prServerName>
</Server>

Aliases Configuration Section defining aliases for search folders. A search folder is a folder in the network 
that contains view files (*.VIEW) and/or Routing Sheet template files (*.WTX, 
*.OMTPL, *.DOC). (See the description of prName on 6-7.) For example:
<Configuration>
     …
     <Aliases>
          <Alias>

               <prAlias>General views</prAlias>
               <prValue>\\LANGSTON\
                AccuRouteServer\AccuRouteViews\
               </prValue>

          </Alias>
          …
     </Aliases>
     …
</Configuration>

Table 6-1: Guidelines on modifying elements in AccuRouteClient.XML

Element Parent Description
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Alias Aliases Section defining an alias for a search folder. A search folder is a folder in the network 
that contains view files (*.VIEW) and/or Routing Sheet template files (*.WTX, 
*.OMTPL, *.DOC). (See the description of prName on 6-7.) For example:
<Aliases>
     <Alias>
          <prAlias>General views</prAlias>
          <prValue>\\LANGSTON\
          AccuRouteServer\AccuRouteViews\
          </prValue>

     </Alias>
     …
</Aliases>

Important! Do not delete the default alias $/. It is required for the Send To 
AccuRoute Desktop feature.
The default alias is defined in AccuRouteclient.xml:

<Aliases>
     <Alias>
          <prAlias>$/</prAlias>
          <prValue>\\server\AccuRouteViews\</prValue>

     </Alias>
     …
</Aliases>

The Alias section supports the following properties:

• prAlias - Alias, or friendly name, for a search folder. A search folder is a folder in 
the network that contains view files (*.VIEW) and/or Routing Sheet template files 
(*.WTX, *.OMTPL, *.DOC). (See the description of prName on 6-8.) For 
example: 
<Alias>
     <prAlias>General views</prAlias>
     …
</Alias>

• prValue - Path to the search folder. Use one of the following values:

%InstallFolder% to represent …\AccuRouteServer\AccuRouteViews on the 
AccuRoute Server

UNC path such as \\computer\folder or \\computer\folder\

local path such as c:\folder or c:\folder\

1 For example:
<Alias>
     …
     <prValue>%InstallFolder%</prValue>
</Alias>

Table 6-1: Guidelines on modifying elements in AccuRouteClient.XML

Element Parent Description
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AccuRoute Web Apps
This section includes:

Configuring required COM permissions for launching the remote Web Apps (6-12)

Creating a new Web Apps Client Profile (6-12)

Adding a Web Apps Client Profile to a User Group (6-15)

Configuring prompts and additional custom options (6-15)

Configuring required COM permissions for launching the 
remote Web Apps 
If your Web Apps Client is installed on a remote system (separate from that of the AccuRoute Server), you 
must configure COM permissions for Anonymous_logon on the AccuRoute server. 

To do so:

1 Log in to the system running the AccuRoute server using an account that belongs to the 
Administrator.

2 Click Start > Control Panel > Administrative Tools > Component Services. 

3 In the console, expand Component Services > Computers.

4 Right-click My Computer and select Properties from the drop-down menu. 

5 Click COM Security.

6 In the Access Permissions section, click Edit Limits. The Access Permission page opens. 

7 For user Anonymous_logon, select Local Access and Remote Access permissions. 

8 Click OK to close the page.

9 In the Launch and Activate Permissions section, click Edit Limits. The Launch 
Permissions page opens. 

10 For user Anonymous_logon, select Local Launch, Remote Launch, Local Activation, and 
Remote Activation permissions. 

11 Click OK and then OK again to close the Properties page. 

Creating a new Web Apps Client Profile
During installation, the system automatically creates default Web Apps Client profiles. To create additional 
profiles:

1 In the AccuRoute Server Administrator, go to the Configuration node and right-click Web 
Apps > New > Profile. The New Profile Properties screen appears. 
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2 Enter a profile Name, and optionally, a Description.

3 Go to the Applications tab, click Add and (one at a time) select the applications of interest 
from the various options in the drop-down menu. 

4 For example, click Add > Messages > Inbox. The Inbox Application Properties screen 
opens. Here you can further refine specific Inbox properties as needed. 
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5 Click OK to exit the application Properties screen. When you return to the New Profile 
Properties screen, you will see the selected Application added to the list. 

6 In the Features tab, click Add and select any Feature you want to associate with the Profile. 
Options include: DocumentLink, Favorites, PrintToWeb, ScanToWeb, and SendToWeb. 

7 As it does with Applications, a Properties screen appears for any Feature you select. You can 
further refine a Feature’s characteristics in its Properties page. 

8 Click OK to exit the Features Properties screen, and click OK again.

9 Your new profile appears in the Web Apps list.

To edit properties of an existing Profile, right-click the profile of interest and select Properties to access 
Profile Properties.
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Adding a Web Apps Client Profile to a User Group
1 Go to Configuration > Groups, right-click the group of interest and select Properties.

2 In the Group Properties screen, click Clients > Web. 

Make sure Enable members of this group to use the following web view is selected. 

3 Click the Profile drop-down list and select the Profile of interest. Click OK.

The user group is now updated to use the new Profile in Web Apps.

Configuring prompts and additional custom options
See the AccuRoute v6.0 documentation page. 

http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
http://www.omtool.com/documentation/accuroute/6.0/documentation.htm
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AccuRoute Queue
This section includes:

Connecting to AccuRoute Queue (6-16)

Connecting to AccuRoute Queue
To connect to the AccuRoute Queue application:

1 Login to the system as a member of a Group with access rights to AccuRoute Queue.

Note When you launch AccuRoute Queue, it automatically pulls your Windows authentication 
information. If the authentication used does not have access permissions to a predefined Queue, 
you will not be able to login.

The AccuRoute Server Administrator, when creating a queue, defines which Group has access 
to the Queue. In addition, the administrator also defines the types of permissions the Group has. 
In order to login to AccuRoute Queue and access your Queue, you must be a member of the 
defined Group which has access to a Queue. 

2 Click Start > All Programs > AccuRoute> AccuRoute Queue to launch the application.

3 You are prompted to connect to an AccuRoute Server.

4 In the Server drop down, select the AccuRoute Server name and enter the IP address of the 
AccuRoute Server. Alternately, manually enter the name of the AccuRoute Server. 

5 Click OK. 
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AccuRoute Connect
This section includes:

Configuring Queue Workflow rule for Link to Queue feature (6-17)

Configuring Queue Workflow rule for Link to Queue feature
The Link to Queue feature of AccuRoute Connect requires a Queue workflow rule for the External 
Applications folder for AccuRoute Queue is setup. Without this rule, jobs will not get routed to the External 
Applications folder, nor will it be listed in the AccuRoute Workflow Integration Application page (this is the 
page that opens when an user selects Link to Queue option in AccuRoute Connect). 

To configure the External Application Queue workflow rule:

1 In the AccuRoute Server Administrator, go to the Queues node. 

2 Select a Queue to configure. The Properties page opens.

3 Open the Workflow tab.

4 Click Add to open the Queue Workflow Rules Properties page.

5 In the Description text box, enter the name for the workflow, for example, ExternalApp.

6 In the Criteria section, click Add. The Add Workflow Criteria page opens. 

7 Select Property Dictionary Item and click Next. 

8 Select the property from the drop down list. Next select the is valid option and click Finish.

9 In the Action section, click Configure. The Configure Action Workflow page opens. 

10 Select External Application and click Next. 

11 In the Application Code text box, enter IIC and click Finish. 

12 Click OK to close the Queue Workflow Rules Properties page.

Queue workflow configuration is complete. 
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AccuRoute COM API
This section includes:

AccuRoute Intelligent Device Client objects (6-18)

AccuRoute Intelligent Device Client objects
The AccuRoute COM API supports the following objects:

 EmbeddedDirective object - Represents an embedded directive. (An embedded directive is 
an encoded key that represents a set of routing instructions.)

 EmbeddedDirectiveTemplate object - Represents a routing sheet template.

 Message object - Represents a message on the AccuRoute server. (A message has at least 
one recipient or destination and at least one attachment.) 

 MessageAttachment object - Represents a file attachment to a message.

 MessageRecipient object - Represents the recipient or destination of a message. 

 MessageServer object - Represents the message server.

 RecipientJournal object - Represents the message journal. (The message journal is a log of 
events pertaining to the message; each time the server acts on a message, it adds an event to 
the journal and indicates whether the action was successful. If the action failed, the description 
of the event usually indicates the reason for the failure.)

 ServConnect object - Represents a connection to the message server.

 User object - Represents a user within your organization.

 UserDelegate object - Represents a delegate. A delegate is a user who can manage the 
messages of another user, and/or send messages on behalf of another user.
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Figure 6-1: AccuRoute Intelligent Device Client objects and their relationships

The Message Server object exposes the Message object (which exposes the Message Recipient object and the 
Message Attachment object), the Embedded Directive object (which exposes the Message Recipient object), the 
Embedded Directive Template object, and the User object (which exposes the User Delegate object).
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AccuRoute CostRecovery
This section includes:

Overview of AccuRoute CostRecovery configuration (6-20)

Configuring AccuRoute CostRecovery file locations (6-20)

Working with fields, delimiters, and masks (6-23)

Using the skip list to omit message types (6-23)

Overview of AccuRoute CostRecovery configuration
After installing AccuRoute CostRecovery, you need to configure it to collect the type of information you need 
for your billing system. You can also configure the format the program uses to save information so that your 
billing system can read the information from the AccuRoute CostRecovery reports, and the price for the 
number of pages sent in faxes or e-mail messages.

You can configure: 

 The names and location of files that AccuRoute CostRecovery uses in the process of 
collecting information and generating reports for your billing system. These files include the 
output file generated by AccuRoute CostRecovery, the template file used to format output, and 
log files to which AccuRoute CostRecovery writes information about its processing. See 
Configuring AccuRoute CostRecovery file locations (6-20).

 The type of information collected and the format of the information in the output report that 
AccuRoute CostRecovery generates. The type of information available for collection differs 
depending on whether you use AccuRoute CostRecovery with Genifax or AccuRoute. See 
Working with fields, delimiters, and masks (6-23).

 Whether AccuRoute CostRecovery includes entire billing codes or only portions of the billing 
codes. If only a portion of the billing codes is used, you can configure how AccuRoute 
CostRecovery extracts that portion from the whole billing code. See Including billing codes in 
AccuRoute CostRecovery output (6-31).

 The prices AccuRoute CostRecovery assigns to message transactions. The transactions 
available for pricing differ depending on whether you use AccuRoute CostRecovery with 
Genifax or AccuRoute.

Configuring AccuRoute CostRecovery file locations
AccuRoute CostRecovery uses or creates a number of files in the process of collecting information about 
message transactions. You can configure the names of these files and their locations if you want to specify 
names different from the default names. The files for which you can configure this information are:

 Output File - This is the file that AccuRoute CostRecovery generates when it runs and 
collects information from Genifax or AccuRoute. You must specify this information before 
AccuRoute CostRecovery can run properly. By default, the output file is called cr.txt, and is 
located in the installation directory for Genifax or AccuRoute. For example: \Program 
Files\AccuRoute\AccuRoute CostRecovery\cr.txt

 Template File - This is the file that AccuRoute CostRecovery uses to generate the output file. 
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By default, this file is called AccuRoute CostRecovery.txt.

Note The template file specifies the type of information AccuRoute CostRecovery collects as well as 
the format in which it saves the information. You should configure this information according to 
the requirements of your company and your billing system. See Working with fields, delimiters, 
and masks (6-23).

 Temporary File - AccuRoute CostRecovery uses this file in the collection process. This file is 
removed at the end of the process. By default, this file is called AccuRoute CostRecovery.tmp.

 Log File - AccuRoute CostRecovery writes to this file each time it runs. It writes a brief 
summary of the export process, including the date and time at which AccuRoute 
CostRecovery runs, the status of the collection, and how many message transactions were 
collected, and whether any errors were encountered. By default, this file is called AccuRoute 
CostRecovery.log.

 Server Name - This option is not a file, but the name of the Genifax or AccuRoute server to 
which AccuRoute CostRecovery must connect to collect information about the calls made, the 
messages sent, or other document transactions that occur. This option is initially set during the 
installation of AccuRoute CostRecovery, but can be modified at any time.

This section includes:

Selecting the location of the AccuRoute CostRecovery output file (6-21)

Configuring the names and locations of AccuRoute CostRecovery files (6-22)

Selecting the location of the AccuRoute CostRecovery output 
file
The output file that AccuRoute CostRecovery generates each time it runs should be stored in a location to 
which either the employees who process accounting information or your billing system have access. If your 
billing system can automatically retrieve the output file from a particular location, configure AccuRoute 
CostRecovery to save the file to the appropriate location. If the folder to which the output file is saved is 
located on a separate system from your billing system, ensure that the folder is shared with the necessary 
permissions so the billing system can access the file.
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Configuring the names and locations of AccuRoute 
CostRecovery files

To configure the names and locations of AccuRoute CostRecovery files:

1 Start AccuRoute CostRecovery and click Configure in the Standard group in the left column.

2 Go to the fields under File Locations in the Options tab, and enter the full path to and name 
of the AccuRoute CostRecovery file as you want it to be, or click the open folder button beside 
the appropriate file’s field to select the location.

Note You need only modify the name and location of the files you want to modify; you can leave the 
other files with their default settings.

3 Click Apply to save your changes.

Configuring output data
AccuRoute CostRecovery saves the information it collects from or AccuRoute to an output file, which you 
then import into your billing system. You can customize the output to meet the needs of your billing system 
and your company. You can:

 Specify the name and location of this file. (Go to Configuring the names and locations of 
CostRecovery files on 6-20.)

 Configure the type of information AccuRoute CostRecovery collects, as well as the format in 
which it saves the information in the output file. (Go to Configuring the export format and 
creating the template file on 6-22.)

 Configure the removal of certain digits from the dialed fax number if your phone system 
requires extra digits to be dialed. (Go to Configuring the removal of digits from fax numbers on 
6-28.)

The type of information collected and the format in which it is saved in the AccuRoute CostRecovery output 
file is specified in a template file. You do not need to modify the file itself; when you make changes on the 
Export Format tab in AccuRoute CostRecovery, the information is automatically stored in the template file.
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Using the skip list to omit message types
CostRecovery can omit messages that do not contain billing data. A skip list is located in the configuration 
file LFCostRecoveryU.ini. Items can be added based on a destination field type containing a destination field 
type value. For example, 

A skipped item consists of three components:

 TS number - An item in the TrxSkipList section must appear on a separate line, and the line 
must be begin with a TrxSkipList identifier. The identifier is simply a way to identify each item 
in the skip list. The formula for creating an identifier is TS+1. If the first item in the skip list has 
the identifier TS1, the second item is TS2, the third item is TS3, and so on. This identifier 
ensures that CostRecovery parses the codes correctly.

 destination field code - The destination field code is a code that represents the field that is 
used as the key to identifying items that should be skipped. For example, if you want to identify 

 destination code - 

To add an item to the skip list:

1 Log on to the AccuRoute server, go to ...\AccuRoute\CostRecovery, and open 
LFCostRecoveryU.ini in Notepad.

2 Go to [TrxSkipList]. It is the last section in the file.

3 Add or modify the items as preferred.

4 Save and close the file.

This section includes:

Working with fields, delimiters, and masks (6-23)

Configuring the export format and creating the template file (6-25)

Adding fields and delimiters (6-26)

Adding a field with a mask (6-28)

Appending and overriding output data (6-30)

Configuring the removal of digits from fax numbers (6-30)

Including billing codes in AccuRoute CostRecovery output (6-31)

Customizing the billing code (6-34)

Working with fields, delimiters, and masks
Your billing system may require that information in the AccuRoute CostRecovery file it imports be in a 
specific format. This can include the order of the information in the file and the delimiter used to separate 
the information in the file. The type of information collected and the format of that information is defined by 
the AccuRoute CostRecovery template file. AccuRoute CostRecovery uses the template as a guide for 
creating the output file.

Information that is written to the AccuRoute CostRecovery output file is represented in the template file by 
field names. The list of fields in AccuRoute CostRecovery from which you can select uses the common text 
descriptions of the information the fields hold, not the actual field names (for example, you will see “Second 
billing field (Client)” instead of the field name, “<Billing2>”). When you add a field to the template file, the 
field at the bottom of the Export Format tab shows the actual field name, along with the selected delimiter 
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and a mask, if specified.

AccuRoute CostRecovery supports a number of delimiters to separate information in the template. The 
delimiter is also used to separate information in the output file. Supported delimiters include a comma (,), 
semi-colon (;), colon (:), pipe (|), dash (-), and a tab. Use the appropriate delimiters for your billing system. 
Consult your billing system documentation for more information about its requirements.

If the data represented by a field you add contains the delimiter you use to separate the fields from one 
another (for example, Robert Jones, Marketing Administrator), use the Surround Strings with Quotes 
option to enclose that field between quotation marks. This prevents the data in the output file from being 
misread. For example, if the data that replaces a field contains a comma and you use a comma to delimit 
the fields, the data before the comma will be read separately from the data after the comma. For example: 
Robert Jones, Marketing Administrator will be read as Robert Jones and Marketing Administrator unless the 
entire field is surrounded in quotes (“Robert Jones, Marketing Administrator”).

A mask is a way of specifying the pattern or format AccuRoute CostRecovery uses when adding information 
to the output file. A mask can also define the specific information that AccuRoute CostRecovery places in 
the output file, which is helpful if your billing system needs only a portion of information provided by Genifax, 
or AccuRoute (for example, the last four digits of a seven-digit billing code). Your billing system may expect 
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information to be in a specific format when it reads the output file from AccuRoute CostRecovery. For 
example, you may want to include the date and time at which a message was sent, and because your billing 
system expects this information in a specific format, you can apply a mask to this field so the information is 
correctly formatted. 

Masks are also used when your billing system requires information in fields of fixed length. To handle fixed 
length output, use a mask instead of a field delimiter. The mask should ensure that each field is the proper 
length. For example, if your billing system requires the cost of the message to be a five digit field with a 
decimal point (a total length of six characters), the mask you use would ensure that the output is always six 
characters—for example, the mask would format 1.50 as 001.50.

Configuring the export format and creating the template file
1 Start AccuRoute CostRecovery and click Configure in the Standard group in the column on 

the left and click the Export Format tab.

2 Add all required fields with the appropriate delimiters and masks if necessary. See Adding 
fields and delimiters (6-26) and Adding a field with a mask (6-28) on page 18.

3 Place the cursor after the last field in the display list box on the Export Format tab and press 
Delete several times to ensure that no blank lines remain at the end of the template file.

4 Click Apply to save your changes to the AccuRoute CostRecovery output file.

Tip By default, the output file is called cr.txt and is located in the \Program Files\AccuRoute\AccuRoute 
CostRecovery folder. You can specify the name and location of the output file if you want to have 
AccuRoute CostRecovery store the information in a different location, or if your billing system 
expects a different file name. See Configuring the names and locations of AccuRoute 
CostRecovery files (6-22).
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Adding fields and delimiters
1 Go to the Export Format tab of the AccuRoute CostRecovery window, and select the field you 

want to add from the list box.

2 Select Surround strings with quotes if the information represented by the selected field 
needs to be enclosed in quotation marks in the output file.

3 Click in the list box at the bottom of the Export Format tab to place the cursor where you want 
to insert the field.

4 Click Insert Field to add the field to the list box. The selected field appears in the display list 

box where the cursor was located.
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Tip If any of the fields you add require a mask, refer to the following section.

5 Go to the Delimiters list, and select the delimiter you want to separate the field you just added 
from the next field you add.

6 Click Insert Delimiter. The delimiter appears in the display list box after the last field you 
added (or where the cursor was located).



© 2019 by Omtool, Ltd. (Upland AccuRoute) All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

6-28AccuRoute® Clients Installation Guide

Section 6: Required Configuration

Adding a field with a mask
1 Go to the Export Format tab of the AccuRoute CostRecovery window, and select the field you 

want to add from the list box.

2 Select Surround strings with quotes if the information represented by the selected field 
needs to be enclosed in quotation marks in the output file.

3 Select Use mask with this field.

4 Click in the list box at the bottom of the Export Format tab to place the cursor where you want 
to insert the field.

5 Click Insert Field. The Enter Mask for Field dialog box appears.
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6 Go to the Mask Format field and enter the format for the information as you want it to appear 
in the output file. 

The Valid Mask Characters for this field are box shows the valid characters you can include 
in the mask for the selected field. The characters listed here vary depending on the field you 
selected. All of the possible characters are described in Appendix: Supported Mask 
Characters.

For example, for the selected field (Date), you might want the date the message was sent to 
be formatted “Mon Dec 30 1990.” To create a mask to format the date in this way, you would 
enter the following text in the Mask Format field: ddd mmm dd yyyy

You can include separators in the date, such as a comma (Mon, Dec 30, 1990). The format of 
the mask would appear as follows: ddd, mmm dd, yyyy

7 Click Apply to test the specified mask. 

AccuRoute CostRecovery applies the mask you specified to the sample data listed in the 
Sample Data field, and displays the result in the Result field.

8 Make changes to the specified mask if needed based on the results of the test.

9 Click OK to add the field with the mask. The selected field appears in the list box where the 
cursor is located; the field includes the mask.

10 Add a delimiter to follow the field you just added. See Adding fields and delimiters (6-23) for 
information about adding a delimiter. 
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Appending and overriding output data
By default, AccuRoute CostRecovery appends new report information to the output file each time it runs. 
You can disable this option if you want to have AccuRoute CostRecovery overwrite the output file each time 
it runs. AccuRoute recommends that you leave the default and configure your billing system to delete the 
output file after importing it. This is recommended especially if AccuRoute CostRecovery runs automatically 
each day. This ensures that no data is lost if for some reason the import of the information into your billing 
system fails. 

To configure AccuRoute CostRecovery to overwrite the contents of the output file each 
time it executes:

1 Start AccuRoute CostRecovery and click Configure in the Standard group in the column on 
the left.

2 Click the Options tab.

3 Clear Append to Existing Output File.

4 Click Apply to save your changes.

Configuring the removal of digits from fax numbers
Some phone systems require extra digits to be dialed prior to the phone number or fax number. These extra 
digits are stored in the Genifax message database with the fax numbers. In such cases, you might want to 
have these digits removed from the fax numbers prior to adding them to your billing system. AccuRoute 
CostRecovery can remove the extra digits from the fax numbers as it collects call information from Genifax.

Note This does not include the digit 9 that is commonly required to obtain an outside line. If your phone 
system requires only a 9, you do not need to configure the removal of extra digits from fax 
numbers.
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To configure AccuRoute CostRecovery to remove extra digits from fax numbers:

1 Start AccuRoute CostRecovery and click Configure in the Standard group in the column on 
the left.

2 Click the Options tab.

3 Go to the Digits to remove from beginning of phone number field and enter the extra digits 
that must be removed from the beginning of fax numbers.

4 Click Apply to save your changes.

Including billing codes in AccuRoute CostRecovery output
You can have AccuRoute CostRecovery include billing codes in the output files it generates. If you want 
billing codes included, you need to add the billing code fields to the AccuRoute CostRecovery template file. 
By default, AccuRoute CostRecovery includes the entire billing code in the output file, but you can provide 
information about how your billing codes are formatted and which portion of the code you want AccuRoute 
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CostRecovery to collect, if your billing system requires only a portion of the billing codes provided by the 
senders of messages. For example, if your billing codes are six digits in length, but you only need the last 
four digits for your billing system, you can configure AccuRoute CostRecovery to pull out the four digits you 
need.

AccuRoute CostRecovery provides the ability to configure the format for three billing code elements: user 
ID code, client code, and matter code. On the Billing tab in AccuRoute CostRecovery, these elements are 
represented by Billing Fields 1, 2, and 3. Typically, Billing Field 1 corresponds to the user ID code, Billing 
Field 2 corresponds to the client code, and Billing Field 3 corresponds to the matter. Your firm may have 
other names for these fields.

Configuring the billing code separator

1 Start AccuRoute CostRecovery and click Configure in the Standard group in the column on 
the left and click the Billing tab.

2 Go to the Billing Field Separator field under All Fields and enter the separator character that 
your billing codes contain, if one is used. 

Note The separator character applies to all billing code types (for example, user ID code, client code, 
and matter code).

3 Click Apply to save your changes.
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Including the entire billing code in AccuRoute CostRecovery output

To configure the inclusion of the entire billing code in AccuRoute CostRecovery output:

1 Start AccuRoute CostRecovery and click Configure in the Standard group in the column on 
the left and click the Billing tab.

2 Go to the section that corresponds to the billing code type that you want AccuRoute 
CostRecovery to include (Billing Field 1 (user), Billing Field 2 (client), or Billing Field 3 
(matter), and complete the following steps:

a Clear Enable Parsing of field.

b Select Strip Leading Zeros if you want any leading zeros stripped from the front of this 
type of billing code. For example, 003456 becomes 3456. Leading zeros are not stripped if 
the billing code contains alpha characters. 

c Click Apply to save your changes.
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Customizing the billing code
To configure the inclusion of a portion of a billing code in AccuRoute CostRecovery 
output files:

1 Start AccuRoute CostRecovery and click Configure in the Standard group in the column on 
the left and click the Billing tab.

2 Go to the section that corresponds to the billing code type you want AccuRoute CostRecovery 
to include (Billing Field 1 (user), Billing Field 2 (client), or Billing Field 3 (matter)), and 
complete the following steps:

a Select Enable Parsing of field.

b Select Strip Leading Zeros if you want any leading zeros stripped from the front of this 
type of billing code. For example, 003456 becomes 3456. Leading zeros are not stripped if 
the billing code contains alpha characters. 

c Go to the Start Position field and enter the position number of the digit with which you 
want AccuRoute CostRecovery to begin extracting from the billing code. Count position 
numbers from left to right.

For example, if your billing codes are all 6 digits (123456) and you want AccuRoute 
CostRecovery to extract digits 2 through 5, enter 2 as the start position.

Note If the billing codes of this type (user, client, or matter) are of varying lengths and AccuRoute 
CostRecovery encounters a billing code that contains fewer digits than specified in the Start 
Position and Digits to Collect fields, AccuRoute CostRecovery saves the billing code as it is in 
the output file.

d Go to the Digits to Collect field and enter the number of digits you want AccuRoute 
CostRecovery to extract from the billing code.

Following the example given in the previous step (c), you would enter 4 as the number of digits 
to collect because there are 4 digits between positions 2 and 5 (digits 2, 3, 4, and 5).

e Enter a name for the billing code in the Billing Code Known As field. For example, 
Billing Field 1 represents user ID information, so you might enter User ID in this field.

The information you provide in this field is for the benefit of those using AccuRoute 
CostRecovery, to help them know the purpose of the billing field.

3 Click Apply to save your changes.
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AccuRoute Server Monitor
This section includes:

Required configuration for AccuRoute Connectors for Filescan and Telco (6-35)

Required configuration for AccuRoute Connectors for Filescan 
and Telco 
AccuRoute Server Monitor can run tests on folders associated with AccuRoute Connectors for Filescan and 
Telco. In order to run tests on these folders, the folders must be configured in UNC format. (UNC uses the 
format \\computer\folder. Drive letter mappings, such as G:\folder\folder, are not supported.) If an 
AccuRoute Server has either of these connectors, complete required configuration in this section.

Note If you configure AccuRoute Server Monitor to run tests on a folder, verify that the Windows user 
account associated with the AccuRoute Server Monitor Service has sharing permissions on that 
folder and security permissions with read access.

This section includes:

Configuring the Filescan connector (6-35)

Configuring the Telco connector (6-36)

Configuring the Filescan connector

To configure Filescan connector folders with UNC paths:

1 Click Connectors in the console tree and double-click the Filescan connector in the details 
pane.
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2 Click the Folders tab.

3 Verify that each folder has been configured with a UNC path. (If you need to change a folder 
configuration, select the folder and click Properties. Type the UNC path to the folder in the 
Folder to scan field and click OK.) 

4 Click OK to save your changes to the connector.

Configuring the Telco connector

Use the following procedure to configure the Telco connector.
To configure the Telco connector folder with a UNC path:

1 Click Connectors in the console tree and double-click the Telco connector in the details 
pane.
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2 Click Advanced on the General tab.

3 Verify that the path to the Telco share directory is in UNC format. Change it if necessary, and 
then click OK. 

4 Click OK to save your changes to the connector. 
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AccuRoute FaxCenter
This section includes:

Registering AccuRoute FaxCenter users (6-38)

Registering AccuRoute FaxCenter users
In order to run FaxCenter, FaxCenter users must be Registered Users on the server. When you create a 
Registered User, you can enable the user as a FaxCenter user, assign the user permissions to use 
FaxCenter features, and configure other properties for this user.

Use the following procedure to create a user account in the Administrator under Registered Users. If you 
have already created a user account for the FaxCenter user, you will modify the user’s FaxCenter 
properties.

To create a new user or modify the FaxCenter properties of a registered user:

1 Start the Administrator.

2 Create a new user or modify the properties of an existing user:

 To create a new user: Right-click Registered Users in the console tree and select New > 
User. Type the name and e-mail address of the FaxCenter user in the Name and E-mail 
text boxes.

 To modify the properties of an existing user: Click Registered Users in the console 
tree and double-click a registered user in the details pane.

3 Click the FaxCenter tab.

4 If you want to enable this user to use FaxCenter, select the Enable this user as a FaxCenter 
user option, and then complete the following steps.

5 If you want to assign a FaxCenter password to this user, type the password in the Password 
and Confirm text boxes. If you do not want to assign a password to this user, leave the text 
boxes empty.

6 When a FaxCenter user selects a fax in FaxCenter, the fax becomes locked so other 
FaxCenter users cannot access the same fax. (This prevents multiple FaxCenter users from 
modifying or routing the same fax.) Type the number of minutes you want FaxCenter to wait 
before it unlocks the fax this user has selected in the Automatically unlock fax after __ 
minutes spin box.

7 You can create an e-mail address filter that limits the users whose e-mail addresses appear in 
the FaxCenter Routing dialog box.

Note The filter does not prevent the FaxCenter user from routing faxes to other recipients and 
destinations. 

If you want to create a filter, do one of the following:

 To create an e-mail address filter, use the following string:
email=[e-mail address of a user account]
For example: email=user@company.com

 To create a site filter, use the following string:



site=[name of the Exchange 5.5 site]
For example: site=Finance

 To create a name filter, use the following string:
name=[alias of a user account]
For example: name=jsmith

Note The values you use in filters are not case-sensitive.

Tip You can use an asterisk to indicate a wildcard. For example, if email=*@company.com, then 
FaxCenter displays the e-mail accounts in the domain you specified as potential routing 
destinations—in this case, “company” is the domain you specified.

8 In the Allow User to section, select the check box beside each option you want to enable for 
this user:

 Delete Faxes - Allow this user to delete faxes from the Processed Items list in 
FaxCenter.

 Move to processed - Allow this user to move faxes from the New Items list into the 
Processed Items list.

 Combine Faxes - Allow this user to combine multiple faxes and route them as one 
combined fax.

 View Entire Fax - Allow this user to view the entire fax. If this option is not enabled, the 
FaxCenter user can view only the first page of each fax.

 Enter originator information when routing - Allow this user to complete the Routing 
Transaction Description section1 of the Route Selected Item dialog box when routing a 
fax. This configuration setting has two additional options that you can enable:

 User may leave From empty - Select this if you want the FaxCenter user to be able 
to leave the From field under Routing Transaction Description empty, or clear this 
check box if you want to require the user to provide the From information.

 User may leave Company empty - Select this if you want the FaxCenter user to be 
able to leave the Company field under Routing Transaction Description empty, or 
clear this check box if you want to require the user to provide the Company 
information.

 Enable or Disable Afterhours Processing - Allow this user to set After Hours2 for all 
FaxCenter users associated with the server.

 Release Registration Pending (HIPAA) - Allow this user to release faxes from Recipient 
Registration Pending to secure destinations.

Important Since releasing a fax can have legal ramifications in some industries, you should 
make sure that the FaxCenter user understands the process of secure delivery.

1.   These fields allow the FaxCenter user to provide the fax recipient with information about the original fax sender. Depending on how 
you configure notification messages for faxes that have been routed from FaxCenter to e-mail recipients, these fields (From and 
Company) can appear in the notification message from the server. 

2.   You can create inbound or outbound routing rules that specify how the server should handle messages when it is after hours in your 
company. While this feature is versatile and can be configured in a variety of ways, it is most commonly used in conjunction with 
FaxCenter. If your company uses FaxCenter, people in your company rely on FaxCenter users to route inbound faxes in a timely 
manner. After Hours prevents someone in your company from missing an important fax when FaxCenter users are not in the office. 
When it is after hours in your company, you might want to consider routing inbound faxes to network printers so that people can 
retrieve them when they arrive. For more information about After Hours, refer to the Administrator help.



 View all Faxes in FaxCenter - Allow this user to view all faxes in FaxCenter, even those 
faxes that have not been routed directly to this user for processing. When this option is 
enabled, this user can view all faxes on the server that currently reside in the FaxCenter 
Routing state. Also, this user can see faxes in all queues, including New Items, 
Processed Items, Found Items, and Registration Pending. 

9 Select the Route faxes as check box if you want the server to send the routing recipient a 
notification message that includes a name and an e-mail address for this FaxCenter user. If 
you select the check box, provide the following information:

• Name - Type the name you want to appear in the From field on all faxes that this user 
routes from FaxCenter. For example, the name can be the name of the user or another 
name, such as "John Smith, fax router" or "John Smith".

10 E-mail - Type the e-mail address you want to appear in the From field on all faxes that this 
user forwards from FaxCenter. For example, the e-mail address can be associated with the 
FaxCenter user or another person who you want to receive all replies to the forwarded fax.

11 Click the Select Columns to View button if you want to configure the columns that this user 
will view in FaxCenter. Modify the column properties and save your changes.

12 Click OK to save your changes to the properties for this registered user, or click on another tab 
to modify more properties for this user.

Note When you modify a user's FaxCenter permissions while that user is currently logged into 
FaxCenter, the new permissions will not take effect until the next time the user logs in to 
FaxCenter.
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Section 7: Optional Configurations

This section describes the optional configurations available for some AccuRoute clients along with their 
interactions with each other and the AccuRoute Server.

This section includes:

AccuRoute Desktop (7-2)

AccuRoute Queue (7-49)

AccuRoute Server Monitor (7-51)

AccuRoute FaxCenter (7-55)

Note: The following clients have no optional server configurations:

 AccuRoute Web Apps

 Print to AccuRoute

 AccuRoute Acquisition

 AccuRoute Connect

 AccuRoute COM API

 AccuRoute Cost Recovery
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AccuRoute Desktop
This section includes:

About AccuRoute Desktop and server clusters (7-2)

Working with views (7-4)

Other AccuRoute Desktop optional configurations (7-44)

About AccuRoute Desktop and server clusters
For an environment of the AccuRoute Desktop with an AccuRoute server cluster, additional configurations 
are necessary before you install AccuRoute Desktop. Resources that are utilized by the AccuRoute server 
and AccuRoute Desktop clients need to be relocated to a high availability server. This ensures that the 
active server in the cluster and all clients have uninterrupted access to them.

These resources include:

 View files

 Routing Sheet templates and cover page templates

Copy these resources to a high availability server, and then edit the registry on the AccuRoute server and 
the configuration file in the AccuRoute Desktop setup so that the AccuRoute server and AccuRoute Desktop 
clients can begin using the resources on the high availability server immediately. 

This section includes:

Copying server and client resources to a high availability server (7-2)

Editing the registry on the AccuRoute Server (7-3)

Editing the AccuRoute Desktop configuration file (7-3)

Copying server and client resources to a high availability server

Before completing this procedure, choose a high availability server. AccuRoute recommends using the 
same high availability server where the AccuRoute server message database is located. If a different server 
is used, then it must be located in the same domain as the AccuRoute server or in a different domain that 
has a bidirectional trust with the AccuRoute server’s domain. Access to the folders containing these 
resources is granted through the sharing and security rights on the folder itself.

To copy server and client resources to the high availability server:

1 Go to …\UplandAccuRoute\AccuRoute\ directory on the AccuRoute server.

2 Copy and paste \AccuRouteViews to the high availability server and wait for the files to be 
copied.

3 Go to \AccuRouteViews on the high availability server and verify that its sharing and security 
permissions allow clients running AccuRoute Desktop to access it:

a Right-click AccuRouteViews and select Properties.
b Click the Sharing tab.
c Verify that the folder is shared as AccuRouteViews.
d Click Permissions and verify that Everyone has Read access to the folder.
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4 Go to …\UplandAccuRoute\AccuRoute Server\ on the AccuRoute server.

5 Copy and paste \Languages to the high availability server and wait for the files to be copied.

6 Go to \Languages on the high availability server and set the sharing and security permissions:

a Right-click Languages and select Properties.
b Click the Sharing tab.
c Select Share this folder. and verify that the share name is Languages.
d Click Permissions and verify that Everyone has Read access to the folder.

e Click OK to close the Permissions dialog box, and click OK to save the changes to the 
folder properties.

Editing the registry on the AccuRoute Server

The location of \LANGUAGES is stored in the registry on the AccuRoute server. Instead of moving the 
location of the Languages folder, you can when needed, move the logical \TEMPLATES. It is in the same 
location as \LANGUAGES.

The logical \TEMPLATES can point to any UNC path (or other path) as long as it maintains the same sub-
folder structure as the original, thereby allowing a single copy of the templates to be maintained for the 
clustered server. 

The default value for the \TEMPLATES logical is the same as the LANGUAGES folder, located in: 
\HKEY_LOCAL_MACHINE\SOFTWARE\AccuRoute\Genifax\Current Version\Logicals. 

All folders except the "Resources" folders in the default install LANGUAGES folder can be moved as 
templates. 

Note Resources must remain on each individual machine. 

Editing the AccuRoute Desktop configuration file

AccuRoute Desktop is installed on clients with a configuration file that defines the locations of resources to 
which the client needs access. This configuration file must be modified to include the new location of view 
files. Optionally, it can be edited to include the location of the folder containing Routing Sheet templates.

Note This procedure updates the AccuRoute Desktop setup. This ensures that no configuration is 
required on the client after installation.

1 To update the AccuRoute Desktop setup with the new location of the folder containing view 
files:

2 Go to \UplandAccuRoute\AccuRoute\Clients\AccuRouteDesktop\program 
files\AccuRoute\AccuRouteDesktop on the AccuRoute server.

3 Open AccuRouteclient.xml in Notepad.

4 Go to the Aliases section. (Search on SearchFolders if necessary.)

5 Locate the following alias:

<Alias>
<prValue>$/</prValue>
</Alias>

6 Replace $/ with \\[server]\AccuRouteViews where [server] is the computer name or IP address 
of the high availability server.
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Note The AccuRouteViews folder is shared, and its share name is AccuRouteViews, so the path to this 
resource is always \\[server]\AccuRouteViews.

7 Save the file and close it.

Note AccuRoute strongly recommends repeating this procedure on the alternate AccuRoute Server.

Working with views
Most features in a view can be modified or removed. Examples include buttons, checkboxes, and labels. 

All controls that can be modified or removed are listed in this section. The information is organized based 
on the view where the control is available:

 Configuring view controls (7-4)

 Modifying view files (7-13)

Configuring view controls

Controls for the Default view and the Print To view are presented in the following sections:

 General controls for the Default view and Print To view (7-5)

 Additional controls for the Print To view only (7-7)

 Controls for menus: File menu (7-7)

 Controls for menus: Edit menu (7-8)

 Controls for menus: View menu (7-8)

 Controls for menus: Tools menu (7-8)

 Controls for menus: Help menu (7-9)

 Controls for toolbar buttons (7-9)

 Controls for the Message Options dialog box: General tab (7-10)

 Controls for the Message Options dialog box: Fax tab (7-11)

 Controls for the Message Options dialog box: Email tab (7-12)
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General controls for the Default view and Print To view

Table 7-1: General controls for the Default view and Print To view

Friendly description Control ID Type Function

toggle switch for menu bar and 
button toolbar

btMenuToggle toggle switch Shows or hides the menu and button toolbars in 
the view.

Recipients section label lbGroupRecipients label Identifies the Recipients section.

Recipients section separator spGroupRecipients separator Defines the Recipients section.

Type list menu label lbRecientTypes label Identifies the Type control.

Type list menu lcRoutingDestinations list menu Displays the routing destination types that are 
available to the user, and allows the user to 
select one.

Format list menu label lbDocumentTypes label Identifies the Format control.

Format list menu lcDocumentTypes list menu Allows the user to select the file format of the 
message.

destination field label lbRecipientTo label Identifies the address field and list menu.

Changing the content of this label is not 
supported. You can only modify whether the 
control is visible and enabled.

destination field and list menu cxRecipientAddress input field/checkbox Allows the user to select or enter recipients and 
destinations for the message. Also enables the 
user to select a recipient or destination from the 
MRU list that contains the 10 most recently 
used items.

destination field browse button 
(displays as an address book 
icon)

btAddressBook button Opens a dialog box that allows the user to select 
recipients from the address book that is native 
to the email application installed on the client.

destination field new recipient 
button (displays as card file 
entry)

btNewAddress button Opens a dialog box that allows the user to add a 
recipient or destination manually and define 
properties associated with the recipient or 
destination.

Add button btAddRecipient button Adds the recipient to the list.

Email copy to self checkbox cbEmailCopyToMyself checkbox Allows the user to request a copy of the 
message that is delivered to the specified 
recipients and destinations.

When this control is modified, both the control 
and the label are modified together.

Changing the content of this label is not 
supported. You can only modify whether the 
control is visible and enabled.

destination properties button btRecipientProperties button Opens the properties of the recipient or 
destination so that the user can view and modify 
them.

destination delete button btRemoveRecipient button Deletes the selected recipient or destination 
from the list in the Recipients section.
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destination list lcRecipients list box Displays the list of recipients and destinations 
for the message.

Billing checkbox cbBillingCheck checkbox Represents billing controls. Use these control 
IDs only to change the size or position of billing 
controls in the user interface. Use the billing 
configuration in the AccuRoute Connector for 
DMS to configure the behavior of these 
controls.

Look up billing codes button 
(displays as an address book 
icon)

btBillingLookup button

billing 1 field edBilling1 input field

billing 2 field edBilling2 input field

billing 3 field edBilling3 input field

billing 1 field label lbBilling1 label Identifies the Billing 1 field.

billing 2 field label lbBilling2 label Identifies the Billing 2 field.

billing 3 field label lbBilling3 label Identifies the Billing 3 field.

Content section label lbGroupMessage label Identifies Content section.

Content section separator spGroupMessage separator Defines the Content section.

Subject field label lbSubject label Identifies the Subject control.

Subject field edSubject input field Allows the user to enter a subject for the 
message.

Comments field label lbComments label Identifies the Comments control.

Comments field edComments input field Allows the user to enter comments for 
recipients.

Attachments list label lblAttachments label Identifies the Attachments section.

Attachments list lcAttachments list box Displays the attachments associated with the 
message.

Add new attachment button 
(displays as paper clip icon)

btAddAttachment button Opens a dialog box that enables the user to 
select an attachment and add it to the message.

Remove selected attachment 
button (displays as a delete icon)

btRemoveAttachment button Deletes the selected attachment from the 
Attachments list.

Print To view separator spPrintTo separator Separates the features above from the buttons 
below.

Print To view Options button btPrintOptions button Allows the user to select options for the 
message. This button is visible in the default 
Print To view.

Print To view OK button btPrintOK button Sends the message and closes the AccuRoute 
Desktop window.

Print To view Cancel button btPrintCancel button Closes the AccuRoute Desktop window.

Print To view Help button btPrintHelp button Launches user documentation on AccuRoute 
Desktop.

Table 7-1: General controls for the Default view and Print To view

Friendly description Control ID Type Function
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Additional controls for the Print To view only

Controls for menus: File menu

Table 7-2: Additional controls for the Print To view only

Friendly description Control ID Type Function

Print To view separator spPrintTo separator Separates the features above 
from the buttons below.

Print To view Options button btPrintOptions button Allows the user to select options 
for the message. This button is 
visible in the default Print To 
view.

Print To view OK button btPrintOK button Sends the message and closes 
the AccuRoute Desktop 
window.

Print To view Cancel button btPrintCancel button Closes the AccuRoute Desktop 
window.

Print To view Help button btPrintHelp button Launches user documentation on 
AccuRoute Desktop.

Table 7-3: Controls for the File menu

Friendly description Control ID Type Function

File menu mnFile toolbar menu option Opens the File menu.

File > New mnNewED menu option Opens a new message based on 
the default settings.

File > Open ED mnOpenED menu option Opens a dialog box that enables 
the user to select and open an 
Embedded Directive.

File > Save ED mnSaveED menu option Opens a dialog box that enables 
the user to save the Embedded 
Directive, or updates an existing 
Embedded Directive.

File > Save As New ED mnSaveAsED menu option Opens a dialog box that enables 
the user to save the Embedded 
Directive.

File > Send mnSend menu option Sends the message and displays 
a dialog box to confirm the send 
operation.

File > View RS mnViewRS menu option Generates a Routing Sheet using 
the existing message settings 
and displays the Routing Sheet 
as a PDF file on the desktop.

File > Print RS mnPrintRS menu option Generates a Routing Sheet using 
the existing message settings, 
displays the Routing Sheet as a 
PDF file on the desktop, and 
executes the Print command.
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Controls for menus: Edit menu

Controls for menus: View menu

Controls for menus: Tools menu

File > Templates mnTemplates menu option Opens the Templates submenu.

File > Templates > Open mnOpenTemplate menu option Opens a dialog box that enables 
the user to open a template file.

File > Templates > Save mnSaveTemplate menu option Opens a dialog box that enables 
the user to save a template file, 
or updates the existing template 
file.

File > Templates > Save As New mnSaveAsTemplate menu option Opens a dialog box that enables 
the user to save a template file.

File > Exit mnExit menu option Prompts the user to save the 
changes, if applicable, and 
closes the AccuRoute Desktop 
window.

Table 7-4: Controls for the Edit menu

Friendly description Control ID Type Function

Edit menu mnEdit toolbar menu option Opens the Edit menu.

Edit > Undo mnUndo menu option Cancels the last command.

Edit > Cut mnCut menu option Cuts the selected text and copies 
it to the clipboard.

Edit > Copy mnCopy menu option Copies the selected text to the 
clipboard.

Edit > Paste mnPaste menu option Inserts text from the clipboard.

Table 7-5: Controls for the View menu

Friendly description Control ID Type Function

View menu mnView toolbar menu option Opens the View menu.

Table 7-6: Controls for the Tools menu

Friendly description Control ID Type Function

Tools menu mnTools toolbar menu option Opens the Tools menu.

Tools > View Configuration mnViewServerCapabilities menu option Opens a window that displays all 
the configuration data that 
impacts AccuRoute Desktop.

Table 7-3: Controls for the File menu

Friendly description Control ID Type Function
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Controls for menus: Help menu

Controls for toolbar buttons

Tools > Configuration Folders mnSearchFolders menu option Opens a window that displays 
the folders containing view files 
and Routing Sheet template 
files.

Tools > Configure DMS mnConfigureDMS menu option Opens a submenu containing the 
DMS applications detected on 
the client.

Tools > Preferences mnDefaults menu option Opens a window that enables the 
user to configure options for 
AccuRoute Desktop.

Tools > Message Options mnOptions menu option Opens a window that enables the 
user to configure options for the 
message.

Table 7-7: Controls for the Help menu

Friendly description Control ID Type Function

Help menu mnHelp toolbar menu option Opens the Help menu.

Help > About AccuRoute 
Desktop

mnHelpContents menu option Opens a dialog box that displays 
information on AccuRoute 
Desktop.

Help > AccuRoute Desktop 
Help

mnHelpAbout menu option Launches user documentation on 
AccuRoute Desktop.

Table 7-8: Controls for toolbar buttons

Friendly description Control ID Type Function

New button tbNewED button Opens a new message based on 
the default settings.

Open ED button tbOpenED button Opens a dialog box that enables 
the user to select and open an 
Embedded Directive.

Save ED button tbSaveED button Opens a dialog box that enables 
the user to save the Embedded 
Directive, or updates an existing 
Embedded Directive.

View RS button tbViewRS button Generates a Routing Sheet using 
the existing message settings 
and displays the Routing Sheet 
as a PDF file on the desktop.

Table 7-6: Controls for the Tools menu

Friendly description Control ID Type Function
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Controls for the Message Options dialog box: General tab

Print RS button tbPrintRS button Generates a Routing Sheet using 
the existing message settings, 
displays the Routing Sheet as a 
PDF file on the desktop, and 
executes the Print command.

Send button tbSend button Sends the message and displays 
a dialog box to confirm the send 
operation.

Options button tbOptions button Opens a window that enables the 
user to configure options for the 
message.

New button separator tbspNew separator Appears to the right of the New 
button on the main toolbar.

Open ED and Save ED button 
separator

tbspOpen separator Appears to the right of the Open 
ED and Save ED buttons on the 
main toolbar.

View RS and Print RS button 
separator

tbspRoutingSheet separator Appears to the right of the View 
RS and Print RS buttons on the 
main toolbar.

Send button separator tbspSend separator Appears to the right of the Send 
button on the main toolbar.

Options button separator tbspOptions separator Appears to the right of the 
Options button on the main 
toolbar.

Table 7-9: Controls on the General tab (Message Options dialog box)

Friendly description Control ID Type Function

Embedded Directive section lbGroupRoutingSheet label Identifies the Embedded Directive section.

Embedded Directive section spGroupRoutingSheet separator Defines the Embedded Directive section.

Routing Sheet Style list menu lbStyles label Identifies the Routing Sheet Style list 
menu.

Routing Sheet Style list menu cxRoutingSheets list menu Enables the user to select the Routing Sheet 
style.

Retain Routing Sheet in 
delivered document checkbox

cbRetainRoutingSheet checkbox Allows the user to request that the Routing 
Sheet be included as part of the message.

Single use checkbox cbSingleUse checkbox Allows the user to enable the single use 
property for the Embedded Directive.

Expires after checkbox cbExpiresAfter checkbox Allows the user to enable expiration for the 
Embedded Directive.

Expires after date control dtExpires date control Enables the user to select the expiration 
date for the Embedded Directive.

Table 7-8: Controls for toolbar buttons

Friendly description Control ID Type Function
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Controls for the Message Options dialog box: Fax tab

Confirmation section label lblGroupConfirmation label Identifies the Confirmation section.

Confirmation section separator spGroupConfirmation separator Identifies the Confirmation section.

None radio button rbNotificationNone button Enables the user to select None as the 
confirmation option for the message,

Failure only radio button rbNotificationFailure button Enables the user to select Failure only as 
the confirmation option for the message,

Success or Failure radio button rbNotificationSuccessFailure button Enables the user to select Success or 
Failure as the confirmation option for the 
message,

Printer checkbox cbConfirmToPrinter checkbox Enables printer confirmation for the 
message. Makes the Printer field available 
when enabled.

Printer field edPrinterNotification input field Allows the user to enter a printer 
destination.

Printer field browse button btPrinterBrowse button Allows the user to browse the network and 
select a printer for confirmation.

Email checkbox cbConfirmToEmail checkbox Enables email confirmation for the 
message. Makes the Email field available 
when enabled.

Email field edEmailNotification input field Allows the user to enter an e-mail 
destination.

Email browse button btEmailBrowse button Allows the user to browse the address book 
and select a user for email confirmation.

Table 7-10: Controls on the Fax tab (Message Options dialog box)

Friendly description Control ID Type Function

Cover sheet section label lbGroupCoversheet label Identifies the Cover sheet section.

Cover sheet section separator spGroupCoversheet separator Defines the Cover sheet section.

Use cover sheet checkbox cbUseCoverpage checkbox Allows the user to request a cover sheet 
for fax recipients.

Style field lblCoverpage label Identifies the Style field.

Style field and list menu cxCoverpages input field/list menu Allows the user to enter the name of a 
cover sheet style or to choose a style from 
the list menu.

Delivery section label lbGroupDelivery label Identifies the Delivery section.

Delivery section separator spGroupDelivery separator Defines the Delivery section.

Use access code checkbox cbUseAccessCode checkbox Makes the Use access code field available 
when enabled.

Table 7-9: Controls on the General tab (Message Options dialog box)

Friendly description Control ID Type Function
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Controls for the Message Options dialog box: Email tab

Controls for Send To view

Use access code field cxAccessCodes input field/list menu Allows the user to enter an access code or 
to choose an access code from the list 
menu.

Hold for preview before sending 
checkbox

cbHoldForPreview  checkbox Allows the user to request a preview of the 
message.

Requires management approval 
checkbox

cbManagerApproval checkbox Allows the user to request management 
approval for the message.

Deliver only to secure fax 
destinations checkbox

cbSecureDelivery checkbox Allows the user to request secure delivery 
for the message.

Do not deliver before checkbox cbHoldDelivery checkbox Allows the user to request delayed 
delivery of the message.

Do not deliver before date 
control

dtHoldDate date control Allows the user to choose the date for 
delivery.

Do not deliver before time 
control

dtHoldTime time control Allows the user to choose the time for 
delivery.

Delivery Priority list menu label lbDeliveryPriority label Identifies the Delivery Priority option.

Delivery Priority list menu cxDeliveryPriority list menu Allows the user to select a priority level 
from the list menu.

Table 7-11: Controls on the Email tab (Message Options dialog box)

Friendly description Control ID Type Function

Attachment file name field label lbAttachmentName label Identifies the Attachment file 
name field.

Attachment file name field edAttachmentName input field Allows the user to enter the file 
name of the message for email 
recipients.

Table 7-12: Controls for the Send To view

Friendly description Control ID Type Function

User prompt label lblAction label Prompts the user to select a radio 
button. If you remove this label, 
the filenames still appear in the 
view.

Launch AccuRoute Desktop and 
attach file(s) to a new Embedded 
Directive radio button

rcCreateNewED button Allows the user to send the file 
as an attachment to a new 
Embedded Directive.

Table 7-10: Controls on the Fax tab (Message Options dialog box)

Friendly description Control ID Type Function
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Modifying view files

Modify view files using the guidelines in the following tables:

 View section (7-14)

 General section (7-15)

 Defaults section (7-17)

 UI section (7-22)

 Transformations section (7-28)

 FaxCoverpages section (7-29)

 FaxAccessCodes section (7-31)

 ConfirmationList section (7-33)

 Recipients section (7-35)

 Attachments section (7-38)

 RoutingSheets section (7-41)

Deliver file(s) to recipients 
specified in the selected 
Embedded Directive radio 
button

rcSendUsingExisting button Allows the user to send the file 
as an attachment to an existing 
Embedded Directive. Makes the 
Embedded Directive list menu 
available.

Embedded Directive list menu cEmbeddedDirectives checkbox Allows the user to select an 
existing Embedded Directive.

OK button btOk button Executes the requested action.

Cancel button btCancel button Closes the window.

Table 7-12: Controls for the Send To view

Friendly description Control ID Type Function
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View section

Table 7-13: Guidelines for modifying the View section

Element Parent Description, attributes, and usage guidelines

View — Description: Root element.

Attribute: inherits 

Optional attribute that determines whether the view inherits configuration data from another 
view source. 

Values: 

• false (default) to disable inheritance
• UNC path to a view file
• view alias (Aliases are defined in AccuRouteClient.XML.) 
Example of usage:

The following code sample demonstrates inheritance using a UNC path to the view file:

<View inherits="\\<server>\AccuRouteServer\AccuRouteViews\
 Organization.view" version="04.00.00">
…
</View>

Attribute: overridable 

Optional attribute that enables or prevents overrides at all levels.

Values: 

true (default) to allow overrides | false to prevent overrides

Example of usage:

<View overridable="false" version="04.00.00">
…
</View>
If overridable=false, then a derived view cannot override any configuration data inherited from 
this view. 

Attribute: version 

Required attribute that determines the version of the XML schema used in the view file. This 
value is used internally by the AccuRoute Server. Do not modify the default value 04.00.00. 

Example of usage:

<View version="04.00.00">
…
</View>
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General section

Table 7-14: Guidelines for modifying the General section

General View Description: Section containing general view properties.

Attribute: overridable 

Optional attribute that enables or prevents overrides within this section. 

Values:

true (default) to allow overrides | false to prevent overrides

Example of usage:

<View overridable="true" version="04.00.00">
     <General overridable="true">
     …
     </General>
     …
</View>

Note: For an override to be valid, the View section must allow overrides.

The General element supports the following properties:

• prFormDll - DLL file (required) that AccuRoute Desktop loads. Do not modify the 
default value omARClient4FrmExU.DLL. The complete element must be:

<General overridable="true">
     <prFormDll>omARClient4FrmExU.DLL</prFormDll>
     …
</General>
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General 
continued

• prFormDll - DLL file (required) that AccuRoute Desktop loads. Do not modify the default 
value omARClient4FrmExU.DLL. The complete element must be:

<General overridable="true">
     <prFormDll>omARClient4FrmExU.DLL</prFormDll>
     …
</General>

• prName - Name (required) that the AccuRoute Server uses to identify the view type. Use one 
of the following values:

AccuRouteClient for standard and Print To views

DirectSend for the Send To view

The following code sample shows a standard view that uses the required value 
AccuRouteClient:

<General overridable="true">
     …
     <prName>AccuRouteClient</prName>
     …
</General>

• prShowDocInTitle - Boolean value that determines whether the title of the message, 
Embedded Directive, or template appears in the window title for AccuRoute Desktop. Use one 
of the following values:

0 to omit the title

1 (default) to include the title

For example:

<General overridable="true">…
     …
     <prShowDocInTitle>0</prShowDocInTitle>…
     …
</General>

• prShowScanLocation - Boolean value that determines whether the prompt Submitted 
document(s) here appears in the attachments list. Use one of the following values:

0 to hide the prompt

1 (default) to show the prompt

For example:

<General overridable="true">
     …
     <prShowScanLocation>0</prShowScanLocation>
     …
</General>

Table 7-14: Guidelines for modifying the General section
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Defaults section

Table 7-15: Guidelines for modifying the Defaults section

Element Parent Description, attributes, and usage guidelines

Defaults View Section containing default view properties.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example: 

<View overridable="true" version="04.00.00">
     …
     <Defaults overridable="true">
     …
     </Defaults>
     …
</View>

For an override to be valid, the View section must allow overrides. 

EmbeddedDirective Defaults Section containing defaults for Embedded Directives.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example: 

<Defaults overridable="true">
     <EmbeddedDirective overridable="true">
     …
     </EmbeddedDirective>
     …
</Defaults>

For an override to be valid, the View section and Defaults section must allow overrides.
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The EmbeddedDirective section supports the following properties:

• prUseOnlyOnce - Use one of the following values:

0 (default) for multiple use

1 for single use

For example:

<EmbeddedDirective overridable="true">
     …
     <prUseOnlyOnce>1</prUseOnlyOnce>
     …
</EmbeddedDirective>

• prRemoveEmbeddedDirective - Use one of the following values:

0 (default) to retain the Routing Sheet in the message

1 to remove the Routing Sheet from the message prior to delivery

For example: 

<EmbeddedDirective overridable="true">
     …
     <prRemoveEmbeddedDirective>0
     </prRemoveEmbeddedDirective>
     …
</EmbeddedDirective>

• prExpiresInterval - Number of days that an Embedded Directive remains valid for use. For 
example: 

<EmbeddedDirective overridable="true">
     …
     <prExpiresInterval>365</prExpiresInterval>
     …
</EmbeddedDirective>

• prAccuRouteCCMySelf - Use one of the following values:

0 (default) to omit the sender as a CC recipient

1 to include the sender as a CC recipient

For example: 

<EmbeddedDirective overridable="true">
     …
     <prAccuRouteCCMySelf>1</prAccuRouteCCMySelf>
     …
</EmbeddedDirective>

Table 7-15: Guidelines for modifying the Defaults section

Element Parent Description, attributes, and usage guidelines



© 2019 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

7-19AccuRoute® Desktop Client Installation Guide

Section 7: Optional Configurations

Recipient Defaults Section containing defaults for various recipient types, including fax, email, and printer.

The required attribute type determines the recipient type for the section. (To define defaults for 
multiple recipient types, include a Recipient section for each recipient type.) Use one of the 
following values:

• fax to define defaults for fax recipient
• email to define defaults for email recipients
• printer to define defaults for printer destinations
For example: 

<Defaults overridable="true">
     …
     <Recipient type="fax">
     …
     </Recipient>
     …
</Defaults>

Setting defaults for the DMS type is not supported at this time.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example: 

<Recipient type="fax" overridable="true">
…
</Recipient>

For an override to be valid, the View section and Defaults section must allow overrides.

Table 7-15: Guidelines for modifying the Defaults section

Element Parent Description, attributes, and usage guidelines
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The type email supports the following properties:

• prDeliveredDocumentName - Filename of the message attachment. (If a message is 
delivered to an email recipient, the message is delivered as a file attachment to an email 
message.) Do not include a file extension. For example: 

<Recipient type="email" overridable="true">
     …
     <prDeliveredDocumentName>Message
     </prDeliveredDocumentName>
     …
</Recipient>

The type fax supports the following properties:

• prApprovalRequested - Use one of the following values:

0 to disable approval by default

1 to enable approval by default

If true, then the AccuRoute Desktop option Requires management approval is enabled 
by default for messages with fax recipients. For example: 

<Recipient type="fax" overridable="true">|
     …
     <prApprovalRequested>1</prApprovalRequested>
     …
</Recipient>

• prRegistrationRequested - Use one of the following values:

0 to disable secure delivery by default

1 to enable secure delivery by default

If true, then the AccuRoute Desktop option Deliver only to secure fax destinations is 
enabled by default for messages with fax recipients. For example: 

<Recipient type="fax" overridable="true">
     …
     <prRegistrationRequested>1</prRegistrationRequested>
     …
</Recipient>

• prPreviewRequired - Use one of the following values:

0 to disable preview by default

1 to enable preview by default

If true, the AccuRoute Desktop option Hold for preview before sending is enabled by 
default for messages with fax recipients. For example: 

<Recipient type="fax" overridable="true">
     …
     <prPreviewRequired>1</prPreviewRequired>
     …
</Recipient>

Table 7-15: Guidelines for modifying the Defaults section

Element Parent Description, attributes, and usage guidelines
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Recipient continued • prPriority - Message priority. Use one of the following values:

0 for high priority

5 for normal priority (default)

10 for low priority.

If this property is included, the AccuRoute Desktop option Delivery Priority displays the 
default value set by the property. For example: 

<Recipient type="fax" overridable="true">
     …
     <prPriority>10</prPriority>
     …
</Recipient>

• prDateSendAfter - Send after date for messages with a fax recipient. Use date format, such as 
MM/DD/YYYY. For example: 

<Recipient type="fax" overridable="true">
     …
     <prDateSendAfter>06/30/2006</prDateSendAfter>
     …
</Recipient>

The type printer supports the following properties:

• prPrintNumberOfCopies - Number of copies for messages with a printer destination. 
Default is 1. For example: 

<Recipient type="printer" overridable="true">
     …
     <prPrintNumberOfCopies>3</prPrintNumberOfCopies>
     …
</Recipient>

Table 7-15: Guidelines for modifying the Defaults section

Element Parent Description, attributes, and usage guidelines
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UI section

Table 7-16: Guidelines for modifying the UI section

Element Parent Description, attributes, and usage guidelines

UI View Section containing view properties pertaining to the user interface, such as the configuration of 
controls, menus, and toolbars

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example: 

<View overridable="true" version="04.00.00">
     …
     <UI overridable="true">
     …
     </UI>
     …
</View>

For an override to be valid, the View section must allow overrides.

Form

Menu

Toolbar

Options

UI The UI element supports the following sections:

• <View><UI><Form> - Pertains to controls in the user interface.
• <View><UI><Menu> - Pertains to a menu item in the user interface.
• <View><UI><Toolbar> - Pertains to the toolbar in the user interface.
• <View><UI><Options> - Pertains to the Message Options dialog box.

Form

Menu

Toolbar

Options

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
The following code sample enables overrides to the form: 

<Form overridable="true">
…
</Form>

For an override to be valid, the View section and UI section must allow overrides.

Menu

Toolbar

The optional attribute visible determines whether the control is visible. Use one of the following 
values:

• true (default) to display the control
• false to hide the control.
The following code sample hides the toolbar: 

<Toolbar visible="false" overridable="false">
…
</Toolbar>
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Menu

Toolbar

The controls for menu items and toolbars support the following properties:

• prControlID - String value that identifies the control. 

The following code sample identifies the control mnTemplates:

<Menu overridable="false">
     <prControlID>mnTemplates</prControlID>
     …
</Menu>
Control IDs are listed in Controls for menus: File menu (7-7) and Controls for toolbar 
buttons (7-9).

• prVisible - Boolean value determines whether the control is visible. Use one of the 
following values:

0 to hide the control

1 (default) to show the control

The following code sample hides the control tbViewRS:

<Toolbar overridable="false">
     <prControlID>tbViewRS</prControlID>
     <prVisible>0</prVisible>
</Toolbar>

• prEnabled - Boolean value determines whether the control is available. (If unavailable, the 
control is grayed out.) Use one of the following values:

0 to disable the control

1 (default) to enable the control

The following code sample disables the control mnTemplates:

<Menu overridable="false">
     <prControlID>mnTemplates</prControlID>
     <prEnabled>0</prEnabled>
</Menu>

• prLabel - Name that accompanies the control. 

The following code sample identifies the label for the control tbViewRS:
<Toolbar overridable="false">
     <prControlID>tbViewRS</prControlID>
     <prLabel>View RS</prLabel>
</Toolbar>

Table 7-16: Guidelines for modifying the UI section

Element Parent Description, attributes, and usage guidelines
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Control

General

Fax

Email

Form

Options

The Form and Options elements support the following sections:

• <View><UI><Form><Control> - Pertains to a control in the user interface.
• <View><UI><Options><General> - Pertains to controls on the General tab in the Message 

Options dialog box.
• <View><UI><Options><Fax> - Pertains to controls on the Fax tab in the Message Options 

dialog box.
• <View><UI><Options><Email> - Pertains to controls on the Email tab in the Message 

Options dialog box.

Control

General

Fax

Email

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
The following code sample enables overrides to the control btMenuToggle:

<Control overridable="true">
     <prControlID>btMenuToggle</prControlID>
     <prVisible>0</prVisible>
</Control>

For an override to be valid, the View section and UI section, as well as the respective parent 
element of this attribute (Form section or Options section), must allow overrides.

General

Fax

Email

The optional attribute visible determines whether the control is visible. Use one of the following 
values:

• true (default) to display the control
• false to hide the control
The following code sample hides the Fax tab in the Message Options dialog box: 

<Fax visible="false" overridable="false">
</Fax>

Table 7-16: Guidelines for modifying the UI section

Element Parent Description, attributes, and usage guidelines
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Control

General

Fax

Email

The controls for forms and the Message Options dialog box support the following properties:

• prControlID - String value that identifies the control. 

The following code sample identifies the control cxDeliveryPriority:
<Fax overridable="true">
     <prControlID>cxDeliveryPriority</prControlID>
     <prVisible>0</prVisible>
</Fax>
The control IDs for this section are listed in General controls for the Default view and 
Print To view (7-5), Additional controls for the Print To view only (7-7), and Controls 
for the Message Options dialog box: General tab (7-10).

• prVisible - Boolean value determines whether the control is visible. Use one of the 
following values:

0 to hide the control

1 (default) to show the control

The following code sample hides the control btMenuToggle on the form:

<Control overridable="true">
     <prControlID>btMenuToggle</prControlID>
     <prVisible>0</prVisible>
</Control>

• prEnabled - Boolean value determines whether the control is available. (If unavailable, the 
control is grayed out.) Use one of the following values:

0 to disable the control

1 (default) to enable the control

The following code sample disables the control cxDeliveryPriority:

<Fax overridable="true">
     <prControlID>cxDeliveryPriority</prControlID>
     <prEnabled>0</prEnabled>
</Fax>

• prTooltip - Tool tip that becomes visible when the pointer hovers over the control.

The following code sample specifies the tool tip for the control btMenuToggle:

<Control overridable="true">
     <prControlID>btMenuToggle</prControlID>
     <prVisible>1</prVisible>
     <prTooltip>Show or hide menu and toolbar</prTooltip>
</Control>

• prLabel - Name that accompanies the control.

For example:

<Control overridable="true">
     <prControlID>lbDocumentTypes</prControlID>
     <prLabel>Recipients</prLabel>
</Control>

Table 7-16: Guidelines for modifying the UI section

Element Parent Description, attributes, and usage guidelines
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The controls for forms and the Message Options dialog box support the following dimension 
properties:

• prTop - Top position of the control. Specify a relative or absolute workspace coordinate. For 
absolute workspace coordinates, the value 0 indicates the top of the form. 

The following code sample demonstrates a change in the vertical position of the control 
cbEmailCopyToMyself:

<Control overridable="true">
     <prControlID>cbEmailCopyToMyself</prControlID>
     <prTop>+20</prTop>
     <prBottom>+20</prBottom>
</Control>

Notice a couple key points in this sample. First, since the 0 coordinate represents the top 
of the form, a positive value is required to move the control toward the bottom of the 
form. Second, notice that the top and bottom positions are modified together. If only the 
top position is moved toward the bottom of the form, the overall height of the control is 
decreased. If only the bottom position is moved toward the bottom of the form, the 
overall height of the control is increased, and in this case, the control would appear to be 
stretched when the view is loaded.

• prBottom - Bottom position of the control. Specify a relative or absolute workspace 
coordinate. See prTop (above) for a code sample.

• prLeft - Left position of the control. Specify a relative or absolute workspace coordinate. 
For absolute coordinates, the value 0 indicates the left side of the form. See prRight (below) 
for a code sample.

• prRight - Right position of the control. Specify a relative or absolute workspace coordinate.

The following code sample demonstrates a change in the size of the input field 
edSubject:

<Control overridable="true">
     <prControlID>edSubject</prControlID>
     <prRight>-20</prRight>
</Control>

First, the intent is to move the right side of the control, so the property prLeft is not set. 
Second, because the absolute value of coordinates increases from left to right, a negative 
value for the property prRight moves the position from right to left. Third, the property 
prWidth would achieve the same effect.

• prWidth - Width of the control. Specify a relative or absolute workspace coordinate. A 
relative positive value always decreases the width of the control, and a relative negative 
value always increases the width of the control. An absolute value determines the width of 
the control relative to its left position. See prHeight (below) for a code sample.

• prHeight - Height of the control. Specify a relative or absolute workspace coordinate. 

The following code sample shows an absolute height declaration on the control 
lcRoutingDestinations:

<Control overridable="true">
     <prControlID>lcRoutingDestinations</prControlID>
     <prHeight>60</prHeight>
</Control>

Guidelines for modifying dimensional properties are continued on the next page.

Table 7-16: Guidelines for modifying the UI section

Element Parent Description, attributes, and usage guidelines
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Use the following guidelines when modifying a dimensional property:

• Each control is independent of others in the view. When modifying the size or position of a 
control, be careful that you do not hide a control behind another one.

• Numerical values for dimensional properties use can be relative or absolute. For example, if 
the value is +20, the view increases the default dimension by 20 workspace coordinates. 
Similarly, if the value is -20, the view decreases the default dimension by 20 workspace 
coordinates. Or if the value is 435, the view sets the dimension on the control at the x- or y-
coordinate 435.

If making an absolute declaration on a dimensional property, consider the following:

• For Standard and Print To views, 0 represents the top of the form, 445 represents the bottom, 
0 represents the left side; and 646 represents the right side.

• For Send To views, 0 represents the top of the form, 215 represents the bottom, 0 represents 
the left side, and 545 represents the right side.

• For message options dialog boxes, 0 represents the top of the form, 265 represents the 
bottom, 0 represents the left side, and 435 represents the right side.

Table 7-16: Guidelines for modifying the UI section

Element Parent Description, attributes, and usage guidelines
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Transformations section

Table 7-17: Guidelines for modifying the Transformations section

Element Parent Description, attributes, and usage guidelines

Transformations View Section containing definitions of data transformations. The view configuration can effect data 
transformations on message properties, recipient properties, Embedded Directive properties, and 
template variables.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example: 

<View overridable="true" version="04.00.00">
     …
     <Transformations overridable="true">
     …
     </Transformations>
     …
</View>

For an override to be valid, the View section must allow overrides.

Transform Transformations Section containing the definition of a data transformation.

The element prValue supports the following attributes:

• transform - Value being transformed. Use a message property, recipient property, Embedded 
Directive property, or template variable.

• replace - This optional attribute identifies any static characters in the string format that need to 
be transformed. Use the attribute replace in conjunction with the attribute with.

• with - This optional attribute accompanies the attribute replace. It determines the replacement 
value.

The following code sample demonstrates the transformation of the access code into billing data:

<Transform transform="prAccessCode" replace="^" with="">
     <prValue>%LEGAL_BILL_01%%LEGAL_BILL_02%
      %LEGAL_BILL_03%</prValue>
 </Transform>

This code sample transforms prAccessCode into a string value that contains merged data from the 
billing fields %LEGAL_BILL01%, %LEGAL_BILL02%, and %LEGAL_BILL03%. It also 
removes carets (^) from the string format so that the resulting string includes only the characters 
from the billing fields.

Tip: Previous AccuRoute Client versions supported the configuration of the string value 
prAccessCode to include billing data. The code sample above can be copied into a view file, 
and further modified if necessary, to achieve the same effect with AccuRoute Desktop.

The Transform section supports the following properties:

• prValue - Substitution value that results from the data transformation. Use any combination of 
message properties such as prOriginator, recipient properties such as prDestination, 
Embedded Directive properties such as prSingleUse, or template variables such as 
%SENDER_CUSTOM1%. Text, formatting characters, and spaces are supported. See the 
code sample above.
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FaxCoverpages section

Table 7-18: Guidelines for modifying the FaxCoverpages section

Element Parent Description, attributes, and usage guidelines

FaxCoverpages View Section pertaining to fax cover pages.

The optional attribute enabled determines whether the information in this section is enabled for 
the current view. Use one of the following values:

• true (default) to enable the section
• false to disable the section.
The following code sample shows the section enabled, which means the view reflects the 
configuration for fax cover pages:

<View overridable="true" version="04.00.00">
     …
     <FaxCoverpages enabled="true" overridable="true">
     …
     </FaxCoverpages>
     …
</View>

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example:

<View overridable="true" version="04.00.00">
     …
     <FaxCoverpages enabled="true" overridable="true">
     …
     </FaxCoverpages>
     …
</View>

For an override to be valid, the View section must allow overrides.
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FaxCoverpage FaxCoverpages Section defining the fax cover page options that should appear in the view.

The attribute default, if true, denotes the cover page that should be selected by default in the view. 
Use one of the following values:

• true to denote the default cover page
• false (default)
The following code sample denotes that the cover page is the default selection: 

<FaxCoverpages enabled="true">
     <FaxCoverpage default="true">
     …
     </FaxCoverpage>
     …
</FaxCoverpages>

The attribute default can be enabled for one cover page only.

The FaxCoverpage section supports the following properties:

• prTemplateFilename - The filename of the cover page template. Do not include the file 
extension. 

The following code sample shows two cover pages that should appear in the cover page 
drop-down menu. The second cover page is denoted as the default:

<FaxCoverpage>
     <prTemplateFilename>Sales
     </prTemplateFilename>
</FaxCoverpage>
<FaxCoverpage default="true">
     <prTemplateFilename>InvestorRelations
     </prTemplateFilename>
</FaxCoverpage>

Table 7-18: Guidelines for modifying the FaxCoverpages section

Element Parent Description, attributes, and usage guidelines
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FaxAccessCodes section

Table 7-19: Guidelines for modifying the FaxAccessCodes section

Element Parent Description, attributes, and usage guidelines

FaxAccessCodes View Section pertaining to fax access codes.

The optional attribute enabled determines whether the information in this section is enabled for 
the current view. Use one of the following values:

• true (default) to enable the section
• false to disable the section
The following code sample shows the section enabled, which means the view reflects the 
configuration for fax access codes: 

<View overridable="true" version="04.00.00">
     …
     <FaxAccessCodes enabled="true">
     …
     </FaxAccessCodes>
     …
</View>

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example:

<View overridable="true" version="04.00.00">
     …
     <FaxAccessCodes enabled="true" overridable="false">
     …
     </FaxAccessCodes>
     …
</View>

For an override to be valid, the View section must allow overrides.
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FaxAccessCode FaxAccessCodes Section defining the fax access code options that should appear in the view.

The attribute default, if true, denotes the access code that should be selected by default in the 
view. Use one of the following values:

• true to denote the default access code
• false (default)
The following code sample denotes that the access code is the default selection:

<FaxAccessCodes enabled="true">
     <FaxAccessCode default="true">
          <prAccessCode>93382</prAccessCode>
     </FaxAccessCode>
     …
</FaxAccessCodes>
The attribute default can be enabled for one cover page only.

The FaxAccessCode section supports the following properties:

• prAccessCode - Access code. 

The following code sample shows three access codes that should appear in the access code 
drop-down menu. The third access code is denoted as the default:

<FaxAccessCode>
     <prAccessCode>7759</prAccessCode>
</FaxAccessCode>
<FaxAccessCode>
     <prAccessCode>93382</prAccessCode>
</FaxAccessCode>
<FaxAccessCode default="true">
     <prAccessCode>1883442</prAccessCode>
</FaxAccessCode>

Table 7-19: Guidelines for modifying the FaxAccessCodes section

Element Parent Description, attributes, and usage guidelines
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ConfirmationList section

Table 7-20: Guidelines for modifying the ConfirmationList section

Element Parent Description, attributes, and usage guidelines

ConfirmationList View Section that defines the list of default destinations for delivery confirmation.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example:

<View overridable="true" version="04.00.00">
     …
     <ConfirmationList overridable="false"
      notifyon="successandfailure">
     </ConfirmationList>
     …
</View>

For an override to be valid, the View section must allow overrides.

The attribute notifyon determines the conditions in which a delivery confirmation message is 
sent. Use one of the following values:

• failure to send a delivery confirmation only when message delivery fails
• successandfailure to send a delivery confirmation when message delivery succeeds or fails.
If this attribute is not present, no delivery confirmation message is sent.

The following code sample shows a confirmation destination that is configured to receive 
delivery confirmation whenever message delivery succeeds or fails:

<View overridable="true" version="04.00.00">
     …
     <ConfirmationList overridable="false"
      notifyon="successandfailure">
     </ConfirmationList>
     …
</View>
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Confirmation ConfirmationLis
t

Section defining a destination for delivery confirmation.

The attribute type defines the destination type. Use one of the following values:

• Email to specify an email address
• Printer to indicate the UNC path or IP address of a network printer
The following code sample shows a printer confirmation destination:

<ConfirmationList overridable="false"
  notifyon="successandfailure">
     <Confirmation type="Printer">
          <prDestination>IP:172.16.10.40</prDestination>
     </Confirmation>

     …
</ConfirmationList>

The Confirmation section supports the following properties:

• prDestination - Defines the location where the delivery confirmation message is sent, and 
must correspond appropriately to the destination type defined by the attribute type.

For email destinations, use an actual email address (name@domain.com) or 
%SENDER_EMAIL% for the sender’s email address. (%SENDER_EMAIL% is valid 
only in AccuRoute Desktop v2.1.01 and later.)

For printer destinations, use a UNC path to the network printer (\\server\printer), or the IP 
address of the network printer (IP:nn.nn.nn.nn).

The following code sample results in the delivery confirmation message being sent to the 
sender’s email address:

<Confirmation type="Email">
     <prDestination>%SENDER_EMAIL%</prDestination>
</Confirmation>

Table 7-20: Guidelines for modifying the ConfirmationList section

Element Parent Description, attributes, and usage guidelines
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Recipients section

Table 7-21: Guidelines for modifying the Recipients section

Element Parent Description, attributes, and usage guidelines

Recipients View Section defining the default recipients associated with the view.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example:

<View overridable="true" version="04.00.00">
     …
     <Recipients overridable="false">
     …
     </Recipients>
     …
</View>

For an override to be valid, the View section must allow overrides.
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Recipient Recipients Section defining a default recipient associated with the view.

The optional attribute visible determines whether the additional recipients are visible on the form. 
Use one of the following values:

• true (default) to display additional recipients
• false to hide additional recipients
The following code sample hides the additional email recipient specified in the view 
configuration: 

<Recipients overridable="false">
     <Recipient visible="false" type="Email">
     …
     </Recipient>
     …
</Recipients>

The required attribute type defines the destination type. Use one of the following values: 

• Email to specify an email address
• Printer to indicate the UNC path or IP address of a network printer
• Fax to specify a fax destination
The following code sample specifies that the recipient destination type is email: 

<Recipients overridable="false">
     <Recipient visible="false" type="Email">
     …
     </Recipient>
     …
</Recipients>

Table 7-21: Guidelines for modifying the Recipients section

Element Parent Description, attributes, and usage guidelines
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The Recipient section supports the following properties:

• prName - Friendly name of the recipient or destination. 

The following code sample shows John Smith as the name of the delivery confirmation 
recipient:

<Recipient visible="false" type="Email">
     <prName>John Smith</prName>
     …
</Recipient>

• prDestination - Destination address. 

The following code sample shows jsmith@AccuRoute.com as the destination for the 
delivery confirmation message:

<Recipient visible="false" type="Email">
     …
     <prDestination>jsmith@AccuRoute.com</prDestination>
     …
</Recipient>

• prFinalFormCode - File format of the delivery confirmation message. Use one of the 
following values:

G4.TIF for a G4 TIFF file

PDF for a PDF file

OCR.PDF for a PDF file that contains OCR-rendered text

OCR.DOC for a Word document that contains OCR-rendered text

OCR.RTF for a rich text format document with OCR-rendered text

OCR.TXT for a simple text document that contains OCR-rendered text

The following code sample shows OCR.TEXT as the file format for the delivery 
confirmation message:

<Recipient visible="false" type="Email">
     …
     <prFinalFormCode>OCR.TXT</prFinalFormCode>
     …
 <\Recipient>

Table 7-21: Guidelines for modifying the Recipients section

Element Parent Description, attributes, and usage guidelines
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Attachments section

Table 7-22: Guidelines for modifying the Attachments section

Element Parent Description, attributes, and usage guidelines

Attachments View Section defining default attachments to messages created with this view.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example:

<View overridable="true" version="04.00.00">
     …
     <<Attachments overridable="true">
     …
     </Attachments>
     …
</View>

For an override to be valid, the View section must allow overrides.



© 2019 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

7-39AccuRoute® Desktop Client Installation Guide

Section 7: Optional Configurations

Attachment Attachments The optional attribute visible determines whether the additional attachments are visible on the 
form. Use one of the following values:

• true (default) to display additional attachments
• false to hide them
The following code sample hides the additional attachments specified in the view configuration: 

<Attachments overridable="true">
     <Attachment visible="false" attachmenttype="file">
     …
     </Attachment>
     …
</Attachments>

The required attribute attachmenttype defines the attachment type. Use one of the following 
values:

• file (default) to specify the UNC path to a file that should be added to the form when the view 
loads

• web to specify the URL of a web page that should be added to the form when the view loads
• urllink to specify the URL of a web page that should be added to the message when the server 

prepares it for delivery
• unclink to specify the UNC path to a file that should be added to the message when the server 

prepares it for delivery
The following code sample show the attachment type urllink:

<Attachments overridable="true">
     <Attachment visible="false" attachmenttype="urllink">
     …
     </Attachment>
     …
</Attachments>

Table 7-22: Guidelines for modifying the Attachments section

Element Parent Description, attributes, and usage guidelines
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The Attachment section supports the following properties:

• prAttachmentOriginalPathname - If attachmenttype="file" or attachmenttype="unclink", 
then this required property represents the complete path to the file attachment, including the 
file name and its native extension. If attachmenttype=web or attachmenttype=urllink, then this 
required property represents the file name and needed extension of the attachment that is 
delivered as part of the message. 

The following code sample demonstrates the use of the property 
prAttachmentOriginalPathname with a UNC link. Here this property represents the 
complete path to the file attachment:

<Attachment visible="true" attachmenttype="unclink">
     <prAttachmentOriginalPathname>
      \\sapphire\standards\legal\confidentiality.txt
     </prAttachmentOriginalPathname>
</Attachment>

• prAttachmentURL - URL, or web address, of the attachment. Use this property if 
attachmenttype=web or attachmenttype=urllink, and include the complete path to the file, 
including the file extension. 

The following code sample demonstrates the use of the property prAttachmentURL with a 
web page:

<Attachment visible="true" attachmenttype="web">
     <prAttachmentURL>
      http://www.mycompany.com/privacy.txt
     </prAttachmentURL>
     <prAttachmentOriginalPathname>
      privacy.txt
     </prAttachmentOriginalPathname>
</Attachment>

Note: AccuRoute Desktop supports only attachments with static content. The application 
cannot automatically detect default pages, and does not support scripting such as redirects 
and active server pages.

Table 7-22: Guidelines for modifying the Attachments section

Element Parent Description, attributes, and usage guidelines
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RoutingSheets section

Table 7-23: Guidelines for modifying the RoutingSheets section

Element Parent Description, attributes, and usage guidelines

RoutingSheets View Section defining the Routing Sheets associated with the view.

Routing Sheet styles available to an AccuRoute Desktop user come from three sources:

• ...\AccuRoute\AccuRouteServer\Languages\ENU\EmbeddedDirectives folder on the 
AccuRoute Server

• search folders defined in the AccuRoute Desktop configuration file (AccuRouteclient.xml)
• search folders specified by the AccuRoute Desktop user (if AccuRoute Desktop allows the 

user to add search folders)
This section enables you to replace, add, or remove a Routing Sheet style from any of these 
sources.

The optional attribute overridable enables or prevents overrides within this section. Use one of 
the following values:

• true (default) to allow overrides
• false to prevent overrides
For example:

<View overridable="true" version="04.00.00">
     …
     <RoutingSheets overridable="true">
     …
     </RoutingSheets>
     …
</View>

For an override to be valid, the View section must allow overrides.

The required attribute action determines the function of the RoutingSheets section. 

Use one of the following values:

replace to replace the Routing Sheet styles from all three possible Routing Sheet style 
sources with the Routing Sheet styles defined in this section

modify to add a Routing Sheet style to the view, remove a Routing Sheet style, or set a 
Routing Sheet style as the default

The following code sample demonstrates a RoutingSheets section that replaces the existing 
Routing Sheet styles in the view with the styles defined in the section. (This is an abbreviated 
example that shows the general structure of the section where the Routing Sheet action is to be 
defined.)

<View overridable="true" version="04.00.00">
     …
     <RoutingSheets overridable="true" action="replace">
     …
     </RoutingSheets>
     …
</View>
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RoutingSheet RoutingSheets Section identifying a Routing Sheet style. 

The configuration of this section depends on whether RoutingSheets, the parent element, has been 
configured to replace or modify Routing Sheet styles:

• If the RoutingSheets section is configured to replace Routing Sheet styles, this section 
identifies the Routing Sheet styles that should be available in the view.

The attribute default is optional. It denotes whether the Routing Sheet style is the default. 
Use one of the following values:

true to denote a default Routing Sheet style

false (default)

The following abbreviated code sample replaces the Routing Sheet styles in the view with 
two new styles. The second style is the default:

<RoutingSheets action="replace">
     <RoutingSheet>
          …
     </RoutingSheet>
     <RoutingSheet default="true">
          …
     </RoutingSheet>
</RoutingSheets>

• If the RoutingSheets section is configured to modify Routing Sheet styles, this section 
indicates the modification action and the Routing Sheet style associated with the action. 

The attribute action is required. Use one of the following values:

add to add a Routing Sheet template to the list of Routing Sheet styles

remove to remove a Routing Sheet style from the view

modify to set a Routing Sheet style as the default

The attribute default is optional. It can be used when adding or modifying a Routing Sheet 
style to denote that the Routing Sheet style being identified is the default. Use one of the 
following values:

true to denote a default Routing Sheet style

false (default)

The following abbreviated code sample demonstrates the removal of a Routing Sheet style 
and the addition of a Routing Sheet style that is the default:

<RoutingSheets action="modify">
     <RoutingSheet action="remove">
          …
     </RoutingSheet>
     <RoutingSheet action="add" default="true">
          …
     </RoutingSheet>
</RoutingSheets>

Table 7-23: Guidelines for modifying the RoutingSheets section

Element Parent Description, attributes, and usage guidelines
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The RoutingSheet section supports the following properties:

• prName and prDescription - Use these properties to identify a Routing Sheet style when 
adding, modifying, or replacing a Routing Sheet style in the view.

prName represents the filename of the Routing Sheet template, for example, 
GeneralRoutingSheet.omtpl.

prDescription represents the description of the Routing Sheet template. The description of 
a Routing Sheet template is defined in the text file that has the same filename as the 
Routing Sheet template file. For example, Simple.OMTPL contains the template data and 
Simple.TXT contains the description.

The following code sample demonstrates the addition of the Routing Sheet template 
CorporateStandard.OMTPL:

<RoutingSheets action="modify">
     <RoutingSheet action="add">
          <prDescription>CorporateStandard</prDescription>
          <prName>CorporateStandard.omtpl</prName>
     </RoutingSheet>
     …
</RoutingSheet>

• prPath - Use this property to identify a Routing Sheet style when removing a Routing Sheet 
style from the view. It represents the path to the Routing Sheet template file including the 
filename and extension. 

Use wildcard expressions to indicate multiple Routing Sheet styles with common:

filenames (CorporateStandard.*)

file types (*.OMTPL)

descriptions (*Standard)

paths 
(\\sapphire\AccuRoute\AccuRouteServer\Languages\ENU\EmbeddedDirectives\*)

The following code sample removes Routing Sheet styles from the view using a wildcard 
expression:

<RoutingSheets overridable="false" action="modify">
     <RoutingSheet action="remove">
          <prPath>\\sapphire\RoutingSheetStyles\*</prPath>
     </RoutingSheet>
     …
</RoutingSheets>

Table 7-23: Guidelines for modifying the RoutingSheets section

Element Parent Description, attributes, and usage guidelines
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Other AccuRoute Desktop optional configurations
This section includes:

Configuring the access code to include billing data (7-44)

Hiding the Email copy to field (7-45)

Connecting the client automatically without prompting the user on startup (7-45)

Adding the user’s email address to the Email copy to field (7-46)

Setting the default server in the Connect to Server dialog box (7-46)

Setting the default cover page for fax recipients (7-47)

Setting the file formats that are valid for a destination type (7-48)

Configuring the access code to include billing data

The view file contains a section called Transformations that enables you to conveniently "transform" or 
customize string values using any combination of message properties such as prOriginator, recipient 
properties such as prDestination, Embedded Directive properties such as prSingleUse, and template 
variables such as %SENDER_CUSTOM1%.

This data transformation capability enables you to modify the access code string value so that it includes 
the data from the billing fields in AccuRoute Desktop.

To configure the access code string value to contain data from the billing fields in 
AccuRoute Desktop:

1 Determine the view file where you want to add this configuration. If you are using AccuRoute 
Desktop out of the box, choose Default.VIEW.

2 Open the file in Notepad or an XML editor.

3 Go to the Transformations section. (Search on Transformations if necessary.)

4 Add the following lines:
<Transform transform="prAccessCode" replace="^" with="">
     <prValue>%LEGAL_BILL_01%%LEGAL_BILL_02%%LEGAL_BILL_03%
     </prValue>
</Transform>
This code populates the string value prAccessCode with merged data from the billing fields 
%LEGAL_BILL_01%, %LEGAL_BILL_02%, and %LEGAL_BILL_03%. The carets (^) in the 
original prAccessCode string format are removed. String values from these fields are merged 
with no spaces.

5 Modify the XML if necessary. Use the guidelines on creating transformations. (Go to 
Transformations section on 7-28.)

6 Save the view file and close it.
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Hiding the Email copy to field

To hide the Email copy to field in AccuRoute Desktop:

1 Determine the view file where you want to add this configuration. If you are using AccuRoute 
Desktop out of the box, choose Default.VIEW.

2 Open the file in Notepad or an XML editor.

3 Go to the UI section. (Search on UI if necessary.)

4 Add the following lines:
<Control overridable="false">
     <prControlID>cbEmailCopyToMyself</prControlID>
     <prVisible>0</prVisible>
</Control>
This code hides the Email copy to option. The attribute overridable is set to false, so a 
derived view cannot override this configuration. (Change the value of the attribute overridable 
if necessary.)

5 Save the view file and close it.

Connecting the client automatically without prompting the user on startup

AccuRoute Desktop can be configured so that it connects to the AccuRoute server automatically—without 
prompting the user to log in.

To configure AccuRoute Desktop to connect to the AccuRoute Server without prompting 
the user to log in:

1 Locate AccuRouteclient.xml on the client (…\AccuRoute\AccuRoute Desktop) or in the 
AccuRoute Desktop setup on the AccuRoute server 
(…\AccuRoute\AccuRouteServer\Clients\AccuRoute Desktop).

If any modifications are made to the AccuRoute Desktop setup on the AccuRoute server and 
the environment has an AccuRoute server cluster, AccuRoute strongly recommends repeating 
this procedure on the alternative AccuRoute server.

2 Open the file in Notepad or an XML editor.

3 Go to the Servers section. (Search on Servers if necessary.)

4 Add the following lines:
<Servers autoconnect="true">
     <Server default="true">
          <prServerName>[connection string]</prServerName>
     </Server>
</Servers>
This code enables AccuRoute Desktop to connect to the AccuRoute server automatically. The 
element Servers must declare autoconnect="true", and the appropriate AccuRoute server 
must be set as the default server (default="true").
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5 Verify that the connection string is correct. (Go to Table 5-1: Connection string formats for 
DCOM, HTTP, and secure HTTP connectivity on 5-5.)

6 Note the following concepts pertaining to logon behavior in AccuRoute Desktop:

 If the email application is configured to start automatically and autoconnect="true", AccuRoute 
Desktop suppresses the Connect to Server dialog box on startup and connects to the 
AccuRoute server automatically. 

 If the email application is configured to prompt the user to select an identity/profile and 
autoconnect="true", the user selects an email identity/profile and then AccuRoute Desktop 
connects to the AccuRoute server. 

 If the element prMailType uses the value None (See the description of prMailType on 6-7.) 
and autoconnect="true", the user must complete the Connect to Server dialog box on 
startup. After providing a name and email address, the user must select Always connect 
to this server. Then AccuRoute Desktop connects to the AccuRoute server automatically.

7 Modify the XML if necessary. Use the guidelines on modifying the connection behavior. (Go to 
Servers on 6-9.)

8 Save the file and close it.

Adding the user’s email address to the Email copy to field

To include the user’s email address in the Email copy to field:

1 Determine the view file where you want to add this configuration. If you are using AccuRoute 
Desktop in its default configuration, choose Default.VIEW.

2 Open the file in Notepad or an XML editor.

3 Go to the Defaults section. (Search on Defaults if necessary.)

4 Add the following lines:
<EmbeddedDirective>
     <prAccuRouteCCMySelf>1</prAccuRouteCCMySelf>
</EmbeddedDirective>

5 Save the view file and close it.

Setting the default server in the Connect to Server dialog box

To set the default server in the Connect to Server dialog box:

1 Locate AccuRouteclient.xml on the client (…\AccuRoute\AccuRoute Desktop) or in the 
AccuRoute Desktop setup on the AccuRoute server (…\AccuRoute\AccuRoute 
Server\Clients\AccuRoute Desktop).

If any modifications are made to the AccuRoute Desktop setup on the AccuRoute server and 
the environment has an AccuRoute server cluster, AccuRoute strongly recommends repeating 
this procedure on the alternative AccuRoute server.

2 Open the file in Notepad or an XML editor.
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3 Go to the Servers section. (Search on Servers if necessary.)

It should look similar to the following and contain all available AccuRoute servers in your 
environment:
<Servers>
     <Server>
          <prServerName>[server A connection string]</prServerName>
     </Server>
     <Server>
          <prServerName>[server B connection string]</prServerName>
     </Server>
     <Server>
          <prServerName>[server C connection string]</prServerName>
     </Server>
</Servers>

4 Set the attribute default on the AccuRoute server that should be selected by default in the 
Connect to Server dialog box that appears on startup. 

The following example shows server A as the default server:
<Servers>
     <Server default="true">
          <prServerName>[server A connection string]</prServerName>
     </Server>
…
</Servers>

5 Save the file and close it.

Setting the default cover page for fax recipients

To set the default cover page for fax recipients:

1 Determine the view file where you want to add this configuration. If you are using AccuRoute 
Desktop out of the box, choose Default.VIEW.

2 Open the file in Notepad or an XML editor.

3 Go to the FaxCoverpages section. (Search on FaxCoverpages if necessary.) 

It should look similar to the following and contain the cover page styles that are associated 
with the view:
…<FaxCoverpages enabled="true">
     <FaxCoverpage>
          <prTemplateFilename>Sales</prTemplateFilename>
     </FaxCoverpage>
     <FaxCoverpage>
          <prTemplateFilename>PublicRelations</prTemplateFilename>
     </FaxCoverpage>
     <FaxCoverpage>
          <prTemplateFilename>InvestRelations
          </prTemplateFilename>
     </FaxCoverpage>…
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4 Set the attribute default on the cover page that should be selected by default in the options for 
fax recipients. 

The following example shows the last cover page style InvestRelations set as the default:
…<FaxCoverpages enabled="true">
     <FaxCoverpage>
          <prTemplateFilename>Sales</prTemplateFilename>
     </FaxCoverpage>
     <FaxCoverpage>
          <prTemplateFilename>PublicRelations</prTemplateFilename>
     </FaxCoverpage>
     <FaxCoverpage default="true">
          <prTemplateFilename>InvestRelations
          </prTemplateFilename>
     </FaxCoverpage>…

5 Save the view file and close it.

Setting the file formats that are valid for a destination type

Using the AccuRoute Server Administrator, you can configure the types of file formats that are valid for each 
destination type that you make available to users. This configuration is part of Registered Users, so the 
configuration can apply to individual users or to the default user which impacts all non-registered users.

To configure the file formats that are valid for a destination type:

1 Start the AccuRoute Server Administrator.

2 Do one of the following:

 For a registered user: Click Registered Users in the console tree and double-click a user in 
the details pane.

 For all non-registered users: Right-click Registered Users and select User Defaults.

3 Click the AccuRoute tab.

4 Select a destination type in the list and click Configure.

5 Click the Final Forms tab. The list displays all the file formats that are supported for the 
destination type. Configure the file formats as needed:

 To remove a final form as a valid file format for a destination type: Clear Enabled.

 To set a final form as the default selection for a destination type: View the properties of a file 
format and select Default.

6 Save your changes. (When you click OK on the Registered Users dialog box, a progress bar 
indicates that your changes are being saved.)
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AccuRoute Queue
This section includes:

Creating a routing rule for routing to multiple queues for the “Rescan” deficiency (7-49)

Modifying a notification template to include user-entered values (7-49)

Creating a routing rule for routing to multiple queues for the 
“Rescan” deficiency

To configure a routing rule for routing to multiple queues for the Rescan deficiency:

1 Click Start >All Programs > Omtool > Omtool Server Administrator.

2 In the console tree, expand the Omtool Server. 

3 Go to the Rules > Outbound > New. 

4 In the Specify the Criteria for this Rule box, click Add. From the Add Rule Criteria page, select 
Destination is an AccuRoute Queue, click Next.

5 In the Items to Match, verify the option is selected. In the text box add the Queue email 
address, for example: queue@yourcompany.com and click Add then click Finish. 

6 Click Next. In the Specify the Actions for this Rule page, click Add. The Add Actions page 
opens.

7 Select Route to AccuRoute Queue option and click Next. The Route to AccuRoute Queue 
page opens.

8 In the Select an AccuRoute Queue settings section, check the Specific Queue option. From 
the drop-down menu, select the Queue email address: queue@yourcompany.com.

9 Click Finish, then Next, Next and Finish to create the rule. 

Modifying a notification template to include user-entered values
You can configure the notification messages to include user entered values by configuring the 
omNotification-IIQ.omtpl template. 

To modify the omNotification-IIQ.omtpl: 

1 Navigate to the following directory on the Omtool server: \\Program Files\omtool\Omtool 
Server\Languages\ENU\Templates

2 Locate the omNotification-IIQ.omtpl template.

3 Make a copy of the .OMTPL file and keep it as backup.

4 Open the file using WordPad.

5 Enter template variables as needed. For example, to include template variables so that the 
information you enter in the Name, Company and Comments text box in the Routing 
Transaction Description text box are not substituted in the notification message, enter the 
information in the omNotification-IIQ.omtpl template as shown below:

Name:%SENDER_CUSTOM1%
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Company:%SENDER_CUSTOM2%

Comments:%SENDER_CUSTOM3%

6 Save the file. 

7 Verify that the file has the .OMPTL extension. 

The value set by the AccuRoute Queue operator will replace the matching value found in the 
%<VALUE>%s, and will remove percents as well.
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AccuRoute Server Monitor
This section includes:

Adding the AccuRoute Server Monitor Administrator snap-in to a Remote Administrator (7-51)

Defining server properties (7-52)

Adding the AccuRoute Server Monitor Administrator snap-in to 
a Remote Administrator
If you have a Remote Administrator MMC, you can add AccuRoute Server Monitor to the MMC console.

To add AccuRoute Server Monitor to the Omtool Remote Administrator:

1 Open the Omtool Administrator.

2 Select Console and select Add/Remove Snap-in.

3 Click Add to view a list of available snap-ins.

4 Scroll down the list of available snap-ins, select AccuRoute Server Monitor Administrator, 
and click Add. The Specify AccuRoute Server Monitor window appears.
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5 Enter the Network IP Address or name of the server you wish to monitor.

6 Click Finish, click Close, and then click OK.

Defining server properties 
This section includes:

Defining the Suspend Monitor tab (7-52)

Adding a new suspend monitoring specification (7-53)

Removing a suspend monitoring specification (7-53)

Modifying the specifications for an existing Suspend Monitor item (7-54)

Defining the Suspend Monitor tab

The Suspend Monitor feature allows you to suspend monitoring of the server for specified dates and times.
To open the Suspend Monitor tab in the server properties:

Right-click the server, select Properties, and then Click the Suspend Monitor tab. (Or, 
highlight the server, click Action on the toolbar, select Properties, and Click the Suspend 
Monitor tab.)

The available options are:
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Add - Allows you to enter new days and times to suspend monitoring.

Remove - Allows you to delete single or multiple suspend monitoring specifications.

Properties - Allows you to modify specifications for an existing Suspend Monitor item. You 
can only modify one item at a time.

Adding a new suspend monitoring specification

To add a new suspend monitoring specification:

1 Click Add on the Suspend Monitor tab. The Suspend Monitor Data screen appears.

2 Select the Days of the Week and the Time Period for which you want to suspend monitoring.

3 Click OK.

Removing a suspend monitoring specification

Use the following procedure to remove a suspend monitoring specification.
To remove a suspend monitoring specification:

1 Highlight an existing specification on the Suspend Monitor tab. You can also select multiple 
specifications using CTRL-Click and Shift-Click.

2 Click Remove.

3 Read the Are you sure you want to delete the selected item? message. Click Yes to delete 
it or No to keep it.

4 Click OK to close the Suspend Monitor tab.
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Modifying the specifications for an existing Suspend Monitor item

To modify a suspend monitoring specification:

1 Highlight the item on the Suspend Monitor tab and click Properties. The Suspend Monitor 
Data screen appears.

2 Make any changes needed and click OK.
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AccuRoute FaxCenter
This section includes:

 Sending a test fax (7-55)

 Retrieving the test fax in FaxCenter (7-55)

 Routing the test fax from FaxCenter to an e-mail account (7-56)

Sending a test fax
Using the following procedure, you will send a test fax. Before you send the fax, you must consider the 
inbound routing rule you created for FaxCenter. The inbound fax will only be routed from the server to 
FaxCenter if the fax matches the criteria you specified in this routing rule. If necessary, you might need to 
modify this rule for the purposes of testing the fax. For example, if the routing rule specifies that all inbound 
faxes will be routed from the server to FaxCenter on Fridays only, you might need to modify this rule to 
include the day you are sending the test fax—unless you are sending the test fax on a Friday. 

To send a test fax:

From any fax machine—including those inside your company, send a fax to a fax number 
in your company.

Tip If you want to track the progress of the fax on the server, you can view the journal for that fax in the 
Administrator. The journal contains a log of events related to that fax.

Retrieving the test fax in FaxCenter
Using the following procedure, you will launch FaxCenter on the client system and locate the test fax in the 
New Items queue.

To locate the test fax:

1 Log on to the client system.

2 Click the Start button and select Programs > FaxCenter > FaxCenter Console. The 
Connect to Server dialog box appears.

3 Type the computer name or IP address of the server in the Server text box, type the e-mail 
address of the FaxCenter user in the E-mail text box, type the appropriate password for the 
FaxCenter user in the Password text box, and click Connect.

4 Click on the test fax in the New Items queue to view it in the page view pane.

Tip If the test fax does not appear in the New Items queue, you can troubleshoot the fax from the 
Administrator. See “Click the Journal tab.” on page 56.
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Note Depending on the permissions you configured for the FaxCenter login account, you might only be 
able to view the first page of the fax or the entire fax.

5 Click the Journal tab.

Routing the test fax from FaxCenter to an e-mail account
Once you can view the test fax in FaxCenter, you should route it to an e-mail account that you can access. 
After you route the fax from FaxCenter to an e-mail account and retrieve the fax from the e-mail account, 
you will have simulated the steps that will occur when your company receives actual faxes.

Note When a FaxCenter user routes an inbound fax, the user can route the fax to e-mail recipients, 
network printers, fax machines, and your company’s document management system or document 
repository. However, you will route the test fax to an e-mail account because it will be easy for you 
to retrieve it. This also allows you to test the mail connector that moves faxes to your mail server 
for delivery.

Using the following procedure, you will open the test fax in FaxCenter and route it to an e-mail account that 
you can access.

To route the test fax to your e-mail account:

1 Start FaxCenter, log in, and click on the test fax in the New Items queue. (If the New Items 
queue does not appear, click View and select New Items.)

2 Click Edit and select Route Item. The Route Selected Item dialog box appears.

3 Select your e-mail address from the list on the left and click the Add Recipient button, or type 
your e-mail address in the Type destination or select from list text box and click the Add 
button. 

4 In the Pages to route text box, indicate the pages you want to route by selecting All Pages 
from the drop-down menu or typing the page numbers in the text box. 

5 Under Routing Transaction Description, type the name of the original sender in the Name 
text box, the original sender’s company name in the Company text box, and your comments 
about the fax in the Comments text box. 

Depending on the permissions you configured for the FaxCenter login account, you might 
have granted permissions for this user to leave the Name or Company fields empty. 

6 Click Route. The server prepares and sends the fax to the destination you specified, and 
FaxCenter moves the fax to the Processed Items queue. 

7 Log in to the e-mail account where you routed the test fax. 

8 In your inbox, you should see a message indicating that a FaxCenter user has routed a fax to 
you. Follow the instructions in the e-mail to retrieve the test fax.
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Section 8: Uninstallation

This section of the AccuRoute Clients Installation Guide explains the standard uninstallation process.

This section includes:

Uninstalling AccuRoute Clients (8-1)

Uninstalling Accuroute Clients in Silent Mode (8-1)

Uninstalling AccuRoute Clients
To uninstall AccuRoute clients:

1 On the system Control Panel, select Programs > Programs and Features > Uninstall or 
change a program.

OR

Click Start > Control Panel > Add/Remove Programs.

2 Select AccuRoute [Client name] and click Remove / Uninstall., where [Client name] is the 
Client you want to uninstall.

3 Follow the prompts to remove the application.

To verify that AccuRoute client is removed, browse the directory structure on the client and 
verify that the client has been removed. 

Uninstalling Accuroute Clients in Silent Mode
To remove the AccuRoute client in silent mode:

1 Log on to the client with an account that belongs to the local Administrators group.

2 Copy the AccuRoute client setup directory to a local drive, or map a drive to the folder that 
contains the setup program. (The setup program is required to silently remove the 
application.)

3 Open a command prompt.

4 Set the current directory to the AccuRoute client setup directory.

5 Run: setup.exe /s /V"/qn REMOVE=ALL"

This removes AccuRoute client from the default location.
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Section 9: Troubleshooting

This section contains descriptions to troubleshoot different AccuRoute clients.

This section includes:

AccuRoute Desktop (9-2)

Server Monitor (9-3)

Fax Center (9-4)

Note: The following clients have no troubleshooting topics.

 Web Apps

 Print to AccuRoute

 AccuRoute Queue

 AccuRoute Acquisition

 AccuRoute Connect

 AccuRoute COM API

 Cost Recovery
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AccuRoute Desktop 
This section includes:

Error when profiling DOCX and XLSX type documents to a Worksite v8.2 repository (9-2)

Error when profiling DOCX and XLSX type documents to a 
Worksite v8.2 repository 
Problem: When I try and profile a document of type DOCX or XLSX from AccuRoute Desktop v6.0 to a 
Worksite repository v8.2, the Save button is disabled and profiling fails.

Solution: When profiling a document from AccuRoute Desktop to WorkSite, the file type must be defined 
and cannot be blank. In this case, the Type field is blank which is the reason for the Save button is disabled.

WorkSite servers prior to v8.5 do not have the "out of the box"  DOCX and XLSX file extensions in the 
registered file types. In order to use DOCX and XLSX file types, the WorkSite Administrator must add 
support for them by adding them to the list of registered types on the WorkSite server for a particular 
database. Once added, the Type field will be pre-populated in the new profile dialog for the DOCX, XLSX 
extensions.

To add the DOCX and XLSX document types in the Worksite server

1 Go to Worksite DMS 8.2 server system. 

2 Navigate to Start> All Programs> Interwoven server> Database Administration. The 
Worksite Database management page opens. 

3 Select Type to see the default file types supported list. 

4 Right click and select Add. The Add Type page opens. 

5 In the Description and Alias fields, specify appropriate values. 

6 In the DMS extension field, enter %V.

7 In the App. Extension field enter DOCX. 

8 Click OK

DOCX file format is added as a new file type and displayed along with the existing file types.

9 Similarly add the XLSX extension (In the App. Extension field enter XLSX. )

After you have added the file types, you can successfully profile documents with file types DOCX and XLSX 
to the Worksite v8.2 repository. 
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Server Monitor
This section includes:

1607 error (9-3)

Configuration file (9-3)

Connecting to the Server Monitor Service (9-3)

Clustered environments (9-3)

The information in the following sections will help you troubleshoot Server Monitor.

1607 error
If you receive a 1607 error when installing Server Monitor, make sure you are not installing to a Windows 
Server that is running in Terminal Server Application mode. This is not a supported environment.

Configuration file
All settings for Server Monitor are contained in the omsvrmonitor.config file. When the Server Monitor 
Services opens, it reads the settings contained in this file.

The omsvrmonitor.config file is located in the ...\AccuRoute\ServerMonitor directory.

Note In a clustered environment, when control passes to the secondary server, tests continue to be 
performed. The omsvrmonitor.config file, however, is not updated with the secondary server’s 
name.

Connecting to the Server Monitor Service
When the Server Monitor Administrator starts, it attempts to detect the Server Monitor Service locally. If the 
Server Monitor Service is not installed, the following error occurs: Failed to connect to specified monitor 
service (0x80040154). Click OK on the message box and proceed to Connecting to the AccuRoute Server 
Monitor Service (3-3).

Clustered environments
If you have declared a preferred server, the preferred server must be active when you add it to Server 
Monitor.
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Fax Center
This section includes:

Tracking the status of the fax on the server (9-4)

Checking inbound routing rules (9-5)

Verify the installation of an image viewer (9-5)

Tracking the status of the fax on the server
You can track the progress of the test fax on the server using the Administrator. If the server did not route 
the inbound fax to FaxCenter, did not deliver the fax for another reason, or paused during the processing of 
the fax, you can view the journal for that fax and see a log of events related to that fax.

Once the server routes the test fax to FaxCenter, you can view the journal for that fax in FaxCenter.

To view the test fax on the server:

1 Start the Administrator.

2 Expand the Messages item in the console tree and select In Process.

The In Process folder displays all messages and faxes being processed on the server. In 
the details pane, the top section displays a set of bar graphs, also called barometers, that 
represent the different processing phases of a fax. You can resize the Administrator window 
if necessary to view all the barometers.

Each barometer has a number that indicates the number of items in that processing phase. 
As items move through various phases of processing, the visual indicators on the 
barometers change in real-time.

Using these barometers, you can locate the processing phase of your test fax and watch it 
move through the other phases until the server dispatches the fax to FaxCenter.

3 Click the option button above the barometer you want to view.

If you cannot locate your test fax in the In Process queue, repeat these steps in the History 
queue.

4 Right-click on the test fax and select Properties.

5 Click the Journal tab.

Review the list of events. (Double-click an event to view more information about it.) If the 
server did not route the inbound fax to FaxCenter, did not deliver the fax, or paused during 
the processing of the fax, the journal provides you with the information you need to 
troubleshoot the issue.

Tip If you make any modifications to the settings on the server and you want to send your test fax again, 
you can resend the fax from the Administrator. For more information, refer to the Administrator help: 
http://www.AccuRoute.com/documentation/accuroute/6.0/faxcenter/faxcenteruserguide.pdf
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Checking inbound routing rules
When you troubleshoot your test fax, make sure that you created an inbound routing rule for FaxCenter. 
Also, verify that the details in this rule will route faxes to FaxCenter and that the appropriate FaxCenter users 
should receive faxes. If you configured the server to route faxes to all FaxCenter users, all FaxCenter users 
should be able to view the test fax in the New Items queue. If you configured the server to route faxes to a 
particular FaxCenter user, only that user should be able to view the test fax in the New Items queue.

Verify the installation of an image viewer
If an image viewer is not installed, you will not be able to view the test fax in FaxCenter.



AccuRoute® Clients Installation Guide

Section 9: Troubleshooting

© 2019 by Omtool, Ltd. (Upland AccuRoute) All rights reserved. Omtool, AccuRoute, Genifax, Image-In, ObjectArchive, ScanFacts, and the Company logo are trademarks of the Company. 
Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

9-6


	AccuRoute® Clients Installation Guide
	Contents
	Section 1: About this Guide
	Intended Audience
	AccuRoute Clients List
	Client Deployment Summary
	Related AccuRoute v6.3 Documentation

	Section 2: Introduction
	AccuRoute Desktop
	Introduction to AccuRoute Desktop
	Methods of submitting messages to the AccuRoute Server
	AccuRoute Web Apps
	Network scanning devices

	Components of AccuRoute Desktop
	Watch Folders application
	AccuRoute Desktop
	Send To AccuRoute Desktop
	Print to AccuRoute printer

	Workflows for messages and Embedded Directives
	Views associated with AccuRoute Desktop features
	Views versus user preferences
	Inheritance
	Overrides


	AccuRoute Web Apps
	Introduction to AccuRoute Web Apps
	Messages and distributions
	Distribution Collections

	Print to AccuRoute
	Introduction of Print to AccuRoute Features
	Printing to AccuRoute Desktop
	Print to AccuRoute WebApps

	AccuRoute Queue
	Introduction to AccuRoute Queue
	Working with AccuRoute Queue

	AccuRoute Acquisition
	Introduction to AccuRoute Acquisition
	User Interface
	Top Menu Bar
	Tool Bar Icons
	Image/page number pane and PDF viewer pane
	Status bar


	AccuRoute Connect
	Introduction to AccuRoute Connect
	Working with AccuRoute Connect
	Description of the AccuRoute Connect features

	AccuRoute CostRecovery
	Introduction to AccuRoute CostRecovery
	CostRecovery Features

	AccuRoute Server Monitor
	Introduction to AccuRoute Server Monitor

	AccuRoute FaxCenter
	Introduction to AccuRoute FaxCenter


	Section 3: Requirements
	Server requirements
	AccuRoute Server requirements
	Basic client hardware requirements
	DCOM permissions when installing on a remote system
	HTTP or HTTPS connectivity for AccuRoute Intelligent Device Client
	Note about connecting AccuRoute Server installed on Windows
	Supported email applications

	Client requirements
	AccuRoute Web Apps
	AccuRoute Web Apps user requirements for email account
	AccuRoute Web Apps user full permission requirements

	Print to AccuRoute
	AccuRoute COM API
	Components installed by the AccuRoute Intelligent Device Client setup

	AccuRoute Server Monitor
	AccuRoute Server Monitor Service
	AccuRoute Server Monitor Administrator


	Section 4: Installation
	AccuRoute Desktop
	About the AccuRoute Desktop Components
	Installing AccuRoute Desktop
	View files installed with AccuRoute Desktop
	Running AccuRoute Desktop setup in silent mode
	Installing AccuRoute Desktop for all users in silent mode

	AccuRoute Web Apps
	About the AccuRoute Web Apps components
	Installing AccuRoute Web Apps
	AccuRoute Web Apps Silent Mode Installation
	Required DCOM permissions when installing on a remote system

	Print to AccuRoute
	Installing Print to AccuRoute for the Web
	Standard Installation of Print to AccuRoute for Web
	Silent Mode Installation of Print to AccuRoute for Web

	Installing Print to AccuRoute for AccuRoute Desktop
	Standard Installation of Print to AccuRoute for AccuRoute Desktop
	Silent Mode Installation of Print to AccuRoute for AccuRoute Desktop


	AccuRoute Queue
	Installing AccuRoute Queue
	Running AccuRoute Queue setup in silent mode

	AccuRoute Acquisition
	Accessing the setup files
	Installing AccuRoute Acquisition
	Running the AccuRoute Acquisition setup in silent mode

	AccuRoute Connect
	Installing AccuRoute Connect
	Running the AccuRoute Connect setup in silent mode

	AccuRoute COM API
	About the Embedded AccuRoute for Intelligent Devices components
	Embedded AccuRoute for Intelligent Devices for COM API installation

	AccuRoute Cost Recovery
	Backing up existing AccuRoute Cost Recovery configuration files
	Running the AccuRoute Cost Recovery setup

	AccuRoute Server Monitor
	About the AccuRoute Server Monitor client components
	Installing AccuRoute Server Monitor

	AccuRoute FaxCenter
	Installing AccuRoute FaxCenter


	Section 5: Required Server Configuration
	AccuRoute Desktop
	Configuring server-client connectivity for AccuRoute Desktop
	About connecting with the AccuRoute Server
	Configuring server-client connectivity methods
	Implementing connectivity methods

	Configuring Group permissions for AccuRoute Desktop

	AccuRoute Web Apps
	Enabling integrated Windows authentication
	Configuring integrated Windows authentication on clients running Internet Explorer 11
	Adding the Web Apps Client URL to the list of trusted sites on a client system
	Disabling Compatibility Mode in Internet Explorer 11
	Selecting a network printer

	AccuRoute Queue
	Configuring the Property Expression feature

	AccuRoute Connect
	Configuring the AccuRoute Connect node
	Configuring Groups for AccuRoute Connect

	AccuRoute Server Monitor
	Configuring AccuRoute Server Monitor server properties
	Clustering Server Monitor
	Defining sender and recipient e-mail addresses
	Defining server properties - the General tab
	Opening the General tab

	Defining failover actions

	AccuRoute FaxCenter
	Creating routing rules for inbound faxes


	Section 6: Required Configuration
	AccuRoute Desktop
	Configuring address book integration in the AccuRoute Desktop setup
	Using AccuRoute Desktop with an AccuRoute Connector for DMS
	Configuring MyAccuRoute on the AccuRoute Server
	Configuring the Watch Folders application on the AccuRoute Server
	Advantage of using Watch Folders

	Modifying the AccuRoute Desktop configuration file

	AccuRoute Web Apps
	Configuring required COM permissions for launching the remote Web Apps
	Creating a new Web Apps Client Profile
	Adding a Web Apps Client Profile to a User Group
	Configuring prompts and additional custom options

	AccuRoute Queue
	Connecting to AccuRoute Queue

	AccuRoute Connect
	Configuring Queue Workflow rule for Link to Queue feature

	AccuRoute COM API
	AccuRoute Intelligent Device Client objects

	AccuRoute CostRecovery
	Overview of AccuRoute CostRecovery configuration
	Configuring AccuRoute CostRecovery file locations
	Selecting the location of the AccuRoute CostRecovery output file
	Configuring the names and locations of AccuRoute CostRecovery files
	Configuring output data
	Using the skip list to omit message types
	Working with fields, delimiters, and masks
	Configuring the export format and creating the template file
	Adding fields and delimiters
	Adding a field with a mask
	Appending and overriding output data
	Configuring the removal of digits from fax numbers
	Including billing codes in AccuRoute CostRecovery output
	Configuring the billing code separator
	Including the entire billing code in AccuRoute CostRecovery output

	Customizing the billing code

	AccuRoute Server Monitor
	Required configuration for AccuRoute Connectors for Filescan and Telco
	Configuring the Filescan connector
	Configuring the Telco connector


	AccuRoute FaxCenter
	Registering AccuRoute FaxCenter users


	Section 7: Optional Configurations
	AccuRoute Desktop
	About AccuRoute Desktop and server clusters
	Copying server and client resources to a high availability server
	Editing the registry on the AccuRoute Server
	Editing the AccuRoute Desktop configuration file

	Working with views
	Configuring view controls
	Modifying view files

	Other AccuRoute Desktop optional configurations
	Configuring the access code to include billing data
	Hiding the Email copy to field
	Connecting the client automatically without prompting the user on startup
	Adding the user’s email address to the Email copy to field
	Setting the default server in the Connect to Server dialog box
	Setting the default cover page for fax recipients
	Setting the file formats that are valid for a destination type


	AccuRoute Queue
	Creating a routing rule for routing to multiple queues for the “Rescan” deficiency
	Modifying a notification template to include user-entered values

	AccuRoute Server Monitor
	Adding the AccuRoute Server Monitor Administrator snap-in to a Remote Administrator
	Defining server properties
	Defining the Suspend Monitor tab
	Adding a new suspend monitoring specification
	Removing a suspend monitoring specification
	Modifying the specifications for an existing Suspend Monitor item


	AccuRoute FaxCenter
	Sending a test fax
	Retrieving the test fax in FaxCenter
	Routing the test fax from FaxCenter to an e-mail account


	Section 8: Uninstallation
	Uninstalling AccuRoute Clients
	Uninstalling Accuroute Clients in Silent Mode

	Section 9: Troubleshooting
	AccuRoute Desktop
	Error when profiling DOCX and XLSX type documents to a Worksite v8.2 repository

	Server Monitor
	1607 error
	Configuration file
	Connecting to the Server Monitor Service
	Clustered environments

	Fax Center
	Tracking the status of the fax on the server
	Checking inbound routing rules
	Verify the installation of an image viewer






